COPYRIGHT & TRADEMARKS
© 2001-2016 Given Imaging Ltd. All rights reserved. Medtronic, Medtronic logo and Further, Together are trademarks of Medtronic.™ Third party brands are trademarks of their respective owners. All other brands are trademarks of a Medtronic company.

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Note
Changes or modifications not expressly approved by Given Imaging could void authority to operate the PillCam Capsule Endoscopy System.

Rx Only

Given Imaging
15 Hampshire Street,
Mansfield, MA 02048 USA
supportUS@givenimaging.com

Medtronic B.V.
Earl Bakkenstraat 10,
6422 PJ Heerlen, The Netherlands
# Table of Contents

**Using This Guide** ........................................................................................................... 1

**Conventions** ................................................................................................................. 1

**Chapter 1**

**About PillCam Capsule Endoscopy** ........................................................................ 3

**About Capsule Endoscopy** ....................................................................................... 3

**System Components** .................................................................................................. 3

- PillCam Capsules ........................................................................................................ 4
  - PillCam SB2/3 .......................................................................................................... 5
  - PillCam C2 .............................................................................................................. 5
  - PillCam UGI ............................................................................................................ 5
  - PillCam Crohn’s .................................................................................................... 5
  - PillCam Patency Capsule ..................................................................................... 5
  - Handling PillCam Capsules .................................................................................. 6

- PillCam Recorders ....................................................................................................... 6
  - PillCam recorder DR2 .......................................................................................... 6
  - PillCam recorder DR3 .......................................................................................... 7

- PillCam Sensor Arrays and Sensor Belts ..................................................................... 7
  - PillCam Sensor Belt .............................................................................................. 7
  - Sensor Array ......................................................................................................... 8

- PillCam Desktop Software ........................................................................................ 9

**Chapter 2**

**Indications, Contraindications, Warnings, Cautions** ............................................ 11

**Indications for Use** .................................................................................................... 11

- PillCam SB ............................................................................................................. 11
- PillCam UGI ........................................................................................................... 11
- PillCam COлон ...................................................................................................... 11
- PillCam Crohn’s .................................................................................................... 12

**Contraindications** ..................................................................................................... 12

- PillCam SB ............................................................................................................. 12
- PillCam UGI ........................................................................................................... 12
- PillCam COлон/PillCam Crohn’s ........................................................................ 13

**Adverse Events** ......................................................................................................... 13

**Warnings** ................................................................................................................... 13

**Cautions** ...................................................................................................................... 16

**Benefits and Risks—PillCam Capsule Endoscopy** .................................................... 16

- Benefits .................................................................................................................. 16
- Risks ........................................................................................................................ 17

**Essential Performance** ............................................................................................. 18

- PillCam Video Capsules ....................................................................................... 18
- PillCam Recorder DR2 and PillCam Recorder DR3 ........................................... 18
Chapter 3
Preparing for Capsule Endoscopy

Patient Preparations—Before the Procedure
Preparing the Patient
Printing Pre-ingestion Instruction Handouts

Preparations at the Clinic
Preparing the Required Equipment
Using the Regimen Manager to Prepare Regimens for Colon Procedures
Accessing the Regimen Manager
Creating Pre-Ingestion Patient Instructions
Post-Ingestion Patient Instructions
Printing the Patient Instructions
Print Layout of the Post-Capsule Ingestion Instructions

Chapter 4
Installing and Setting up PillCam Desktop

Installing PillCam Desktop
Setup Requirements & Prerequisites
Connecting the PillCam Desktop Workstation to the PillCam Recorder Cradle
Starting PillCam Desktop for the First Time
Familiarizing yourself with the PillCam Desktop Home Screen
Configuring PillCam Desktop for the First Time
Accessing PillCam Desktop
Allowing Access to PillCam Desktop
Allowing Access to the Pre-installed PillCam Desktop Workstation
Defining User Information
Defining Regional Settings
Defining Video Creation Settings
Customer Support Section

Chapter 5
Performing Capsule Endoscopy with DR3

Preparing for the Capsule Endoscopy Procedure
Before You Start Checklist
General Patient Guidelines During the Procedure
Post-ingestion Instructions for Procedures Involving Colon Visualization
Performing Patient Check-in
Connecting the PillCam Recorder for Patient Check-in
Entering Patient Check-in Information
Configuring the Patient Check-in Fields
Chapter 8
Reviewing Videos and Creating Reports ............................................................ 115

Using the Study Manager ..................................................................................... 115
 Opening the Study Manager ............................................................................... 116
 Archives .............................................................................................................. 116
   Adding an Archive ......................................................................................... 117
 Studies ................................................................................................................. 118
 Search Options ....................................................................................................... 119
 Status Bar ............................................................................................................. 119
 Action Buttons ...................................................................................................... 119
 Managing Columns ............................................................................................... 120
   Defining Study Manager Settings ................................................................. 122

Working with Studies .......................................................................................... 123
 Opening a Study ................................................................................................... 123
 Exporting Studies ................................................................................................ 124
   Burning a Study to a CD/DVD ........................................................................ 124
   Saving a Study to Another Archive .............................................................. 125
   Saving a Study as a Zip File .......................................................................... 126
 Deleting Studies .................................................................................................. 127
 Working with Offline Studies ............................................................................. 127

Familiarizing Yourself with the PillCam Desktop Main Screen ......................... 129
 Ribbon Tab ........................................................................................................... 130
 View Screen .......................................................................................................... 130
   Viewing Layout Group .................................................................................. 132
   Image Adjustment Group .............................................................................. 133
   Show Group .................................................................................................... 134
   Compare Group .............................................................................................. 135
 Report Screen ........................................................................................................ 135
   Configure Group ........................................................................................... 135
   Thumbnails Group ......................................................................................... 137
   Report Group ................................................................................................ 138
   Image Data Group ......................................................................................... 139
   Clinical Tools Group ..................................................................................... 140
   Lewis Score .................................................................................................... 143
 Keyboard Shortcuts ............................................................................................... 145

Viewing Videos ..................................................................................................... 147
 QuickView ............................................................................................................ 147
 Viewing a Video with Complementary QuickView ......................................... 148
 Using Dynamic Player Control ......................................................................... 148
 Dual Head View .................................................................................................. 149
 SBI View .............................................................................................................. 150
 Viewing the Top 100 Images ............................................................................. 151
 Time Bar/Color Bar ............................................................................................. 152
   Time Indication ............................................................................................... 152
 Working with Thumbnails .................................................................................... 152
   Thumbnail Status ......................................................................................... 153
   Thumbnail Comments .................................................................................... 154
Marking Tools.............................................................................................................. 156
Using Localization and Landmarks ........................................................................ 159
Landmarks .................................................................................................................. 159
Suggested Flexure Landmarks for PillCam COLON/PillCam Crohn’s Videos .......... 160
Suggested Landmarks for PillCam SB 3 Videos ......................................................... 160
GI Map ................................................................................................................... 160
Comparing Thumbnails.......................................................................................... 161
Working with Findings ............................................................................................... 163
Saving Your Findings .............................................................................................. 163
Opening a Findings File .......................................................................................... 163
Creating a PillCam Capsule Endoscopy Report ...................................................... 165
Generating a Report ............................................................................................... 166
Signing Reports Electronically ............................................................................... 167
Report Export Options ............................................................................................ 168

Chapter 9
Working with PillCam Crohn’s Videos ................................................................169
Overview ...................................................................................................................... 169
Segmentation ............................................................................................................ 169
Segmental Review ..................................................................................................... 170
Segment Assessment ............................................................................................... 170
Using the Prepare Screen .......................................................................................... 171
Viewing Current Procedure Information ................................................................ 172
Viewing and Editing Current Medications ............................................................... 172
Viewing a Study from a Previous Procedure ............................................................. 173
Viewing Treatment Over Time .................................................................................. 174
Viewing PillCam Crohn’s Videos .............................................................................. 174
Defining Severity and Extent of Lesions in PillCam Crohn’s Videos....................... 175
Guidelines for Defining Severity and Extent of Lesions in PillCam Crohn’s Videos... 175
Defining Anatomical Landmarks .............................................................................. 176
Working with the GI Table ....................................................................................... 178
Comparing GI Tables ............................................................................................... 180
Comparing Findings ............................................................................................... 180
Viewing a Prior Video ............................................................................................. 181
Creating a PillCam Crohn’s Report ......................................................................... 182
Viewing a Prior Report ........................................................................................... 182
Creating a Report ................................................................................................... 183

Appendix A
PillCam Equipment Maintenance ............................................................................ 185
PillCam Recorder Maintenance .............................................................................. 185
Important Safety Instructions ................................................................................ 185
PillCam Recorder DR3 ........................................................................................... 186
PillCam Recorder DR2 ........................................................................................... 187
Charging .................................................................................................................... 187
Manual Discharge ................................................................................................... 188
PillCam Sensor Cleaning ......................................................................................... 189
Guidance and Manufacturer’s Declarations ............................................................. 213
  PillCam Capsules ............................................................................................... 213
  PillCam Recorder DR2/DR2C ............................................................................. 216
  PillCam Recorder DR3 ....................................................................................... 219
Declaration of Conformity with Radio and Telecommunications Terminal
  Equipment Directive ............................................................................................. 222
Conventions

Screen elements, such as menus, button names, and screen names are in bold as follows: **PillCam Recorders**.

System messages appear as follows: *Your PillCam recorder needs an update*.

A Note is a piece of information or a remark that receives emphasis and appears as follows:

| Note | When connecting more than one PillCam recorder DR2 to the computer, use a USB-powered hub. |

A Caution warns you about possible damage to equipment, and appears as follows:

| Caution | Make sure that there is no other PillCam capsule or other diagnostic capsule in the patient's gastrointestinal tract. |

A Warning warns you about possible harm to people and appears as follows:

| Warning | Never connect the PillCam recorder to the sensor array while the PillCam recorder is in its cradle. |
About PillCam Capsule Endoscopy

This section provides an overview of capsule endoscopy and a description of the PillCam Capsule Endoscopy System components.

This chapter includes the following main topics:

- About Capsule Endoscopy on page 3
- System Components on page 3

About Capsule Endoscopy

The PillCam capsule endoscopy procedure is a process that enables minimally invasive visualization of the GI tract using an ingestible video capsule. The video capsule captures images that are later presented to the physician for review and interpretation.

The PillCam capsule endoscopy process consists of the following steps:

- Preparing the patient and the system for the ingestion of the capsule.
- Performing the capsule endoscopy procedure.
- Creating the video.
- Reviewing and interpreting the video.

System Components

The PillCam Capsule Endoscopy System components that support the PillCam capsule endoscopy process consist of the following:

- PillCam capsules, which acquire pictures of the gastrointestinal (GI) tract and transmit them to the PillCam recorder.
- PillCam recorders with PillCam sensors (sensor belt or sensor array), which receive and store the images collected during the procedure for subsequent video creation with the PillCam software.
- PillCam Desktop software (formerly RAPID), which processes and transforms the raw image data stored in the recorder into a conveniently viewable PillCam software video.
PillCam capsules are video cameras designed specifically for imaging the intestinal tract. Each capsule is equipped with a tiny battery, a transmitter with antenna, and LEDs (light-emitting diodes) for each video camera head. These components are enclosed in a biocompatible plastic casing. A capsule is about the size of a large vitamin pill.

After activation and ingestion, the capsule is propelled by peristalsis through the gastrointestinal tract. During this process, the video cameras acquire images and the transmitter sends them, via the sensors, to the PillCam recorder for storage.

The PillCam Capsule Endoscopy System supports the following PillCam capsule types, optimized for use in different bowel segments and equipped with either one or two video heads:

- PillCam SB
- PillCam COLON
- PillCam Crohn’s
- PillCam UGI

A description of the capsules follows. Note that:
- A full technical specification for each capsule is available under System Specifications on page 204.
- Indications and contraindications are available in Indications, Contraindications, Warnings, Cautions on page 11.

Caution

The PillCam capsule transmits at a specific frequency of 434.1MHz in a bandwidth of ±10MHz. Occasionally, interference from external devices transmitting in the same bandwidth may occur that may interrupt or limit the effective performance of the capsule transmission:

- Car or house alarm: These operate with momentary transmissions. Depending on the proximity of the car or house alarm transmitter to the ingested capsule, there could be a momentary interference that should not damage the capsule video.
- Police/Fire stations radio equipment: These may operate with more extended transmission durations. Depending on the proximity of the police/fire station alarm transmitter to the ingested capsule, this could cause longer duration interference, possibly causing gaps in the capsule video.
**PillCam SB2/3**

**PillCam SB capsules: Small bowel**
PillCam SB capsules contain one video camera:
- PillCam SB 2 is a fixed frame rate second generation capsule.
- PillCam SB 3 is a third generation capsule with enhanced imaging capabilities with adaptive frame rate (AFR).

**PillCam C2**

**PillCam COLON capsule: Colon**
PillCam COLON capsules contain two video cameras (one at each end). PillCam COLON 2 is an enhanced imaging capability adaptive frame rate (AFR) variant.

**PillCam UGI**

**PillCam UGI capsules: Esophagus and upper GI**
PillCam UGI capsules contain two video cameras (one at each end) with prolonged operation time and adaptive frame rate.

**PillCam Crohn’s**

**PillCam Crohn’s capsule: Small bowel and colon**
PillCam Crohn’s capsules contain two video cameras (one at each end). PillCam Crohn’s is an enhanced imaging capability adaptive frame rate (AFR) variant.

**PillCam Patency Capsule**

**PillCam Patency capsule**
The PillCam patency capsule is an ingestible and dissolvable capsule used to verify the patency of the GI tract.
Handling PillCam Capsules

PillCam capsules are packaged using a controlled process that ensures the capsule is activated only when needed. Each PillCam capsule is packed in a separate box with an embedded magnet that prevents it from activating when it is handled in the box prior to ingestion.

Caution
To avoid accidental activation (blinking) of the capsule while in its box:
- Keep the PillCam capsules in their box until use.
- Store the PillCam capsules only in the packaging supplied with the product.
- Do not use a PillCam capsule if the packaging is damaged.
- Keep the capsule package away from strong magnetic fields (such as MRI devices).
- Stack PillCam capsule boxes with the clear lid facing up only; never stack capsule boxes lid to lid.
- Keep metal objects away from the lid of the capsule box.
- After ingesting the PillCam COLON/PillCam Crohn’s capsule, instruct the patient not to sit on bare metal surfaces, such as chairs with a metal sitting area, during the procedure.

PillCam Recorders

The PillCam recorder is a compact battery-operated unit worn by the patient during the procedure which receives and stores the image data transmitted by the PillCam capsule. The following PillCam recorder models are available:
- PillCam recorder DR3
- PillCam recorder DR2

The PillCam recorder is supplied with a pouch, which is worn over the shoulder and includes an adjustable strap to allow securing the pouch to the waist.

PillCam recorder DR2

The PillCam recorder DR2 is a compact battery operated unit worn by the patient during PillCam capsule endoscopy. It receives and stores the image data transmitted by the PillCam capsule. The PillCam recorder is supplied with a pouch to wear over the shoulder and with an adjustable strap to secure to the waist.
PillCam recorder DR3
The PillCam recorder DR3 is a compact battery operated unit worn by the patient during PillCam capsule endoscopy. The PillCam recorder DR3 consists of a receiver, a transmitter, and a memory device for storing the data transmitted by the PillCam capsule. The battery of the PillCam recorder DR3 is charged while the PillCam recorder is in its cradle.

PillCam Sensor Arrays and Sensor Belts
The data transmitted from the capsule is received by sensors and transferred to the PillCam recorder. These sensors are either placed on the patient as a sensor array or incorporated as part of the sensor belt.

The PillCam sensor array and belt are connected to the PillCam recorder by a flexible cable.

Note
The PillCam Capsule Endoscopy System components do not contain any natural rubber latex components.

PillCam Sensor Belt
The sensors are part of the sensor belt and are hidden from view. The sensor belt is worn around the patient’s waist over a thin shirt. The sensors incorporated within the belt eliminate the need for applying adhesive sensor sleeves and reduces patient preparation time and equipment maintenance.

PillCam Sensor Belt, DR3 SB3
This sensor belt model is for small bowel capsule endoscopies performed with PillCam recorder DR3.
PillCam Sensor Belt, DR3 C2
This sensor belt model includes a back sensor and is for colon capsule endoscopies performed with PillCam recorder DR3.

Sensor Array
The sensors of the sensor array are attached to the patient’s skin. The sensor locations depend on the procedure type. Each sensor consists of a flexible printed circuit board (PCB) and is attached with a disposable, medical adhesive sleeve.

3-Lead Sensor Array
Used in PillCam UGI capsule procedures.

8-Lead Sensor Array
Used in PillCam SB, COLON, and Crohn’s capsule procedures.
PillCam Desktop Software

PillCam Desktop software enables efficient management of PillCam capsule endoscopy studies from initiation, through review and analysis, to report generation.

PillCam software is supplied as:

- **PillCam Desktop Software**: Installs on your PC.
- **PillCam Desktop Workstation**: A dedicated PC with the PillCam software pre-installed.
- **PillCam Reader Software**: A limited version of the software which includes all PillCam Desktop features, except for creating videos. This provides the flexibility to review and interpret videos on another computer instead of the main PillCam workstation.

**Note**

- Your version of the PillCam software may include different types of software (for example, the full PillCam Desktop version to install on your PC, plus copies of PillCam Reader to install on multiple PCs used only for video review and reporting).
- You cannot install PillCam Reader on a PC on which PillCam Desktop was already installed.
- Throughout this manual, PillCam Desktop implies any version unless specifically noted.

Refer to **Installing PillCam Desktop** on page 33 for instructions on installing and getting started with the PillCam software.
Indications, Contraindications, Warnings, Cautions

Indications for Use

PillCam SB

The PillCam Capsule Endoscopy System with the PillCam SB capsule is intended for visualization of the small bowel mucosa.

- The PillCam Capsule Endoscopy System with the PillCam SB capsule may be used in the visualization and monitoring of lesions that may indicate Crohn's disease not detected by upper and lower endoscopy.
- The PillCam Capsule Endoscopy System with the PillCam SB capsule may be used in the visualization and monitoring of lesions that may be a source of occult bleeding not detected by upper and lower endoscopy.
- The PillCam Capsule Endoscopy System with the PillCam SB capsule may be used in the visualization and monitoring of lesions that may be potential causes of iron deficiency anemia (IDA) not detected by upper and lower endoscopy.

The Suspected Blood Indicator (SBI) feature is intended to mark frames of the video suspected of containing blood or red areas.

The PillCam Capsule Endoscopy System with PillCam SB capsules may be used as a tool in the detection of abnormalities of the small bowel and is intended for use in adults and children from two years of age.

PillCam UGI

The PillCam UGI capsule endoscopy system is intended for visualization of the upper gastrointestinal tract (esophagus, stomach, duodenum). It may be used for the detection of gross blood in the esophagus, stomach, duodenum in patients from 18 years old.

PillCam COLON

The PillCam Capsule Endoscopy System with the PillCam COLON capsule is intended for the visualization of the colon for diagnosis of colonic disorders.

- The PillCam COLON capsule is further intended in the visualization and monitoring of lesions associated with Crohn's disease in the small bowel and colon.
- The PillCam COLON capsule is intended for use in adults and children from 8 years of age.
PillCam Crohn’s

The PillCam Crohn’s capsule is intended for visualization of the small bowel and colonic mucosa.

- It may be used in the visualization and monitoring of lesions that may indicate Crohn’s disease.
- It may be used in the visualization and monitoring of lesions that may be a source of obscure bleeding (either overt or occult).
- It may be used in the visualization and monitoring of lesions that may be potential causes of iron deficiency anemia (IDA).

The PillCam Crohn’s capsule may be used as a tool in the detection of abnormalities of the small bowel and colon. It is intended for use in adults and children from 8 years of age.

Contraindications

PillCam SB

The PillCam SB capsules are contraindicated for use under the following conditions:

- In patients with known or suspected gastrointestinal obstruction, strictures, or fistulas based on the clinical picture or pre-procedure testing and profile.
- In patients with cardiac pacemakers or other implanted electromedical devices.
- In patients with dysphagia or other swallowing disorders.

Note

The SB PillCam Capsule may be deployed by using transendoscopic delivery in patients who are either unable to ingest the PillCam capsule or are known to have slow gastric emptying time. Placement into the duodenum is recommended to prevent the patient from vomiting the capsule.

PillCam UGI

The PillCam UGI capsule is contraindicated for use under the following conditions:

- In patients with known or suspected gastrointestinal obstruction, strictures, or fistulas based on the clinical picture or preprocedure testing and profile.
- In patients with cardiac pacemakers or other implanted electromedical devices.
• In patients with dysphagia or other swallowing disorders.

Note
This device is not meant to replace upper endoscopy.

PillCam COLON/PillCam Crohn’s
The PillCam COLON/PillCam Crohn’s capsule is contraindicated for use under the following conditions:
• In patients with known or suspected gastrointestinal obstruction, strictures, or fistulas based on the clinical picture or pre-procedure testing and profile.
• In patients with cardiac pacemakers or other implanted electromedical devices.
• In patients with dysphagia or other swallowing disorders.
• In patients with allergies or known contraindication to the medications and preparation agents used in the procedure as described in the relevant instructions for use.

Adverse Events
Potential adverse events associated with the use of this device may include delayed or no excretion of the capsule, aspiration, obstruction, perforation, and mucosal injury or bleeding. In some instances, intervention is required to remove the capsule.

Warnings

Warning
PillCam capsules are MR unsafe.

Procedure Related:
• A normal or negative capsule endoscopy examination does not exclude the possibility of colon polyps or colon cancer.
• A negative or normal result obtained by the PillCam video capsule does not exclude the presence of pathology and if symptoms persist, further evaluation should be performed.
• The safety of the PillCam SB capsule has not been established in children below two years of age.
• The safety of the PillCam UGI capsule has not been established in patients below age 18.
• The safety of the PillCam COLON/PillCam Crohn’s capsule has not been established in patients below age 8.
• In a small number of cases, the PillCam COLON/PillCam Crohn’s capsule used for colon capsule endoscopy may not image the entire large bowel (colon) due to variations in patient GI motility. In the MA-204 study 104 (11.8%) subjects were excluded due to issues with the capsule procedure including 77 (8.7%) subjects with inadequate cleansing or short transit time for the capsule.
• If an adequate cleansing level is not achieved and the total transit time of the capsule is less than 40 minutes related, a repeat evaluation should be considered with the PillCam COLON/PillCam Crohn’s capsule, or with alternative diagnostic modalities.

• The capsule should not be swallowed by children under the age of 8 years or patients where a concern for aspiration of the capsule exists (e.g., due to cognitive or neurological deficits or a history of aspiration). In these patients, it is recommended that a capsule endoscopic delivery system be used to place the capsule directly in the duodenum. Placement of the capsule in the duodenum will decrease the risk of aspiration of the device [by vomiting] and gastric retention.

• Examine both video streams when viewing the results of a PillCam COLON/PillCam Crohn’s capsule endoscopy.

• If intestinal fistulas, strictures, or stenosis are suspected, or the patient has had prior abdominal or pelvic surgery, the physician should consider performing an examination to ascertain patency for an object the size of the PillCam video capsule.

• A thorough understanding of the technical principles, clinical applications and risks associated with the PillCam system is necessary before using this product. Read the entire manual before using the system for the first time.

• To prevent the patient from being exposed to unforeseen risks during passage of any PillCam video capsule, make sure the patient thoroughly understands the procedure, and provide the patient with a copy of the Patient Instructions.

• A patient with known or suspected delayed gastric emptying (whether disease related or drug induced) could be at increased risk for incomplete PillCam capsule endoscopy of the small bowel or colon.

• When swallowing the capsule there is a possibility of choking on the capsule. If the patient exhibits any symptoms and/or clinical signs of choking (labored breathing, wheezing, involuntary coughing, etc.), the recommended first-aid procedure should be followed.

• If a child has accidentally swallowed any unused or spent PillCam video capsule, seek medical attention.

• Instruct the patient not to sit on bare metal surfaces, such as chairs with metal seating area, during the procedure.

• Instruct the patient to contact the physician immediately if, after ingesting any PillCam video capsule, there is any abdominal pain, nausea, or vomiting.

• Only one PillCam video capsule should be ingested at a time and only after confirmation that no other PillCam video capsules or ingestible diagnostic devices remain in the patient’s body.

• If, contrary to instructions, a patient ingests more than one PillCam video capsule, instruct the patient to immediately contact the physician.

• In patients with unsuspected strictures of the GI tract, any PillCam video capsule can potentially cause intestinal obstruction resulting in the need for hospitalization and surgery.

• The safety of this device in pregnant women has not been established.

• The safety of this device in patients with significant gastrointestinal diverticular disease is unknown.

• Final diagnosis based on the PillCam Desktop video should be made only by physicians who are trained in the interpretation of capsule endoscopy images.
Product Related:

- If there is reasonable doubt concerning the integrity of the PillCam video capsule due to dropping, biting, or any other eventuality, the capsule should be deactivated by returning it to its box and it should not be used until consulting with an authorized Given Imaging representative.
- Store all PillCam video capsules in a safe place, out of the reach of children and infants.
- Do not use any PillCam video capsule after its expiration date.
- Instruct the patient to avoid biting the PillCam video capsule prior to swallowing.
- Instruct the patient to wear the PillCam recorder throughout the procedure for as long as the PillCam recorder LED continues to blink at the ingested capsule’s blinking rate.
- Review the time bar of the PillCam video to determine if video gaps exist, which may result in the need to repeat the capsule endoscopy procedure. This is important if the procedure results in a normal or negative capsule endoscopy examination.
- Occasionally, some images may be lost which results in video gaps (shown as a gray section on the time bar display of the PillCam video) due to radio interference (e.g., from amateur radio transmitters, RFID (radio-frequency identification) systems, MRI). This may result in the need to repeat the capsule endoscopy procedure. In such a case, advise the patient to stay within the premises of the clinic for the duration of the second capsule endoscopy procedure to prevent this problem from recurring.

Electromagnetic Compatibility Related:

- After ingesting the PillCam video capsule and until it is excreted, the patient should not be near any source of powerful electromagnetic fields such as one created near an MRI device.
- Keep the magnet of the PillCam video capsule’s packaging away from implants such as pacemakers, defibrillators, nerve stimulators, and other devices that could be affected by proximity to a DC magnetic field.
- Undergoing an MRI while the PillCam video capsule is inside the patient’s body may result in serious damage to his/her intestinal tract or abdominal cavity. If the patient did not positively verify the excretion of any PillCam video capsule from his/her body, he/she should contact the physician for evaluation and possible abdominal X-ray before undergoing an MRI examination.
- PillCam Capsule Endoscopy System and its components need special precautions regarding Electromagnetic Compatibility (EMC) to avoid loss of image transfer resulting in video gaps. PillCam Capsule Endoscopy System needs to be installed and put into service according to the Electromagnetic Compatibility (EMC) information provided in the accompanying documents.
- The use of the accessory with PillCam capsule other than those specified may result in increased emissions or decreased immunity of the PillCam capsule.

Recorder Related:

- A PillCam video capsule should be ingested only in the presence of authorized medical personnel. The patient should be instructed not to let relatives, neighbors or acquaintances use any PillCam video capsule without medical attention.
- If excretion of the PillCam video capsule from the patient has not been positively verified, and the patient develops unexplained post-procedure abdominal pain, vomiting, or other symptoms of obstruction, he/she should contact the physician for evaluation and possible abdominal X-ray examination.
- Never connect the PillCam recorder to the sensor array while the PillCam recorder is in its cradle.
• The PillCam video capsule and PillCam recorder should not be used adjacent to or stacked with other equipment and that if adjacent or stacked use is necessary, the equipment or system should be observed to verify normal operation in the configuration in which it will be used.

• Portable and mobile RF communications equipment can affect the PillCam video capsule and the PillCam recorder.

• The PillCam video capsule may be interfered with by other equipment, even if that other equipment complies with CISPR emission requirements.

• The Lithium-Ion battery pack in the PillCam recorder DR3 incorporates built-in safety devices.

• Do not use the PillCam recorder in a location where static electricity (greater than the manufacturer’s guarantee) may be present. Otherwise, the safety devices can be damaged, possibly leading to acid leakage, overheating, smoke emission, bursting and/or ignition.

Cautions

A caution indicates a condition that may damage the equipment.

• Make sure that only trained personnel, familiar with all of the PillCam Capsule Endoscopy System operating procedures, use the system.

• Endoscopic video capsule placement requires skill and experience in endoscopic esophageal intubations with an accessory device seated at the distal tip of the endoscope. Use of the device is not recommended if the clinician lacks the required experience and proficiency.

• Use the system only with components purchased from Given Imaging. Use of other components including power supply for the cradle, may damage the system and void the warranty.

• In a small number of cases, the PillCam SB capsules used for Small Bowel Capsule Endoscopy may not image the entire small bowel due to variations in patient GI motility. Similarly the PillCam COLON/PillCam Crohn’s capsule used for colon capsule endoscopy may not image the entire large bowel (colon) due to variations in patient GI motility.

• Final diagnosis based on the PillCam video should be made only by physicians who are trained in the interpretation of capsule endoscopy images.

Benefits and Risks—PillCam Capsule Endoscopy

Benefits

• PillCam capsule endoscopy is the most widely used patient-friendly tool for visualization of the GI tract. To date, more than 3,000,000 patients worldwide have benefited from PillCam endoscopy.

• After the patient swallows the PillCam video capsule, images and data are transmitted wirelessly as the capsule passes through the digestive system. The images are captured and stored in a PillCam recorder worn by the patient; after the procedure is complete the images are reviewed by a physician.

• The procedure does not require sedation, intubation, bowel insufflation or radiation.

• Patients may continue with their normal daily activity during the procedure.

• PillCam capsule endoscopy offers a simple, safe and non-invasive alternative to traditional imaging procedures.
• The PillCam Patency capsule provides a simple and convenient means to verify functional patency of the GI tract in patients with known or suspected strictures.

**Risks**

• A normal or negative capsule endoscopy examination does not exclude the possibility of colon polyps or colon cancer.

• PillCam capsule endoscopy is not for everyone. PillCam video capsules are contraindicated in patients with known or suspected gastrointestinal obstruction, strictures or fistulas, in patients with cardiac pacemakers or other implantable electromedical devices and in patients with swallowing disorders.

• Capsule retention has been reported in less than two percent of all capsule endoscopy and patency procedures. Capsule retention is defined as having a capsule remain in the digestive tract for more than two weeks.

• Causes of retention cited in the literature include: NSAID strictures, Crohn’s disease, small bowel tumors, intestinal adhesions, ulcerations, and radiation enteritis. Summaries in published literature identify the overall risk of retention for capsule endoscopy to be 1.4%. The risk of retention for obscure bleeding is estimated to be 1.2%, for suspected Crohn’s disease to be 2.6%, for known Crohn’s the risk is higher at 5% and for neoplastic lesions the rate of retention is 2.1% as compared to healthy volunteers [1]. To verify passage of the capsule from the GI tract, an abdominal X-ray may be obtained at the discretion of the physician. The capsule can be removed using medical, endoscopic or surgical intervention.

• There is an extremely rare risk of capsule aspiration while patients are attempting to swallow a PillCam video capsule or Patency capsule.

• There is also a low risk of skin irritation from the sensor array sleeve adhesive or silicone exposure.

• The PillCam SB video capsule may be administered by using transendoscopic delivery in patients who are either unable to ingest the capsule or are known to have slow gastric emptying time. If using transendoscopic delivery potential complications include, but are not limited to: perforation, hemorrhage, aspiration, fever, infection, hypertension, respiratory arrest, cardiac arrhythmia or arrest, due to the transendoscopic procedure.

• PillCam Patency capsules are contraindicated in patients with swallowing disorders. The PillCam Patency Scanner is contraindicated in patients with cardiac pacemakers or other implanted electromedical devices.

• All medical procedures carry some risks. Information on this site should not be used as a substitute for talking with your doctor about diagnosis and treatment.

**References:**

[1] Liao et al., Indications and detection, completion, and retention rates of small-bowel capsule endoscopy: a systematic review, Gastrointestinal Endoscopy, 2010; 71:280-286
Essential Performance

PillCam Video Capsules

ON-Mode
Data transmitting to PillCam recorder is considered to be essential performance of the PillCam capsules. The PillCam capsules shall transmit data continuously monitored by on-line image display as received by PillCam recorder.

OFF-Mode
No unintentional transmissions are allowed.

PillCam Recorder DR2 and PillCam Recorder DR3
Data receiving by PillCam recorder is considered to be essential performance of the PillCam recorder DR2 and PillCam recorder DR3.

Accuracy of the Device—SB
The PillCam Capsule Endoscopy System with the PillCam SB 1 capsule was studied in a series of 20 subjects with hemoccult positive stool, iron-deficiency anemia, and/or subacute hematochezia or melena. All patients had undergone unrevealing colonoscopy, gastroscopy, enteroscopy, and small bowel X-rays prior to enrolling in the study. When compared to repeated push enteroscopy, the PillCam video capsule was able to detect a pathological abnormality in 12 (60%) of the patients whereas enteroscopy detected abnormalities in 7 (35%) of these patients. The 5 patients in whom lesions were found by the PillCam video capsule but not enteroscopy all had abnormalities in the distal jejunum or ileum, outside the reach of most standard enteroscopy examinations. The average length of insertion during enteroscopy was 2.3 meters. Specific findings detected by the imaging system included arterio-venous malformations (AVMs), mucosal erosions and ulcerations, and a submucosal tumor. In one case (5%), though the PillCam video capsule detected a small bowel AVM that was found by enteroscopy, one out of the two reviewing physicians did not detect the AVM when reviewing the PillCam Desktop video.

Overall, the findings obtained from the PillCam Capsule Endoscopy System and standard enteroscopy agreed in 14 cases (70%). The two methods revealed similar pathologies in 6 of these patients. Both exams were normal in an additional 8 patients. [1]

A total of 14 separate small bowel findings were eventually noted in 13 patients by either of the two imaging modalities or by laparoscopic surgery. The PillCam Capsule Endoscopy System was able to identify 12 of the 14 lesions (86%) while the enteroscopy detected 7 of the 14 lesions (50%). Both repeated enteroscopies, small bowel X-rays and the PillCam video capsule, failed to detect an ulcerated Meckel’s diverticulum found at surgery.

PillCam video capsule localization is based on off-line processing of the strength of the radio frequency signals emitted from the PillCam video capsule as received by each of the eight sensors. The information helps estimate the relative two-dimensional location of the PillCam video capsule with respect to the umbilicus (e.g., abdominal quadrant).
The localization software was studied in a series of 17 healthy subjects. Multiple fluoroscopic images (92 sets) were obtained at various times during the PillCam video capsule’s passage through the small bowel. The location was assessed in two dimensions relative to the umbilicus and then compared to the position obtained from the localization software. When compared to the relative two-dimensional location determined fluoroscopically, approximately 87% (80/92) of the PillCam video capsule estimates were within 6cm (a “fist”). The mean error for PillCam video capsule localization was found to be 3.8 cm. [2]

The Suspected Blood Indicator (SBI) feature is intended to mark frames suspected of containing fresh blood. The feature may be activated only after labeling the first duodenal image and marks frames contained only within the small bowel. The SBI feature should not serve as a substitute for a physician’s complete viewing of the video but rather to provide supplemental information afterwards. All events marked by the SBI feature should be carefully reviewed by a physician. In a review of 27 patients with at least one red or bleeding lesion found by a physician on capsule endoscopy, the SBI feature correctly marked 439, or 88%, of the 498 individual lesions. In addition, a total of 561 false positive lesions were marked by the feature, giving a positive predictive value (PPV) of 44%. [3]

References:
[1] Clinical report presented in K010312
[2] Clinical report presented in K020341
[3] Clinical report presented in K022980

Accuracy of the Device—UGI

The PillCam Capsule Endoscopy System with the PillCam UGI capsule was evaluated in adults with acute upper gastrointestinal hemorrhage presenting to the emergency departments of two academic medical centers. The study enrolled 49 patients who ingested the PillCam capsule, which was followed immediately by nasogastric tube aspiration and later (12-24 hours later) by esophagastroduodenoscopy (EGD).

Capsule endoscopy was compared with nasogastric tube aspiration for determination of the presence of gross blood in the upper GI tract (primary endpoint).

Analysis was performed on 41 patients for the primary endpoint.

There were 18/41 patients (43.9%) who were found to have gross blood in the upper gastrointestinal tract as determined by either capsule endoscopy, nasogastric aspiration, or by both modalities. Blood was detected in the upper gastrointestinal tract significantly more often by capsule endoscopy (15 / 18 [83.3%]) than by nasogastric aspiration (6 / 18 [33.3%]; P=0.035).

The PillCam UGI capsule reached the duodenum in 45/46 patients (98%).

Accuracy of the Device—COLON

A combined analysis of three studies performed on patients with suspected colonic polyps was performed. It includes 202 patients who underwent both PillCam COLON 2 capsule endoscopy (PCE) and conventional colonoscopy. The studies were designed to assess the detection of colonic polyps. The accuracy parameters for PCE, in detecting patients with polyps > 6mm and polyps > 10mm, were evaluated against colonoscopy which was considered as the gold standard. Results are presented in the table hereafter:

<table>
<thead>
<tr>
<th>Polyp size</th>
<th>Sensitivity (95% CI)</th>
<th>Specificity (95% CI)</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; 80.36</td>
<td>84 (77-90)</td>
<td>79 (74-82)</td>
</tr>
<tr>
<td>80.36</td>
<td>82 (72-88)</td>
<td>94 (91-96)</td>
</tr>
</tbody>
</table>

Capsule endoscopy of the PillCam COLON 2 system appears to show good sensitivity and specificity for detecting patients with polyps > 6 mm and > 10 mm.

Accuracy of the Device—Crohn’s

The PillCam Capsule Endoscopy System with the PillCam Crohn’s capsule was studied in a series of 66 subjects included in the study. Patients included in this clinical study were adults with known Crohn’s disease (CD) and signs and symptoms of active disease.

All patients followed a bowel preparation regimen and underwent PillCam Crohn’s capsule endoscopy followed by ileocolonoscopy (IC) procedure on the same day or by the following day per physician discretion (in such case, the subject was required to stay on a clear liquid diet), to compare the results of the PillCam Crohn’s capsule endoscopy with ileocolonoscopy in assessing the active Crohn’s disease in their TI and/or colon and small bowel.

Pathologies identified during the PillCam Crohn’s capsule and IC procedures were analyzed by their type and relation to Crohn’s disease. Each lesion was classified as “Active Crohn’s disease” or “Non active Crohn’s disease”.

Diagnostic yield per patient at the TI and colon

Each patient was classified as follows:

- Active Crohn’s disease is likely
- Active Crohn’s disease is NOT likely

Diagnostic yield was evaluated as the percentage of subjects who were classified under the category “Active Crohn’s disease is likely” (i.e., “Positive by both modalities” and “Positive by PillCam Crohn’s capsule” events for PillCam Crohn’s capsule and “Positive by both modalities” & “Positive by IC” events for IC) out of the entire population which included in the efficacy analysis.

---

1. Evaluation of the PillCam Endoscopy System with the PillCam Crohn's Disease Capsule in Visualization of Lesions in the Small Bowel and Colon that may indicate Crohn's Disease (MA-206)
The diagnostic yield results of patient classified as “Active Crohn's disease is likely” are depicted in the table below.

<table>
<thead>
<tr>
<th>Positive by IC</th>
<th>Positive by both modalities</th>
<th>Positive by PillCam Crohn’s capsule</th>
<th>Negative by both modalities</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>43</td>
<td>12</td>
<td>8</td>
</tr>
<tr>
<td>5%</td>
<td>65%</td>
<td>18%</td>
<td>12%</td>
</tr>
</tbody>
</table>

Total of 46 patients were classified based on IC as “Active Crohn’s disease is likely”, CE classified 43 (93%) cases out of them similarly (i.e., “Active Crohn’s disease is likely”).

No significant difference was found between CE and IC in classifying patients having active Crohn’s Disease (McNemar test - P.value ≤0.426), meaning that both modalities classified the patients similarly.

**Diagnostic yield of CE at SB**

Proximal SB was evaluated only by PillCam Crohn’s capsule.

Diagnostic events were defined as such:

- Active Crohn’s disease in proximal SB is likely
- Active Crohn’s disease in proximal SB is NOT likely

Diagnostic yield was evaluated as the percentage of patients who were classified under the category “Active Crohn's disease in proximal SB is likely” out of the population which included in the efficacy analysis. Diagnostic yield was provided with 95% confidence interval.

Thirty {45%, (95% CI, 33% to 58%)} patients were classified under the category “Active Crohn's disease in proximal SB is likely” out of the 66 cases which were included in the efficacy analysis.
Chapter 3

Preparing for Capsule Endoscopy

This section lists what should be done by the patient at home, and at the clinic in preparation for the procedure.

This chapter includes the following main topics:

- **Patient Preparations—Before the Procedure** on page 23
- **Preparations at the Clinic** on page 24

**Patient Preparations—Before the Procedure**

This section guides you through providing the patient with relevant information in preparation for the capsule endoscopy procedure.

**Preparing the Patient**

Once it is decided that the patient should undergo capsule endoscopy, use the checklist below to make sure the patient is prepared and informed regarding the procedure:

<table>
<thead>
<tr>
<th>Checklist - Patient Preparations</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Verify that no contraindications apply to the patient (see Indications, Contraindications, Warnings, Cautions on page 11).</td>
</tr>
<tr>
<td>• Inform the patient of the small possibility of bowel obstruction.</td>
</tr>
<tr>
<td>• Inform the patient of the importance of a clean bowel for the success of the PillCam examination.</td>
</tr>
<tr>
<td>• Instruct the patient what to expect before, during, and after the procedure.</td>
</tr>
<tr>
<td>• Obtain the patient’s informed consent.</td>
</tr>
<tr>
<td>• Provide the patient with the appropriate pre-ingestion instructions. Refer to the Patient Instructions supplied with the installation media.</td>
</tr>
<tr>
<td>• For procedures involving visualization of the colon: Use the Regimen Manager to create and select pre- and post-ingestion instructions (see Using the Regimen Manager to Prepare Regimens for Colon Procedures on page 25). Print for the patient and explain how to use.</td>
</tr>
<tr>
<td>• Remind the patient to wear appropriate clothing:</td>
</tr>
<tr>
<td>• If using the sensor belt, the patient should wear an upper garment of thin, natural fiber cloth that is long enough to reach at least hip level and will not ride up above the belt.</td>
</tr>
<tr>
<td>• If using the sensor array, the patient should wear loose-fitting, two-piece opaque clothing.</td>
</tr>
</tbody>
</table>
Printing Pre-ingestion Instruction Handouts

Print pre-ingestion instructions for the respective PillCam procedure and give them to the patient before the day of the procedure.

Take note that:

- PillCam SB and PillCam UGI procedures have predefined pre-ingestion instruction text. The instructions are provided as a PDF file, with editable fields.
- For PillCam COLON/Crohn’s procedures it is possible to create customizable pre-ingestion instructions using the Regimen Manager tool. The pre-ingestion bowel preparation for colon procedures includes instructions on when the patient should stop taking iron supplements, start a Clear Liquid Diet, and ingest laxatives.

All these instructions, including the customized laxative schedule, are embedded in the pre-ingestion regimen instructions.

For instructions on preparing pre-ingestion instructions, see Creating Pre-Ingestion Patient Instructions on page 26.

Preparations at the Clinic

This section lists preparations that are performed at the clinic prior to the capsule endoscopy procedure.

Preparing the Required Equipment

Before the patient arrives for the procedure, verify that the following equipment and accessories are ready for the procedure:

<table>
<thead>
<tr>
<th>Checklist - Preparing for the CE procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>PillCam Desktop</td>
</tr>
<tr>
<td>Make sure PillCam Desktop is installed and configured for first-use.</td>
</tr>
<tr>
<td>PillCam capsule (UGI, SB, COLON, Crohn’s)</td>
</tr>
<tr>
<td>Take note of Handling PillCam Capsules on page 6.</td>
</tr>
<tr>
<td>PillCam recorder</td>
</tr>
<tr>
<td>Make sure the PillCam recorder is fully charged.</td>
</tr>
<tr>
<td>PillCam recorder pouch</td>
</tr>
<tr>
<td>Prepare PillCam recorder pouch with shoulder strap.</td>
</tr>
<tr>
<td>Printed instructions</td>
</tr>
<tr>
<td>Print the patient instructions.</td>
</tr>
<tr>
<td>PillCam sensor belt or PillCam sensor array</td>
</tr>
<tr>
<td>Prepare the belt or, if using a sensor array, make sure the sensors are already inserted in the sleeves.</td>
</tr>
<tr>
<td>Sensor Location Guide</td>
</tr>
<tr>
<td>Prepare the necessary sensor location guide.</td>
</tr>
<tr>
<td>Prepare a drinking cup and water</td>
</tr>
<tr>
<td>Medication</td>
</tr>
<tr>
<td>Prepare any medication prescribed for the patient during the procedure.</td>
</tr>
</tbody>
</table>
Using the Regimen Manager to Prepare Regimens for Colon Procedures

The Regimen Manager is a tool for generating pre-capsule ingestion regimen instructions to give to the patient before the day of the procedure, and post-capsule ingestion regimen instructions for the patient to follow during the capsule endoscopy procedure.

The Regimen Manager allows creating and maintaining different sets of instructions which can be adapted to different circumstances and procedures. The post-capsule ingestion regimen instruction set is selected during Check-in from the regimen library. The instruction set is uploaded to the PillCam recorder DR3 and is used to create timely alerts for the patient during the procedure.

This section provides an overview of the Regimen Manager tool and includes instructions for the following main tasks:

- Accessing the Regimen Manager on page 25
- Creating Pre-Ingestion Patient Instructions on page 26
- Post-Ingestion Patient Instructions on page 28
- Printing the Patient Instructions on page 30
- Print Layout of the Post-Capsule Ingestion Instructions on page 31

Accessing the Regimen Manager

The Regimen Manager includes several pre-loaded pre- and post-capsule ingestion regimens that can be modified for the current procedure. Regimens must be in an approved status in order to be used. By default, the pre-loaded regimens in the library are not in an approved status.

To access the Regimen Manager:

1. From the Home screen select Tools > Regimen Manager.
2. Double click or select a regimen and click the Open button to view the regimen.
3. See the sections that follow for instructions on creating and approving pre- and post-capsule ingestion regimens.

A description of the Regimen Manager main screen follows.
The buttons at the bottom of the Regimen Manager screen allow performing the following tasks:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates a new regimen to add to the regimen library.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens the selected regimen.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected regimen. All regimens, including the pre-loaded</td>
</tr>
<tr>
<td></td>
<td>regimens can be deleted.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the selected regimen. This button becomes available only after</td>
</tr>
<tr>
<td></td>
<td>a regimen is approved.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Displays a preview of the selected regimen before printing.</td>
</tr>
<tr>
<td></td>
<td>This button becomes available only after a regimen is approved.</td>
</tr>
<tr>
<td>Import</td>
<td>Imports a regimen from a selected directory. The default directory is</td>
</tr>
<tr>
<td></td>
<td>defined in <strong>Tools &gt; Settings &gt; Regimens Directory</strong>.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports a regimen to a selected directory. The default directory is</td>
</tr>
<tr>
<td></td>
<td>defined in <strong>Tools &gt; Settings &gt; Regimens Directory</strong>.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Regimen Manager.</td>
</tr>
</tbody>
</table>

**Creating Pre-Ingestion Patient Instructions**

A completely clean colon is essential for a successful examination. Therefore, the patient must carefully adhere to the preparation procedure for cleaning the GI tract. The Regimen Manager can be used to create and print instructions for the patient to follow before the planned PillCam COLON/ PillCam Crohn’s capsule endoscopy procedure.

The instructions list the type of medications and liquid intake that must be taken in order to prepare the colon prior to the procedure. The preparation instructions can be edited to accommodate
Preparing for Capsule Endoscopy

different circumstances or available medications, and then saved to maintain a library of valid usable regimen instruction sets.

To create pre-capsule ingestion regimen instructions:

1. In the Regimen Manager, select the **Pre-capsule Ingestion** tab. A list of all available pre-ingestion regimens appears.

2. Open a regimen by double clicking or selecting the regimen and clicking **Open**.

   If a regimen has not yet been approved, you will be prompted to do so. Click the **Review** button to view the regimen.

3. In the **Background Information** section, you can enter information for the specific regimen in the **Notes** field. This information will not appear on the printout.

4. In the **Printed Information** section, you can add and edit instructions which will be included in the printed instructions. You can perform the following tasks:
   
   - Edit existing instructions using the drop-down lists in the adjacent columns. For predefined instructions, information represented in brackets [ ] is generic and allows entering local names of the solution.
   - Click the **Add Instruction** button to add a new instruction. Designate the appropriate start day, start and end time of the instruction, and enter text in the **Instructions for Patient** text box as necessary. A pop up screen appears if the **Instructions for Patient** text is too long. Click **OK** to save the updated instruction.
   - Type any other relevant information in the **Additional Instructions** field. This text will appear on the printout for that specific regimen.
   - Select the **Clear liquid diet** check box if you wish to include instructions for a liquid diet. A list of **Allowed** and **Not Allowed** food and drink items appears. To modify these lists, click the **Edit** button. Make necessary edits and then click **Save** and **Close**.

---

Note
Regimens must be in an approved status in order to be used.
• Select the **Low fiber diet** check box if you wish to include instructions for a fiber diet. A list of **Allowed** and **Not Allowed** food or drink items appears. To modify these lists, click the **Edit** button. Make necessary edits and then click **Save** and **Close**.

**Note**
The **Liquid Diet** and **Fiber Diet** instructions are shared across all pre- capsule ingestion regimens. Any changes to the instructions will apply to all the pre- capsule ingestion regimens.

5. Under **Approval**, you can click **Approve Regimen** to approve the regimen. It is also possible to save the regimen and approve at a later date. A regimen must be approved in order to be printed.

6. Click **Save** to save any changes to the regimen. The regimen will be added to the library of regimens available.

7. If necessary, use the **Print Preview** and **Print** buttons to preview and print the regimen.

**Post-Ingestion Patient Instructions**

In order to ensure a successful procedure after PillCam COLON/PillCam Crohn’s capsule ingestion, the patient must carefully adhere to the personalized Post-Capsule Ingestion Instructions. The post-capsule ingestion regimen is selected during patient check-in (*Performing Patient Check-in* on page 48) and uploaded to the PillCam recorder DR3. The PillCam recorder DR3 alerts the patient as to specific medications or liquids that must be ingested at specified times during the procedure. These regimen instructions can be added, edited, saved, and approved through the Regimen Manager.

The PillCam recorder DR3 uses a tactile and sound alert to notify the patient of a scheduled event by displaying the event number on the LCD screen. The patient follows the instructions for the associated event number in the Post-Ingestion Patient Instructions which are printed out and provided by the medical staff.

By default, the post-capsule ingestion regimen includes at least the following alerts and instructions:

- **Alert 0**: An instruction #0 (based on time passed from capsule ingestion) to take prokinetics to facilitate passage of the PillCam COLON 2/PillCam Crohn’s capsule to the small bowel. Threshold of time passed from capsule ingestion for alert 0 can be modified in the regimen manager for a specific regimen.

- **Alert 1**: An instruction #1 for taking laxative after detection by the PillCam recorder of PillCam COLON 2/PillCam Crohn’s passage into the small bowel. It coincides with the activation of the AFR mode in the PillCam COLON 2/PillCam Crohn’s capsule and the appearance of the AFR status icon in the right corner of the status line at the top of the PillCam recorder DR3 display. The appearance of alert 1 can be designated to appear either an additional 0 minutes or 15 minutes after the original tentative alert 1 timing. Alert 0 will not occur if alert 1 occurred before it.

- **The End of Procedure (EOP)** alert occurs when no more capsule images are received by the PillCam recorder or enough time has elapsed in the procedure. This may occur several minutes after capsule excretion or after the capsule battery was depleted without excretion in a long procedure.

Additional alerts and instructions can be inserted between Alert 1 and the EOP alert to reflect the physician’s preference for post-ingestion instructions in a PillCam COLON 2/PillCam Crohn’s procedure.
The following section explains how to edit the Post-Ingestion Patient Instructions. Approved regimens can be selected during the patient check-in stage and can be printed (see Printing the Patient Instructions on page 30).

To edit and save a post-ingestion regimen:

1. In the Regimen Manager, select the **Post-capsule Ingestion** tab. A list of all available post-ingestion regimens appears.

2. Open a regimen by double clicking or selecting the regimen and clicking **Open**.
   
   If a regimen has not yet been approved, you will be prompted to do so. Click the **Review** button to view the regimen.

3. In the **Background Information** section, you can enter information for the specific regimen in the **Notes** field. This information will not appear on the printout.

4. In the **Printed Information** section, you can add and edit instructions which will be included in the printed instructions. You can perform the following tasks:
   
   - Edit existing instructions using the drop-down lists in the adjacent columns. For predefined instructions, information represented in brackets [ ] is generic and allows entering local names of the solution.
   
   - Click the **Add Instruction** button to add a new instruction. Select the appropriate timing and trigger for the instruction and enter text in the **Instructions for Patient** text box as necessary. A pop up screen appears if the **Instructions for Patient** text is too long. Click **OK** to save the updated instruction.
   
   - Type any other relevant information in the **Additional Instructions** field. This text will appear on the printout for that specific regimen.

The **Recorder Display** column on the left lists the event numbers that will be displayed on the PillCam recorder LCD screen along with the corresponding alert.

The **Trigger** column on the right of the timing column indicates that the event will activate the recorder instruction. This can be delayed by using the drop-down list on the left of each trigger.
5. Under Approval, you can click Approve Regimen to approve the regimen. It is also possible to save the regimen and approve at a later date. A regimen must be approved in order to be printed.

6. Click Save to save any changes to the regimen. The regimen will be added to the library of regimens available.

7. If necessary, use the Print Preview and Print buttons to preview and print the regimen.

---

**Note**
Alert times are designated by the PillCam recorder and PillCam software. In rare cases, short delays may occur.

---

**Printing the Patient Instructions**

The pre-capsule ingestion instructions need to be handed to the patient 1 or 2 days prior to the ingestion and are needed for proper preparation of the patient for the procedure.

The post-capsule ingestion instructions need to be printed and handed to the patient after capsule ingestion. The reminder numbers on the screen of the PillCam recorder DR3 correspond to numbered instructions in the post capsule ingestion patient instructions but the instruction is not detailed on the PillCam recorder screen. You must print the post-capsule ingestion patient instructions for the patient to allow the association of the alerted number with the instruction details.

**To print the Pre-capsule Ingestion Regimen Instructions:**

1. In the Regimen Manager, select the Pre-capsule Ingestion tab. A list of all available pre-ingestion regimens appears.

2. Select the relevant instructions and click Print.

**To print the Post-capsule Ingestion Regimen Instructions:**

Take note of the Print Layout of the Post-Capsule Ingestion Instructions in the section that follows. Post-capsule ingestion regimen instructions can be printed in various ways:

- **During patient check-in:** Click Print Regimen. Note that the patient’s details are included in the printout.

- **After patient check-in via the Study Manager:** In the Study Manager, right-click the patient details and select the Print Preview Regimen option.

- **Via the Regimen Manager:** When printing from the Regimen Manager, patient details are not included.
  
a. In the Regimen Manager, select either the Post-capsule Ingestion tab or the Pre-capsule Ingestion tab. The relevant screen appears displaying all available patient instructions.

  b. Select the relevant instructions and click Print.

---

**Note**
Only approved regimens can be printed. When a regimen is approved the following text appears next to the Approve Regimen button: This Regimen is approved.
Print Layout of the Post-Capsule Ingestion Instructions

The Regimen Manager allows printing the post-capsule ingestion instructions in either pocket format or page format. The default layout can be configured under **Tools > Settings** and selecting the **Report** tab.

Printing in Pocket Format

When enabled, the post-capsule ingestion instructions will be printed in a convenient pocket format with fold lines for folding to an easy to carry size (quarter fold). The pocket format will show the instructions guide on one side and important contact information on the other.

If you have any questions, please contact:

---

Instructions During Your PillCam Procedure

- **Patient name:**
- **Patient ID:**
- **Procedure date:**

When the recorder beeps and vibrates:

- Check the number on the recorder screen and follow the matching instruction in the INSTRUCTION GUIDE table.

If you have any questions, please contact:

---

INSTRUCTION GUIDE

<table>
<thead>
<tr>
<th>#</th>
<th>INSTRUCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Ingest [ENTER LOCAL BRAND NAME OF 20mg DOMPERIDONE] with a glass of water. Continue complete fast (no additional drinking) until next alert.</td>
</tr>
<tr>
<td>1</td>
<td>Dilute [ENTER LOCAL BRAND NAME OF 30mL SODIUM PHOSPHATE] in a glass of water and drink it. Drink at least 1 liter of water over the next hour. You may resume drinking all clear liquids freely.</td>
</tr>
<tr>
<td>2</td>
<td>Dilute [ENTER LOCAL BRAND NAME OF 25mL SODIUM PHOSPHATE] in a glass of water and drink it. Drink at least 1 liter of water over the next hour. You may continue drinking all clear liquids freely.</td>
</tr>
<tr>
<td>3</td>
<td>Insert [ENTER LOCAL BRAND NAME OF 10mg BISACODYL SUPPOSITORY] according to instructions in package insert.</td>
</tr>
<tr>
<td>4</td>
<td>You may eat a light meal</td>
</tr>
</tbody>
</table>

---

End of Procedure. Please remove equipment from your body.

---

**Warning:**

- Use of this equipment may cause serious injury. Use this equipment only after carefully reading and understanding these instructions and the enclosed equipment manual. If you have any questions, please contact your healthcare provider.
- **Sensor Removal**
  - If you need to remove the sensor, please follow the instructions included in the equipment manual.

---

Fold lines

Fold the bottom part of the printout first
Printing in Page Format

When enabled the post-capsule ingestion instructions will be printed on a page layout displaying all information on one page.
Chapter 4

Installing and Setting up PillCam Desktop

This chapter covers the following topics, which guide you through installing and setting up the PillCam System:

- Installing PillCam Desktop on page 33
- Starting PillCam Desktop for the First Time on page 35
- Familiarizing yourself with the PillCam Desktop Home Screen on page 37
- Configuring PillCam Desktop for the First Time on page 38

Installing PillCam Desktop

Detailed instructions for installing PillCam Desktop are available in the PillCam Desktop IT Guide provided with the software package. This section lists the hardware components that you will need in order to work with PillCam Software and guides you through connecting the PillCam recorder to your PC.

Setup Requirements & Prerequisites

Before installing the PillCam software on the assigned computer, make sure you have the following available to accommodate the PillCam Capsule Endoscopy System:

- Monitor
- Keyboard
- Mouse
- Printer
- Four electrical outlets to connect the above components and the PillCam recorder cradle. Each additional cradle requires an additional outlet.

Note

- You may use a Given Imaging approved power strip.
- You may connect your monitor directly to the workstation using a DVI cable (the DVI-VGA adaptor is not required).
**Caution**
- Do not connect any component of the PillCam Capsule Endoscopy System to the same outlet together with any appliance or device that has a high power requirement (refrigerators, generators, devices with motors, etc.).
- When setting up the system, make sure that the total power requirements for all of the devices connected to a single outlet or circuit do not exceed the rated limit for that circuit. If you are not sure of the rated limit, please consult your maintenance department or an electrician.
- Do not use a KVM (Keyboard, Video, Mouse) Switch with the PillCam Capsule Endoscopy System.

**Note**
Extra space is needed for air circulation and cable connectors behind the workstation.

---

**Connecting the PillCam Desktop Workstation to the PillCam Recorder Cradle**

**Warning**
The PillCam Workstation has either an automatic or a manual voltage select switch. In case the workstation has a manual switch:
- Verify that the workstation's voltage is set according to the local voltage prior to connecting the PillCam workstation to the wall outlet.
- If the voltage is not set according to the local voltage, do not connect the system. Call Given Imaging Customer Support.

**Caution**
Voltage mismatch will damage the PillCam workstation.

**Note**
For workstations, use the monitor's native screen resolution as defined in the monitor user manual.
To connect the PillCam Recorder Cradle:

- Connect the cradle only to the USB 2.0 ports that are located side by side in a separate slot on the back panel of the Workstation. If you are not using a PillCam Workstation, use a USB hub for connecting more than one cradle to your computer.

**Note**
If you use more than one cradle, make sure each cradle is connected to a different power outlet.

---

**Starting PillCam Desktop for the First Time**

Before using PillCam Desktop, you must configure and personalize it.

**Note**
PillCam Desktop is installed on an open system and therefore it is highly recommended to install anti-virus software and security updates on the computer running PillCam Desktop.

---

To use PillCam Desktop for the first time:

1. See the bullet below relevant to your type of installation:

   - **For the pre-installed PillCam Workstation**, log in as follows:
     
     - **Single-user mode**: Log in with the username `rapid` and leave the password blank.
     - **Multi-user configuration**: Log in with your username and password (created for you by the administrator).

   **Note**
   **PillCam Workstation only**: The **Computer Locked** screen appears whenever the workstation is idle for more than half an hour. Only two users can unlock it:
   
   - The user who was logged in when the PillCam Workstation went into Autolock, by entering the appropriate password, or
   - The system administrator.

   - **For all other installations**: Double-click on the desktop.

   When you run the software for the first time, a license agreement appears (in English). A translation is provided for other languages.

2. Read the license agreement and click **Yes** to accept it. Since the English license agreement is the legally binding version, you can only accept the license agreement when the English version is selected. The Registration dialog box appears.
Unrestricted use of PillCam Desktop requires registration via the Given Imaging registration center. You must supply the requested information to obtain the Registration Key. The registration screen appears at the end of the installation process:

3. Obtain a Registration Key via the Given Imaging registration center online or by phone:
   - **Online:** [https://portal.givenimaging.com/RapidRegistration](https://portal.givenimaging.com/RapidRegistration)
   - **By phone:** Call your local Given Imaging customer support center.

4. Prepare and provide the following information to the registration center:
   - System ID (from the registration screen)
   - System Key (from the registration screen)
   - PillCam Desktop DVD serial number (supplied with the DVD)
   - Your customer ID

5. Enter the Registration Key received from the Given Imaging registration center using ONLY lower case letters and numbers.

6. Click **OK**. The **Home** screen appears. A description of the **Home** screen appears in the section that follows.

**Note**
If you do not register during installation, after seven uses without registering, you will not be able to use PillCam Desktop without first performing registration.

**Note**
It is recommended to restart your computer at least once a month to ensure optimal performance.
Familiarizing yourself with the PillCam Desktop Home Screen

After starting the PillCam Desktop software, the Home screen appears. The Home screen is the main screen that is used during all phases of the PillCam capsule endoscopy procedure.

The Home screen includes the following options:

- **Patient Check-in**: Opens the patient check-in wizard that guides you through entering information about the patient and the capsule endoscopy procedure and to initialize the PillCam recorder with this data (see *Performing Patient Check-in on page 48*).

- **Recorder Download**: Opens a screen to download data from a PillCam recorder (see *PillCam Recorder Download on page 103*) and to create a PillCam video from the data.

- **View Study**: Displays a menu that provides access to the following:
  - **Study Manager**: Allows you to open, search, sort, delete, and export studies. For details, see *Using the Study Manager on page 115*.
  - **Open Video**: Opens a dialog box that allows you to browse for a saved PillCam Desktop video and findings, if available. For details, see *Viewing Videos on page 147*.
  - **Recent Videos**: Displays recently viewed PillCam Desktop videos that can be selected and opened. For details, see *Viewing Videos on page 147*.

- **Tools**: Displays a menu that provides access to the following:
  - **Regimen Manager**: Allows creating or modifying capsule ingestion regimen instructions for the patient (see *Using the Regimen Manager to Prepare Regimens for Colon Procedures on page 25*).
  - **Settings**: Allows viewing and modifying PillCam Desktop configuration settings (see *Configuring PillCam Desktop for the First Time on page 38*).
  - **Atlas**: Opens an atlas of typical disease images that can be searched by key descriptors and used as a viewing aid for comparing study images with reference images (see *PillCam Software Atlas on page 140*).

Note: Throughout this manual, mention of Home screen, such as “From the Home screen, click the Tools button” refers to the screen described above.
Delete Videos: Deletes a PillCam Software video folder and its contents (see Freeing Space on Your Computer on page 110).

- Help: Displays a menu that provides access to the following:
  - The User Manual option in the submenu opens a searchable PDF version of this user manual.
  - The Help Center option opens the PillCam Help Center webpage. The Help Center provides quick references for How to questions and additional tools including video clips and step-by-step demonstrations to facilitate learning more about PillCam capsule endoscopy procedures and the PillCam software.
  - The About option displays patent and trademark information, and information about this version of the software.

- Exit: Closes the PillCam Desktop software.

**Configuring PillCam Desktop for the First Time**

Before you can start using the PillCam Capsule Endoscopy System, you should configure the following initial settings in PillCam Desktop Software:

- Who can access PillCam Desktop Software.
  See Accessing PillCam Desktop on page 39.

- Physician details that will be displayed in the CE (capsule endoscopy) report.
  See Defining User Information on page 40.

- The interface language and measurement units.
  See Defining Regional Settings on page 40.

- The method that will be used to create videos and the location of the data.
  See Defining Video Creation Settings on page 41.

These settings affect all PillCam procedures performed with PillCam Desktop. For example, the medical personnel names you enter during configuration are available for selection at patient check-in performed on your PC or workstation. If you set units of measurement to centimeters and kilograms, all patient data is shown that way.
Installing and Setting up PillCam Desktop

**Accessing PillCam Desktop**

**Allowing Access to PillCam Desktop**

When installed in a network environment, you can limit access to PillCam Desktop Software to a group of authorized users. The system administrator must first set up a network group with all the authorized users. Once this is done, the administrator must set up PillCam Desktop to enable only the users from this network group to use PillCam Desktop software.

To enable access to other PillCam Desktop users:

1. From the Home screen, select **Tools > Settings > General** tab. The **Settings** screen appears.
2. Select the **System Wide** check box at the bottom of the screen.

   **Note**
   
   The **System Wide** option is only available when you are logged in as an administrator.

3. In the **General** tab, in the **Permissions** section, select the **PillCam Desktop Software users must belong to this network group** check box.
4. Enter the network group. The domain must be entered in this format:
   
   `<domain name>\<group name>;<local group name>;<next group>`

5. After making the changes to the settings, click **Apply** to accept the new settings or click **Cancel** to close the Settings screen without accepting any changes. Clicking **OK** will accept the new settings and close the Settings screen.

**Allowing Access to the Pre-installed PillCam Desktop Workstation**

The PillCam Desktop Workstation is a dedicated computer with PillCam Desktop already installed. The PillCam Desktop workstation supports Windows user management. This allows you to control access to the workstation and to make sure that only authorized personnel use the appropriate files on the workstation.

By default, the PillCam Desktop workstation is configured with the username **rapid** and a blank password. You can continue to use the PillCam Desktop workstation this way, or you can use the multi-user feature. To do so, the administrator (person who sets up and maintains your facility’s PCs) creates additional users, each with a unique username and password, and defines the appropriate access for them.

**Note**

It is recommended to change the default password. Contact your network administrator for information regarding your organization’s password policy.
It is possible to change the password (the administrator usually creates a temporary password) by pressing Ctrl+Alt+Delete and clicking Change Password.

The administrator logs in with the username administrator and password administrator.

Full details for managing PillCam Desktop users are available in the PillCam Desktop IT Guide.

**Defining User Information**

User information includes the physician name, facility name and address (where the procedure was performed), and the facility logo which will appear in the endoscopy report.

To define user information:

1. From the Home screen, select Tools > Settings. The Settings screen appears.
2. In the User Information section, type in the physician name. The physician name appears on the CE report.
3. If more than one physician uses this installation of PillCam Desktop, select Clear physician name when new video opens. When selected, you can manually enter the physician name for each video when needed.
4. In Facility details, type in the facility information (for example, address and telephone number).
5. To add your facility’s logo to reports, click Change Logo and browse to the logo file.

**Note**

The Logo used in the report is copied to a PillCam Desktop directory. The original is not affected.

6. After making the changes to the settings, click Apply to accept the new settings or click Cancel to close the Settings screen without accepting any changes. Clicking OK will accept the new settings and close the Settings screen.

**Defining Regional Settings**

By default, the PillCam Desktop software is set to English and uses metric units of measure. You may change these settings if necessary.

To change the regional settings:

1. From the Home screen, select Tools > Settings. The Settings screen appears.
2. In the General tab, in the Regional Settings section, you can change the following settings, as necessary:
   - **Language**: Allows you to select a different language to view the interface.
   - **Enable spell check**: This option is enabled by default. Spell check will be used to check any new text entered while using the software.
• **Enable GI Dictionary:** This option is enabled by default. The dictionary displays a database of terms and phrases when entering text, for example, when adding thumbnail comments.

• **Measurement units:** By default, PillCam Desktop uses metric units of measure. You can select inches and pounds if necessary.

• **Full name format:** Allows you to define the order that will be used when entering the patient name during Patient Check-in. For example, First Middle Last.

3. After making the changes to the settings, click **Apply** to accept the new settings or click **Cancel** to close the Settings screen without accepting any changes. Clicking **OK** will accept the new settings and close the Settings screen.

### Defining Video Creation Settings

PillCam Desktop allows creating videos using one of the following methods:

• **Create video directly from recorder:** The video is compiled while the data is being downloaded from the PillCam recorder.

• **First copy raw data, then create video:** This is the default option. This option copies the raw data without waiting for full video compilation. This method quickly releases the PillCam recorder for the next procedure. You can copy the video data from the PillCam recorder to the computer, to a USB storage device, or to a DVD without video compilation. When selecting this option, an additional option to delete the oldest study raw data after compilation, becomes available. In this way, PillCam Desktop will automatically free up space each time a new video is compiled.

The video or raw data is copied to a predefined directory. If necessary, you can change these default locations. When creating videos for PillCam SB capsules, the **Allow Manual mode for SB procedures (except for SB3 with DR3)** check box allows viewing SB videos in M-mode. In this mode, videos are created sequentially from all captured images. Since this option increases study size, it is not enabled by default.

**Note**

- When the **Delete oldest study raw data after compilation** option is selected, PillCam Desktop saves raw data for the last five studies. Any additional video created will erase the oldest video’s raw data.
- If you do not use the **Delete oldest study raw data after compilation** option, you must manually clear raw data files because this video creation method can rapidly fill up your computer’s hard drive.

To define video creation settings:

1. From the Home screen, select **Tools > Settings**.
2. Select the **Video** tab.
3. In the **Video Creation** section, under **Creation method**, select either:
   - **Create video directly from recorder** or
• First copy raw data, then create video

4. If necessary, click **Browse** to change the following default directories:
   • **Video directory**: The destination location for created videos.
   • **Raw data directory**: The destination location for copying raw data from the PillCam recorder.

5. If necessary, select the **Allow Manual mode for SB procedures (except for SB3 with DR3). Increases study size** check box.

6. After making the changes to the settings, click **Apply** to accept the new settings or click **Cancel** to close the Settings screen without accepting any changes. Clicking **OK** will accept the new settings and close the Settings screen.

**Customer Support Section**

This section explains how to configure the PillCam Desktop software to allow the collection of performance data for analysis by the Given Imaging support department. PillCam Desktop allows for a one-click extraction and sending of PillCam Desktop log files for convenient customer support access. This enables easier tracking and background information on the PillCam Desktop software being used in the event of a malfunction. In order to enable this feature, you must first enter the email address for your regional Given Imaging Customer Support.

**To enter Customer Support details:**

1. From the Home screen, select **Tools > Settings**. This opens the **Settings** screen.
2. Select the **Other** tab.
3. Under **Customer Support**, click the **Email** list and select your regional customer support center. If it is not listed, you can type in the email address manually.

4. After making the changes to the settings, click **Apply** to accept the new settings or click **Cancel** to close the Settings screen without accepting any changes. Clicking **OK** will accept the new settings and close the Settings screen.
To extract and send PillCam Desktop log files:
In the event that you are requested to send the log files to Given Imaging Customer Support the steps below should be followed:

1. From the Home screen, click **Help > Customer Support > Collect Analysis Files**. The following screen appears.

![Customer Support Screen]

2. Click the **General**, **Video**, **Recorder, Capsule & Sensor** tabs and enter the information in the editable fields. If there is a video that needs to be sent as well, click the **Browse** button in **Video logs** and navigate to the video.

3. Click the **Email** button to send the data to Given Imaging Customer Support.

4. After making the changes to the settings, click **Apply** to accept the new settings or click **Cancel** to close the Settings screen without accepting any changes. Clicking **OK** will accept the new settings and close the Settings screen.
Performing Capsule Endoscopy with DR3

This chapter covers the following tasks, which guide you through performing capsule endoscopy using the PillCam recorder DR3:

- Preparing for the Capsule Endoscopy Procedure on page 45
- Performing Patient Check-in on page 48
- Fitting the Equipment on the Patient on page 54
- PillCam Recorder—Capsule Pairing (DR3 only) on page 62
- Capsule Ingestion on page 64
- Using the PillCam Recorder DR3 on page 67
- Removing the Sensors and the PillCam Recorder on page 81

Preparing for the Capsule Endoscopy Procedure

This section describes preparations required before the PillCam capsule endoscopy procedure.

Before You Start Checklist

In preparation for the procedure, verify that the following equipment and accessories are available:

<table>
<thead>
<tr>
<th>Checklist - Preparing for the CE procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PillCam Software</strong></td>
</tr>
<tr>
<td>Make sure PillCam Desktop has been installed, configured, and opened after accepting the license agreement.</td>
</tr>
<tr>
<td><strong>PillCam capsule (UGI, SB, COLON, Crohn’s)</strong></td>
</tr>
<tr>
<td>Take note of PillCam handling instructions. See Handling PillCam Capsules on page 6.</td>
</tr>
<tr>
<td><strong>PillCam recorder</strong></td>
</tr>
<tr>
<td>Make sure the PillCam recorder is charged.</td>
</tr>
<tr>
<td><strong>PillCam recorder pouch</strong></td>
</tr>
<tr>
<td>Prepare PillCam recorder pouch with the shoulder strap.</td>
</tr>
<tr>
<td><strong>Printed instructions</strong></td>
</tr>
<tr>
<td>Print the patient instructions.</td>
</tr>
<tr>
<td><strong>PillCam sensor belt or PillCam sensor array</strong></td>
</tr>
<tr>
<td>Prepare the sensor belt. For sensor arrays, insert the sensors into the sleeves.</td>
</tr>
<tr>
<td><strong>Sensor Location Guide</strong></td>
</tr>
<tr>
<td>Prepare the sensor location guide.</td>
</tr>
</tbody>
</table>
General Patient Guidelines During the Procedure

In addition to the patient instructions provided prior to the procedure (see Printing Pre-ingestion Instruction Handouts on page 24), additional handouts are available to provide information during the procedure and after the procedure (for procedures involving visualization of the colon).

See Printing the Patient Instructions on page 30

Make sure that the patient has the printed post-capsule ingestion instructions or patient instructions with your contact information included, and is aware of the instructions that follow.

For colon visualization procedures using PillCam recorder DR3

Explain to the patient that the PillCam recorder DR3 will alert them to perform the actions listed in the post-ingestion instructions handout by beeping and vibrating and displaying on its screen the number of the instruction to be performed at the alert time.

When the PillCam recorder beeps and vibrates the patient should do the following:

1. Check the instruction number on the PillCam recorder LCD screen.
2. Press the Acknowledge button on the upper right corner of the PillCam recorder for at least 3 seconds.
3. Follow the corresponding post-capsule ingestion instruction on the supplied printed out.
4. Follow instructions only when prompted by the PillCam recorder and only the instruction that matches the displayed number, even if the PillCam recorder skips a number.
5. Take note that the PillCam recorder DR3 displays the End of Procedure screen, beeps and vibrates when the procedure is over and shuts down automatically after five minutes.
For ALL procedures:

**Patient Guidelines During the Procedure**

- Instruct the patient on the proper use of the PillCam recorder:
  - The patient must treat the PillCam recorder with care. Avoid any sudden movements. Avoid bumping the PillCam recorder.
  - The patient should not remove or disconnect the PillCam recorder at any time during the procedure.
  - The patient should contact the medical staff if the PillCam recorder is blinking red.
  - The patient must follow the dietary instructions from the medical staff or when alerted by the PillCam recorder.

- If the patient experiences any abdominal pain, nausea, or vomiting after ingesting the PillCam capsule, the patient should immediately inform the medical staff.

- If the patient experiences any post-procedure abdominal pain, vomiting, or other unexplained symptoms and PillCam capsule excretion cannot be verified, the patient should contact the physician for evaluation and possible abdominal X-ray procedure.

- After ingesting the PillCam capsule and until it is excreted, the patient should not go near any source of a powerful electromagnetic field, such as one created near an MRI device and should avoid direct exposure to bright sunlight.

- Instruct the patient to contact the medical staff if one of the adhesive sleeves detaches from the patient's body.

- Avoid any physical activity that involves sweating, bending, or stooping.

- Remain active. Do not sleep.

- Use the bathroom as often as needed (do not suppress the urge). The use of wet wipes and cream to protect the skin is recommended.

- Avoid any source of powerful electromagnetic field (such as an MRI device).

- Do not remove the PillCam recorder until the capsule is excreted or the End of Procedure instruction appears on the PillCam recorder.

- If the capsule LED at the top of the recorder is blinking red, move to a different location until the capsule LED on the top of the PillCam recorder has resumed blinking blue.

- The end of the procedure for a PillCam recorder DR3 is when the End of Procedure instruction is alerted and displayed on the recorder screen.

- The end of a procedure may also be declared by the medical staff after proper consultation if the blinking stopped before the above specified times.

- At the end of the procedure, remove the PillCam recorder and sensors. If you need assistance, or were instructed to do so, return to the clinic to have this done.

- Contact the medical staff in case of any unexpected event or doubt.
Post-ingestion Instructions for Procedures Involving Colon Visualization

The post-ingestion instructions should result in the preservation of proper cleanliness of the colon during the procedure, and facilitate the timely progress of the PillCam COLON/PillCam Crohn’s capsule in the colon to enable visualization of the entire colon before capsule burn-out or excretion. To achieve this, the patient receives real-time alerts from the PillCam recorder DR3 which correspond with a set of printed instructions that dictate the timely ingestion of prokinetics and laxatives.

The post-ingestion instructions are grouped in a regimen that is selected from a library of possible regimens and are loaded into the PillCam recorder DR3 during patient check-in (see Performing Patient Check-in on page 48). The difference between the regimens is in the use of specific laxative and prokinetic materials as well as some timing differences associated with these different materials. The regimens are created, edited, and printed using the Regimen Manager. For details on viewing, editing, and printing post-ingestion instructions, Using the Regimen Manager to Prepare Regimens for Colon Procedures on page 25.

The post-ingestion instructions (regimen) include conditional instructions similar to the following:

- Continue fasting until capsule leaves the stomach.
- If capsule is delayed in the stomach, ingest a customized prokinetic agent.
- Intake the first boost laxative dose (and water when necessary) directly after capsule leaves the stomach.
- Intake the second boost laxative dose (and water when necessary) 2 - 4 hours after the capsule leaves the stomach.
- Eat a light meal (depending on capsule progress) 1 - 3 hours after the second laxative.
  - Take a suppository 1 - 2 hours after the meal (if required).

In some cases it may be necessary to delay execution of the instructions. For example, if ingestion is at the physician’s office but the rest of the procedure will take place at the patient’s home, intake of the associated laxatives can be delayed until the patient reaches a suitable environment. This is made possible by programming the PillCam recorder DR3, either through check-in or through direct programming before capsule pairing (see Setting Delay First Instruction in PillCam Recorder on page 79).

Performing Patient Check-in

Connecting the PillCam Recorder for Patient Check-in

The PillCam recorder connects to the PillCam Desktop workstation or Personal Computer (PC) via the cradle. When connected, it is possible to:

- Perform patient check-in
- Download videos
- Upgrade the recorder
Performing Capsule Endoscopy with DR3

Once connected, the Procedures page appears, as follows.

The following function buttons are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identify Recorder</td>
<td>Identifies the PillCam recorder for the selected recorder bar. When you click this button, all the LEDs on the associated PillCam recorder and cradle blink.</td>
</tr>
<tr>
<td>Check-in Patient</td>
<td>Prepares the PillCam recorder for the capsule endoscopy procedure by entering patient data.</td>
</tr>
<tr>
<td>Copy Raw Data</td>
<td>Copies the raw video data to the computer. This button only appears after unchecking the check box Disable video data management in the Video tab of the Settings screen (see Managing PillCam Software Video Data on page 104). (Not available for PillCam Reader.)</td>
</tr>
<tr>
<td>Create Video</td>
<td>Starts or stops video creation from the raw data on the PillCam recorder.</td>
</tr>
<tr>
<td>Recorder Information</td>
<td>Displays all technical details of the PillCam recorder.</td>
</tr>
</tbody>
</table>

Note

The PillCam recorder DR3 battery is limited to 400 recharge cycles. PillCam Desktop will display a notification at approximately 385 cycles prompting you to replace the battery. Contact customer service for a replacement battery when the battery notification appears, or when the battery reaches 3 years of service; whichever occurs first.
Enter Patient Check-in Information

The check-in process allows entering patient and procedure data for the procedure and saves the correct patient and procedure information to the PillCam recorder. Patient check-in can be done manually or by importing patient data from the HIS (Hospital Information System). Instructions for both methods appear in the sections that follow.

**Note**
Do not remove the PillCam recorder from its cradle before the end of the check-in process.

**Caution**
When placed in the cradle, PillCam Desktop will perform a mandatory update to your PillCam recorder DR3. It is important to follow the instructions displayed on the screen. Do not stop the update process until it is finished.

To perform patient check-in manually:

1. Make sure the PillCam recorder is fully charged and connected to the PillCam Desktop computer.
2. Make sure the PillCam recorder is firmly inserted into the cradle.
3. In the **Home** screen, click **Patient Check-in**.
4. In the **Procedures** screen, select the **Recorder** tab and select the PillCam recorder to use for check-in (if more than one recorder is connected).
5. Click the **Check-in Patient** button. The **Patient Check-in** wizard opens and displays the **Welcome...** window.
6. Click **Next** to continue. The first **Patient Check-in** window appears.
7. Enter the following information:
   - The patient’s **Last**, **First**, and **Middle** names. Use alphanumeric, underscore, hyphen, and space characters. Use the TAB key to move to the next field.
   - Enter the patient’s **ID** number.
   - Select the **Gender**.
   - In **Birth Date**, set the patient’s date of birth.
   - In **Procedure Date**, enter the date on which the procedure is to be performed. By default, it is set to the current date.
Performing Capsule Endoscopy with DR3

• In **Capsule ID**, if filling this field during check-in, enter the capsule ID code that is printed on the bottom of the capsule box (by typing it in or by using a barcode reader). The capsule type field is automatically populated according to the capsule type encoded in the capsule ID entered.

• In **Capsule Type**, if you did not enter the Capsule ID in the previous field, select the correct type of procedure (SB2, SB3, UGI, COLON 2, Crohn’s).

8. Click **Next** to continue. The next window that appears depends on the capsule type selected. For SB and UGI capsule types, continue with Step 9. For COLON and Crohn’s capsule types, continue with this step.

• Select a regimen and print it to give to the patient before capsule ingestion.

• If you want to enforce a minimum 60 minute delay between the time of ingestion and the first patient instruction (DR3 alert), use the Delay first instruction checkbox.

By default, the **Delay first instruction** option is not enabled. If necessary it can also be set directly via the PillCam recorder DR3 before pairing with the PillCam COLON 2/PillCam Crohn’s capsule. See **Setting Delay First Instruction in PillCam Recorder** on page 79. For more information on this option.

Click **Next** to continue.

9. In the next window, complete physician and insurance details:

• Enter **Referring Physician** and **Ordering Physician**.

• In **Check-in by**, enter your name.

• Enter the **Insurance** company details, **Group Number**, and **ICD Code**, as required.

Click **Next** to continue.

10. Type in the **Reason for Referral**, if it is known. You can use predefined words and phrases from the GI Dictionary, if necessary.

Click **Next** to continue.
11. Complete the patient’s physical description. Define the **Height**, **Weight** and **Waist** measurements, and the **Physique**.

Click **Next** to continue.

12. Complete the protocol and components details:

- Fill in a **Protocol number** or Name if you are performing a clinical trial.
- For **Capsule lot number**, enter the LOT # from the back of the capsule box.
- For **Sensor serial number**, enter the SN from the sensor array cable.
- For **Battery pack serial number**, enter the DR2 recorder battery pack serial number.

Click **Next** to continue. A screen appears summarizing the data entered in the wizard.

13. Verify that the patient and procedure data is correct:

- If the data is incorrect, click **Back** and return to a previous screen to correct the mistake.
- If the data is correct, select **Accept**, and then click **Finish** to continue. When the **Patient Check-in complete** screen appears, click **Ready** to proceed.

To perform patient check-in using HIS data:

1. Make sure the PillCam recorder is fully charged and connected to the PillCam Desktop computer.

2. Make sure the PillCam recorder is firmly inserted into the cradle.

3. In the **Procedures** screen, select the **Recorder** tab and select the PillCam recorder to use for check-in (if more than one recorder is connected).

4. Click the **Check-in Patient** button. The **Patient Check-in** wizard opens and displays the **Welcome...** window.

5. Click **Next** to continue.

The first **Patient Check-in** window appears.

6. Click **Import**. The **Import Patient Data** screen appears.

For information, see Defining the HIS Information Directory on page 54.

The available data for patients not yet checked in appears on the screen sorted by planned **Procedure Date**. You can sort the studies by any of the column headings in either ascending or descending order.
7. To select a patient, select the relevant line and click **OK**. This automatically adds check-in data into the appropriate fields in PillCam Desktop.

Once imported, the patient data is removed from the **Available for Check-in** list and appears in the **Already imported** list. From the **Display** drop-down list, you can select which patient list you wish to see: **Available for Check-in** or **Already imported**.

8. If necessary, you can delete a patient from the **Already imported** list. To do this, select the relevant line and click **Delete**.

9. After selecting the patients for check-in, click **OK**. The first check-in screen appears again, with all available information already entered. You may need to complete additional mandatory or optional procedure information (such as the capsule ID) which was not auto-populated by the HIS (see the *PillCam Desktop IT Guide* for detailed information on working with the HIS).

When all necessary data entry is completed, you may proceed to the **Procedure info confirmation** screen by clicking the **Next** or **Finish** buttons or by changing any of the information fields.

**Note**

When the patient check-in is complete, the capsule LED on the PillCam recorder lights up in orange.

After patient check-in, keep the PillCam recorder in its cradle until the capsule ingestion procedure begins.

### Configuring the Patient Check-in Fields

PillCam Desktop allows you to add frequently used options that can be selected when performing patient check-in, such as the physician name and ICD Code.

**To add frequently used Check-in fields:**

1. From the Home screen select **Tools > Settings > Check-in** tab.

2. Under Configure Check-in fields, select a Check-in field and enter the corresponding values for this field in the text box beneath it.

3. Click **Add**. In the window below the text box you can see all the values already entered for this check-in field.
4. Use the **Move Up** and **Move Down** buttons to organize the defined values.

5. After making the changes to the settings, click **Apply** to accept the new settings or click **Cancel** to close the **Settings** screen without accepting any changes. Clicking **OK** will accept the new settings and close the **Settings** screen.

**Defining the HIS Information Directory**

If a HIS system is available, type the location from which to import patient data for Check-in or click **Browse** to navigate to the necessary folder.

**Updating Patient Details**

Patient details are collected during the Patient Check-in process. If necessary, you can change or update all the patient information after video creation.

**To update patient details:**

1. Find the study in the Study Manager.

2. Right-click the study and select **Update Patient Details**. The Update Patient Details screen appears. Edit the details as necessary and click **Next** to view the next screen.

3. In the last screen, click **Save** to save the changes.

**Fitting the Equipment on the Patient**

This section guides you through preparing and fitting the recording equipment required for the capsule endoscopy procedure on the patient.

Fitting the equipment on the patient includes the following steps:

1. **Applying the PillCam Sensor Array** or **Applying the PillCam Sensor Belt**

2. **Attaching the PillCam Recorder to the Sensor Array**
Applying the PillCam Sensor Belt

The sensor belt is used for PillCam SB or PillCam COLON/Crohn’s procedures and consists of a flat, flexible belt-like sensor arrangement worn around the patient’s waist over a single, thin layer of natural fabric, such as a T-shirt. Depending on the type of sensor belt, for sanitary purposes some models may require the fitting of a single-use disposable protective sleeve while other models feature a reusable washable external fabric sleeve.

Note
Refer to the product insert supplied with your sensor belt for full instructions on fitting, usage, cleaning, and a technical description.

Applying the PillCam Sensor Array

The sensor array allows the PillCam recorder to collect localization data during a procedure. The prescribing physician may request this. The checklist that follows lists the equipment you need in order to attach the sensor array to the patient.

Checklist - Applying the sensor array

<table>
<thead>
<tr>
<th>Equipment</th>
</tr>
</thead>
<tbody>
<tr>
<td>PillCam Sensor Array</td>
</tr>
<tr>
<td>Sensor Location Guide (UGI, SB, COLON, Crohn’s)</td>
</tr>
<tr>
<td>Adhesive sleeves, to hold each one of the sensors securely in place</td>
</tr>
<tr>
<td>Razor and disinfectant (not supplied)</td>
</tr>
</tbody>
</table>

Note
Sensor arrays must be applied directly to smooth skin. Anything that comes between the patient’s skin and the sensors, including hair or air, and any changes in the sensors’ arrangement, may interfere with the quality of the data.

Warning
Do not use the sensor array if it is torn or damaged.
To prepare the sensor array:

1. Insert each sensor into an adhesive sleeve. The sensor markings (dots or this side up) should face away from the adhesive side of the sleeve.

2. To secure the sensor in the sleeve, remove the liner from the top-side of the lower lip at the opening of the adhesive sleeve and then press both lips together.

3. Place the sensors on the patient according to the appropriate placement guides (see UGI Sensor Locations on page 57, SB Sensor Locations on page 58, or COLON 2/Crohn’s Sensor Locations on page 59).

To attach the sensor array:

1. With the patient standing and exposing the thorax and abdominal area, place the sensor array loop on the left shoulder. If the loop is too long, gather and fasten the surplus in the fastener.

2. Use the appropriate Sensor Location Guide to identify the location of each sensor on the patient’s body and mark it with a dot.

3. The sensor array sleeves should be applied to hairless skin. If needed, wipe the patient’s skin with disinfectant and shave the areas where sensors are to be applied.

4. With the sensor array connector at the patient’s side, lay the prepared sensor array on the patient’s abdomen and match the letters and colors on each sensor wire to the letters and colors on the Sensor Location Guide.

5. To attach each sensor, remove the protective backing from its adhesive sleeve.

   **Note**
   Since the sensors are placed on the body according to anatomical reference points, the distances between sensors may vary from patient to patient.

6. If you are using a sensor array with a downlink loop, adjust the downlink loop to remove excess cable so that it fits closely to the patient’s body. To prevent damage to the wires do not forcibly bend the downlink loop in any way.
7. When the patient gets dressed, make sure that the sensor array connector remains outside of the patient’s clothing and that the patient is not uncomfortable with the equipment.

Note
Adjust the downlink loop to remove excess cable so that it fits closely to the patient’s body. To prevent damage to the wires do not forcibly bend the downlink loop in any way.

Caution
- Make sure that there is no other PillCam capsule or other diagnostic capsule in the patient’s gastrointestinal tract.
- Verify that the capsule expiration date has not passed (see the date next to the icon on the packaging).
- If you are performing the procedure for the first time, read the capsule package insert.

UGI Sensor Locations

<table>
<thead>
<tr>
<th>Sensor Label</th>
<th>Sensor Color</th>
<th>Sensor Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Black</td>
<td>Upper Sternum (on the bone)</td>
</tr>
<tr>
<td>B</td>
<td>Yellow</td>
<td>Xiphoid process</td>
</tr>
<tr>
<td>C</td>
<td>Brown</td>
<td>Intersection of left 7th intercostal space and left mid-clavicular line</td>
</tr>
</tbody>
</table>
SB Sensor Locations

<table>
<thead>
<tr>
<th>Sensor Label</th>
<th>Sensor Color</th>
<th>Sensor Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Black</td>
<td>Intersection of right 7th intercostal space and right mid-clavicular line</td>
</tr>
<tr>
<td>B</td>
<td>Yellow</td>
<td>Xiphoid process</td>
</tr>
<tr>
<td>C</td>
<td>Brown</td>
<td>Intersection of left 7th intercostal space and left mid-clavicular line</td>
</tr>
<tr>
<td>D</td>
<td>Blue</td>
<td>Right lumbar region at umbilical level</td>
</tr>
<tr>
<td>E</td>
<td>Purple</td>
<td>Above umbilicus (navel)</td>
</tr>
<tr>
<td>F</td>
<td>White</td>
<td>Left lumbar region at umbilical level</td>
</tr>
<tr>
<td>G</td>
<td>Green</td>
<td>Right mid-inguinal region</td>
</tr>
<tr>
<td>H</td>
<td>Red</td>
<td>Left mid-inguinal region</td>
</tr>
</tbody>
</table>

Note
The small sensor array is differentiated from the regular sensor array by a yellow section on the downlink loop.
**COLON 2/Crohn’s Sensor Locations**

<table>
<thead>
<tr>
<th>Sensor Label</th>
<th>Sensor Color</th>
<th>Sensor Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Black</td>
<td>Intersection of right 7th intercostal space and right mid-clavicular line</td>
</tr>
<tr>
<td>B</td>
<td>Yellow</td>
<td>Mid upper region of right gluteus</td>
</tr>
<tr>
<td>C</td>
<td>Brown</td>
<td>Intersection of left 7th intercostal space and left mid-clavicular line</td>
</tr>
<tr>
<td>D</td>
<td>Blue</td>
<td>Right lumbar region at umbilical level</td>
</tr>
<tr>
<td>E</td>
<td>Purple</td>
<td>Suprapubic region</td>
</tr>
<tr>
<td>F</td>
<td>White</td>
<td>Left lumbar region at umbilical level</td>
</tr>
<tr>
<td>G</td>
<td>Green</td>
<td>Right mid-inguinal region</td>
</tr>
<tr>
<td>H</td>
<td>Red</td>
<td>Left mid-inguinal region</td>
</tr>
</tbody>
</table>
Attaching the PillCam Recorder to the Sensor Array

The PillCam recorder is worn by patients during the procedure in the recorder pouch with the shoulder strap. Make sure that these accessories fit the patient comfortably.

Recorder Pouch

To fit the recorder pouch:

1. With the patient standing, hang the recorder pouch from the patient’s shoulder as displayed in the illustration.
2. Adjust the shoulder strap so that the recorder hangs at the patient’s side at waist level with the supplied strap securing the recorder to the waist.

PillCam Recorder

To assemble PillCam recorder accessories:

1. Remove the PillCam recorder from the cradle. If the PillCam recorder is properly initialized and ready for the procedure, the capsule LED is constantly on in white.
2. Verify that the battery is fully charged.

   The battery icon on the screen should be .
3. Insert the PillCam recorder into its pouch. Instruct the patient to keep wearing the PillCam recorder during the examination.

   The pouch or belt is ready and the patient can wear it.

**Warning**

When a PillCam recorder is connected to a sensor array worn by a patient:

- Do not connect the PillCam recorder to a computer that is connected to an electrical outlet.
- Do not put the PillCam recorder into a cradle or connect it to a charger.
- Attach the sensor connector to the PillCam recorder immediately prior to capsule ingestion.
- PillCam recorder DR3 only: make sure that the connector component is placed between the patient’s body and the PillCam recorder DR3 waist strap.
Positioning the PillCam Recorder DR3

1. Make sure the PillCam recorder is ON (navigation button LEDs blink once every 5 seconds).

2. With the patient standing, hang the pouch from the patient’s left shoulder to the right hip.

3. Insert the sensor connector (A in the illustration) into the PillCam recorder’s slot (B in the illustration) until you feel and hear a click.

If the sensor is not properly connected to the recorder, ![symbol] appears on the PillCam recorder screen (see PillCam Recorder DR3 on page 194 for troubleshooting details).

4. If using a PillCam sensor array, tuck the vibrating connector component between the recorder pouch and the patient’s abdomen. This will ensure that the tactile vibrating alerts will be felt by the patient.

Note

- Remind the patient about wearing and handling the PillCam recorder with care (see General Patient Guidelines During the Procedure on page 46).
- Make sure the patient has the printed instructions (see Printing the Patient Instructions on page 30).
- When securing the sensor belt, make sure the fabric of the patient’s shirt is not folded beneath the front portion of the sensor belt.
- Make sure nothing other than a single, thin layer of fabric is allowed to come between the sensor belt and the abdomen.
- In order to avoid pulling the sensor belt out of position, do not attach or anchor anything to the sensor belt.
- Be sure that the PillCam recorder is worn over the sensor belt and that the PillCam recorder pouch is not attached to the PillCam sensor belt.
- Another layer of clothing may be worn over the sensor belt as long as the sensor belt connecting wire can be attached to the PillCam recorder.
PillCam Recorder—Capsule Pairing (DR3 only)

PillCam recorder DR3 operates only with capsules that were paired to it. This allows the PillCam recorder to recognize images from the correct capsule. Pairing is initiated when the PillCam recorder recognizes transmission from a designated capsule. From that point on, the recorder is associated with the capsule. The recorder and capsule are then paired.

**Warning**
The PillCam recorder starts recording **only after it is paired with the capsule**. If pairing is not complete, no video can be produced.

Make sure you see the **Pairing Success** icon on the screen and the capsule LED on top of the recorder blinking in **BLUE** before capsule ingestion.

Designation of the capsule to be used in the procedure may be performed during patient check-in or immediately before capsule ingestion. The sections that follow describe these two scenarios.

**Capsule Designation During Patient Check-in**
While entering the patient and procedure data during check-in, type the capsule ID in the Capsule ID field or use a barcode scanner. The capsule ID is displayed on the capsule package.

During recorder initiation, the unique capsule ID will be transferred into the PillCam recorder together with the rest of the initiation data. It will appear on the PillCam recorder LCD together with the rest of the patient data.

As long as no transmission from the checked in capsule is received, pairing is not done. The **Ready for pairing** icon remains in the top right corner of the screen.

If there are PillCam capsule transmissions received by the PillCam recorder, which are not from the designated capsule, the capsule IDs of these other capsules (only of the checked-in capsule type) are temporarily displayed on the PillCam recorder screen. **Ready for pairing** icon remains in the top right corner of the screen.

When you open the designated capsule box, just before ingestion, the capsule starts blinking and transmitting, each capsule type in its unique way. The PillCam recorder will automatically pair to the designated capsule and start recording when it receives transmissions from it. If the capsule box is closed again and the capsule is not paired, the LED on the recorder blinks white every 5 seconds.
The **Pairing success** icon ![icon](image) will appear in the top right corner of the screen.

---

**Note**

Capsule designation during patient check-in is the recommended method for designating a capsule to be used in the procedure.

---

**Capsule Designation Before Capsule Ingestion**

There are two situations when you need to perform capsule designation manually immediately prior to ingestion:

- if designation was not performed during check-in, or
- if designation was performed, but the designated capsule is not available for the procedure.

As long as there are PillCam capsule transmissions received by the PillCam recorder but are not from a designated capsule, the capsule IDs of these other capsules (only of the checked-in capsule type) are temporarily displayed on the PillCam recorder screen.

The **Ready for pairing** icon ![icon](image) remains in the top right corner of the screen.

**To designate and pair a capsule to be used in the procedure before capsule ingestion:**

1. Open the capsule box lid—the capsule starts blinking, each capsule in its unique blinking pattern (see [System Specifications on page 204](#)).
   - Right after opening the lid, the blinking rate for PillCam SB 2/PillCam SB 3, PillCam COLON 2, and PillCam Crohn’s capsules should still be 2 fps per head.
   - For PillCam SB 2 (fixed 4 fps variant) the blinking rate should be 4 fps.
   - For PillCam UGI the blinking rate is 35 fps per head. Hold the capsule close to the sensors worn by the patient during this pairing process.

2. When the **Ready for pairing** icon ![icon](image) is displayed in the top right corner of the screen and when the PillCam recorder detects your PillCam capsule, its ID code is displayed on the screen (alone or in addition to IDs from other capsules).

   ![Image](image)

   This mark indicates that this capsule ID will be selected when pressing the middle navigation button.

3. If only one capsule ID appears on the PillCam recorder screen, check the capsule ID shown in the PillCam recorder screen against the capsule ID displayed on the PillCam capsule package. If the codes match, press the middle navigation button, above which ![icon](image) appears on the screen.
4. If more than one capsule ID appears on the PillCam recorder screen, use the navigation buttons (located below \[ \uparrow \] or \[ \downarrow \] icons on the screen) to scroll to your capsule ID and press the middle navigation button (located below \[ \leftarrow \] icon on the screen) to designate and initiate pairing of your capsule with the PillCam recorder.

The Pairing success icon \[ \checkmark \] will appear in the top right corner of the screen.

Note
- If a PillCam COLON 2/PillCam Crohn's capsule blinks slower than 1 blink per second during the pairing procedure, return it to its box so that it stops blinking and start over.
- If, at any time before ingestion, the capsule does not blink for at least 20 seconds, do not use this capsule. Instead, use a different capsule and repeat the pairing procedure.

If after designating the capsule:
- the patient does not ingest it within ten minutes, or
- you suspect that the capsule is defective.
Return the capsule into its box. When you close the lid, if the capsule stops blinking, it is deactivated.
If the capsule continues blinking, rotate it around its axis, without removing it from its place holder in the box until it stops blinking when you close the lid.
To use this capsule later (if it is not defective), you must repeat the pairing process.

Capsule Ingestion

Capsule ingestion is the process of having the patient swallow the PillCam capsule.

Before you start

<table>
<thead>
<tr>
<th>Checklist - Capsule Ingestion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prepare the PillCam capsule (UGI, SB, COLON, or Crohn’s)</td>
</tr>
<tr>
<td>Prepare a glass of water</td>
</tr>
<tr>
<td>Ensure that the PillCam recorder is on</td>
</tr>
</tbody>
</table>

For procedures involving the visualization of the colon:
After ingesting the PillCam COLON/PillCam Crohn’s capsule, instruct the patient not to sit on bare metal surfaces, such as chairs with a metal sitting area, during the procedure.
Before allowing the patient to swallow the capsule, take note of the following issues regarding Multiple Procedures:

**Multiple Procedures**
When performing more than one PillCam capsule endoscopy procedure in the same vicinity, follow these guidelines to prevent signal interference with other procedures:

- After patient check-in, keep the PillCam recorder in the cradle without sensors attached until capsule ingestion procedure begins. Return it to the cradle when the procedure is complete.
- Perform only one capsule ingestion at a time with no other active PillCam recorder or capsules present in the room.
- Attach sensors to the PillCam recorder immediately prior to the ingestion after sensors are properly positioned on the patient.
- Do not permit patients wearing PillCam recorders to stay directly next to other patients with ingested capsules.
- To minimize the potential for radio frequency interference from the capsule after it is removed from the box, verify that the capsule LEDs are blinking and have the patient ingest it immediately.
- Once the PillCam Desktop video is created, check to be sure the video is complete.

To perform capsule ingestion:

1. **Make sure that the capsule and the capsule LED** on the PillCam recorder are blinking in time with each other.

2. **Check the color of the capsule LED on the PillCam recorder:**
   - **If** (blue), go to step 3.
   - **If** (white), pair the capsule with the PillCam recorder and verify the pairing success icon appears in the top right corner of the PillCam recorder screen and the capsule LED blinks blue.

**Note**
During capsule endoscopy, the capsule LED blinks blue at the recording rate. If the capsule LED blinks orange once every 5 seconds, the PillCam recorder is not receiving capsule signals (see PillCam Recorder DR3 on page 194 for troubleshooting details).

3. **Have the patient swallow the capsule with a sip of water. The ingestion procedure may take several minutes.**
After Capsule Ingestion

PillCam Recorder DR3
- The procedure ends when the **End of Procedure** screen appears on the PillCam recorder. The PillCam recorder also beeps and vibrates when the End of Procedure alert appears.
- In SB capsule procedures, the End of Procedure icon appears when 25 minutes have passed without paired capsule reception in the PillCam recorder DR3.
- At the end of the procedure, remove the PillCam recorder and sensors from the patient. The patient may then be released and can return to a normal daily routine.

PillCam UGI
- The patient must stay at the medical facility until the end of the procedure (approximately 90 minutes after ingestion of the capsule).
- The procedure ends when the End of Procedure screen appears on the PillCam recorder. The PillCam recorder also beeps and vibrates when the End of Procedure alert appears. In UGI capsule procedures, the End of Procedure icon appears when 10 minutes have passed without paired capsule reception in the PillCam recorder DR3.
- At the end of the procedure, remove the PillCam recorder and sensors from the patient. The patient may then be released and can return to a normal daily routine.

PillCam SB
- Once the patient has ingested a PillCam SB capsule, the patient may leave the clinic.
- Make sure that the patient knows which activities to avoid during the procedure and how to return the PillCam recorder and sensors.

PillCam COLON/PillCam Crohn’s
- After ingestion, explain the Patient Guidelines (see *General Patient Guidelines During the Procedure on page 46*) to the patient.
- Explain to the patient what to do when the PillCam recorder beeps or vibrates (see *Post-ingestion Instructions for Procedures Involving Colon Visualization on page 48*).
- The procedure ends when the **End of Procedure** screen appears on the PillCam recorder. The PillCam recorder also beeps and vibrates when the End of Procedure alert appears.
- In COLON/Crohn’s capsule procedures, the appearance of the End of Procedure icon depends on how much time has passed without paired capsule reception in the PillCam recorder DR3:
  - During the first 5 hours of the procedure, 25 minutes of no paired capsule reception.
  - Between 5 hours and 10 hours of the procedure, decreasing incrementally from 25 minutes to 10 minutes of no paired capsule reception.
  - After 10 hours into the procedure, 10 minutes of no paired capsule reception.
- At the end of the procedure, the PillCam recorder and sensors may be removed from the patient. The patient may then return to a normal daily routine.
Using the PillCam Recorder DR3

Preparing the PillCam Recorder
The PillCam recorder is used to receive and store the captured images from the PillCam capsule during the capsule endoscopy procedure for subsequent download to PillCam Desktop. The video created from the downloaded data can then be reviewed by the physician.

The DR3 model is the newest model and works with all types of PillCam capsules and provides advanced functions of real-time viewing during the procedure.

The recorder is provided with a cradle (for charging and connecting to a PC) and a pouch (to allow the patient to wear the PillCam recorder during the procedure).

Functions

Initialization
Initialization is a mandatory operation before the procedure. With the PillCam recorder connected to PillCam Desktop, the patient and procedure data are uploaded to the PillCam recorder so that the ensuing study and procedure data are personalized. The initialization of the PillCam recorder is performed through the PillCam Desktop check-in process (see Performing Patient Check-in on page 48), while the PillCam recorder is connected to PillCam Desktop through its cradle. The PillCam recorder is a passive element in this process and no control or operation on it is required.

Pairing for DR3
Pairing is performed before PillCam capsule ingestion, the capsule and PillCam recorder are made to connect so the PillCam recorder is tuned to the transmissions only from the paired capsule.

Pairing for PillCam recorder DR3 may be performed either through the check-in process in PillCam Desktop by entering the capsule ID during check-in, or directly using the recorder control buttons before ingestion (see PillCam Recorder—Capsule Pairing (DR3 only) on page 62). Pairing is mandatory when working with a PillCam recorder DR3 in order to enable recording.

Real-Time Viewing
Real-time viewing is an optional function whereby the images captured by the capsule and received by the PillCam recorder are displayed to the user in real-time for review by the physician. The PillCam recorder DR2 provides this functionality only in conjunction with a dedicated tablet PC connected to it during the procedure. The PillCam recorder DR3 provides this functionality both

Note
For full technical specifications about the PillCam recorders and their cradles, see System Specifications on page 204.
through a dedicated tablet PC but also autonomously by its built-in display. Appropriate controls on the recorder activate and control the operation of this function.

**Regimen Reminder**

Regimen Reminder is a reminder function whereby the PillCam recorder alerts the user to perform dietary instructions during a PillCam COLON 2/PillCam Crohn’s procedure. For more details see *Post-ingestion Instructions for Procedures Involving Colon Visualization on page 48.*

**Download**

Download is the transfer of the stored raw procedure data from the PillCam recorder to PillCam Desktop and the creation of a PillCam Software video for subsequent review.

Before you perform your first PillCam procedure, make sure that you are familiar with the controls and functions of the PillCam recorder.

**PillCam Recorder DR3**

**General**

The PillCam recorder DR3 battery is limited to 400 recharge cycles. PillCam Desktop will display a notification at approximately 385 cycles prompting you to replace the battery. Contact customer service for a replacement battery when the battery notification appears, or when the battery reaches 3 years of service; whichever occurs first.

---

**Note**

Take note of the following issues regarding the **SD card:**

- The SD card in the PillCam recorder DR3 may not be used externally to perform a patient check-in.
- Use of SD cards not supplied by Given Imaging with the PillCam recorder DR3 may cause the device to malfunction or lead to data corruption or loss.
- The number of procedures that were performed using the SD card appears on the PillCam recorder DR3 screen at check-in. When the number of procedures nears 400 usages, notify customer service.

---

**Caution**

The SD card should never be removed or reinserted when the PillCam recorder DR3 is ON.
Performing Capsule Endoscopy with DR3

Turning the PillCam Recorder DR3 On and Off

The illustration below shows the PillCam recorder DR3 docked in the cradle:

The PillCam recorder DR3 is automatically ON when it is in its cradle.

When removed from the cradle, it may be turned off and on again using the On/Off button.

The On/Off button is on the left side of the PillCam recorder DR3:

- To turn on, press and hold the On/Off button for 5 seconds until you see the startup screen. All LEDs start to flash. (The full start-up sequence takes about one minute.)
- To turn off, press and hold the On/Off button for 5 seconds until the PillCam recorder DR3 beeps and the screen turns off and the button LEDs turn black.

**Note**

Automatic Shutdown:

- After the PillCam recorder DR3 has been checked in, it goes into standby mode ready to receive capsule signals when removed from its cradle. If after 90 minutes no capsule pairing is performed, the PillCam recorder DR3 automatically shuts down.
- After starting to receive signals from a paired capsule, if there is a gap of 30 minutes with no signal reception from the paired capsule, the PillCam recorder DR3 will shut down.

**Note**

When the PillCam recorder DR3 is on, its screen backlight goes into an off mode if the screen or recorder controls are idle for more than 3 minutes. If the PillCam recorder DR3 is on, but the screen is off, press any key to turn the screen on. Once the PillCam recorder DR3 screen is activated, proceed with pressing the desired function button.
Regimen Reminder
Regimen Reminder is a reminder function, whereby the PillCam recorder alerts the patient to perform dietary instructions during a PillCam COLON 2/PillCam Crohn’s procedure. The alerts are timely instruction numbers that appear on the recorder screen together with some audio and tactile alerts to draw the patient’s attention to the alerted instruction number. The patient is required to acknowledge the alert by pressing an acknowledge button on the recorder and execute the associated instruction detailed on a patient instruction sheet. The PillCam recorder DR3 is programmed during the initialization to remind the user according to an uploaded regimen instruction set which is also printed out and handed to the patient. The timing of the regimen instructions is synchronized to the moment of PillCam recorder DR3 pairing with the PillCam capsule.

The last instruction alerted is displayed on the screen of the PillCam recorder DR3.

Charging
Charge the PillCam recorder DR3 by placing it in the cradle. The cradle charges the PillCam recorder DR3 and also connects it to the PC for performing patient check-in and creating videos. There are two LEDs at the base of the cradle:

- The top LED is orange when the PillCam recorder DR3 is in the cradle.
- The bottom LED is orange while charging and green when the PillCam recorder is fully charged.

There is a power connector on the back panel of the cradle:

The PillCam recorder is ready for operation when:
- the battery is at least 80% charged (eight or more bars displayed on battery icon),
- it has been removed from the cradle,
• it is connected to the sensor belt or sensor array.

**Warning**

Never connect the PillCam recorder to the sensor array or the sensor belt while the PillCam recorder is in the cradle.
Do not use the DR3 cradle for any USB devices except the PillCam recorder DR3.

**Controls**

**Main Display**

The main display of the PillCam recorder DR3 displays the relevant information during the different phases of the capsule endoscopy procedure.

After Initialization (after check-in) and before pairing with the capsule, the recorder display shows the relevant procedure information data, as follows:

- **Status line**
- **Patient name**
- **Patient ID**
- **Capsule type**
- **Last Regimen instruction**
- **Battery charge level**
- **Capsule signal level**
- **Recorder status:** unpaired
- **Audio alert control**
- **Icon to toggle delay first instruction**

After pairing with the capsule, the display shows the relevant procedure information data, as follows:

- **Status line**
- **Patient name**
- **Patient ID**
- **Capsule type**
- **Last Regimen instruction**
- **Battery charge level**
- **Capsule signal level**
- **Recorder status:** paired
- **Audio alert control**
- **Real-Time viewing**

To activate real-time viewing (only after pairing), use the navigation buttons located under the icons at the bottom of the display: press the button below the camera icon, then the left button, and then the right button.
When a regimen instruction alert is activated, the instruction number appears all over the main screen and remains until the Acknowledge button is pressed (or 5 minutes pass). The graphic indication in the top right corner of the displayed alert indicates that an acknowledge response is required by pressing the acknowledge button.

Error messages appear similarly over the main screen (see Error Messages on page 77).

LED Display

The top of the PillCam recorder has a small screen on which the capsule and message LEDs are displayed. These LEDs indicate the status of the PillCam recorder and the capsule endoscopy procedure. For example, when the capsule LED on the PillCam recorder blinks in blue, this means that PillCam recorder is receiving data from a capsule.

Acknowledge Button, Designated for Patient Use

During a capsule endoscopy procedure, patients press the Acknowledge button in response to PillCam recorder message alerts that appear on the recorder display. This ensures that the patient acknowledges the instruction message. This can include regimen instruction messages during post-ingestion regimen (see Post-ingestion Instructions for Procedures Involving Colon Visualization on page 48).

- The acknowledge button will simultaneously blink with the display of any regimen reminder popup in PillCam recorder DR3 LCD display and it will keep blinking until patient pressed the acknowledge button for 3 sec or the popup display has reached its time out duration.
- At the end of 3 sec continuous pressing on the acknowledge button the blinking will go off.
Navigation Buttons

The navigation buttons are used to interact with the recorder by moving a cursor on a menu of icons on the recorder LCD screen and to make a selection during the capsule pairing process (see *PillCam Recorder—Capsule Pairing (DR3 only)* on page 62) and when selecting display modes. The icon above the navigation button at the bottom of the display area indicates the functionality of the button. The table below shows the navigation buttons and their actions.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action when pressed</th>
<th>Icon</th>
<th>Action when pressed</th>
</tr>
</thead>
<tbody>
<tr>
<td>⏳</td>
<td>Confirm/select</td>
<td>⚈</td>
<td>Manually activate AFR mode in PillCam COLON 2/PillCam Crohn’s capsule and activate instruction #1 if gastric passage of the capsule is detected and the AFR mode was not entered automatically</td>
</tr>
<tr>
<td>↑</td>
<td>Scroll up the cursor</td>
<td>☮</td>
<td>Activate Real-Time viewing (followed by pressing the left then right buttons within 6 seconds)</td>
</tr>
<tr>
<td>↓</td>
<td>Scroll down the cursor</td>
<td>🎥</td>
<td>Mark displayed frame</td>
</tr>
<tr>
<td>⏹️</td>
<td>Exit Real-Time viewing</td>
<td>🎥</td>
<td>Switch video head (in Real-Time viewing mode)</td>
</tr>
</tbody>
</table>

Button Pressing Indication

The following audio (beep) and visual feedbacks alert the user when pressing buttons on the PillCam recorder DR3:

- **If the backlight is off:** Pressing any button for the first time or turning on the PillCam recorder DR3 turns the backlight on. This action is not accompanied by audio feedback.
- **If the backlight is on:**
  - Momentarily pressing a button that affects a function, such as volume control, Real-Time viewing combination, scrolling up/down or left/right, and selecting buttons, results in audio (beep) feedback.
  - Continuously pressing a button (i.e. press the Acknowledge button for 3 seconds), results in audio (beep) feedback at the end of the required duration (i.e. at the end of 3 seconds).
  - Momentarily pressing a button that is designed to activate a function after continued pressing (i.e. Acknowledge), is not accompanied by audio or visual feedback.
- **If the volumes is set to “off”, no audio indications should play.**
Battery and Capsule Icons

The battery icon on the left side of the status line at the top of the display indicates the status of the battery in 10% increments. These icons appear in the top status line of the PillCam recorder DR3 screen.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Battery Status</th>
<th>Icon</th>
<th>Capsule Reception Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Battery icon]</td>
<td>Battery fully charged</td>
<td>![Signal weak icon]</td>
<td>Signal weak, recording with noise</td>
</tr>
<tr>
<td>![Battery icon]</td>
<td>Battery charge level at 10% intervals</td>
<td>![Signal strong icon]</td>
<td>Signal strong, recording with noise</td>
</tr>
<tr>
<td>![Battery icon]</td>
<td>Battery empty, PillCam recorder shuts down</td>
<td>![Signal weak but OK icon]</td>
<td>Signal weak, but recording OK</td>
</tr>
<tr>
<td>![Battery icon]</td>
<td>Battery charging</td>
<td>![Signal strong but OK icon]</td>
<td>Signal strong, and recording OK</td>
</tr>
</tbody>
</table>

PillCam Recorder DR3 LEDs

The status indications of the LED indicators on the top of the PillCam recorder DR3 for the most common PillCam recorder events are as follows:

<table>
<thead>
<tr>
<th>LEDs</th>
<th>PillCam Recorder DR3 Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Blinking in white]</td>
<td>PillCam recorder DR3 is being checked in. Blinking rate = very fast. Note: In some cases, the LED may appear as light purple.</td>
</tr>
<tr>
<td>![Constant on in white]</td>
<td>PillCam recorder DR3 is checked in and ready to receive capsule signals. Note: In some cases, the LED may appear as light purple.</td>
</tr>
<tr>
<td>![Blinking in white]</td>
<td>PillCam recorder DR3 is checked in and receiving signals from an unpaired capsule. Blinking rate = capsule frame rate. Note: In some cases, the LED may appear as light purple.</td>
</tr>
<tr>
<td>![Blinking in blue at capsule frame rate]</td>
<td>PillCam recorder DR3 is receiving paired capsule signals and recording. Blinking rate = capsule frame rate.</td>
</tr>
<tr>
<td>![All LEDs are off]</td>
<td>Recording done and raw data is available for downloading.</td>
</tr>
</tbody>
</table>
### LEDs

<table>
<thead>
<tr>
<th>Blinking in green</th>
<th>PillCam recorder DR3 has started downloading.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant on in green</td>
<td>PillCam recorder DR3 has completed downloading.</td>
</tr>
<tr>
<td>Blinks in yellow/orange every 5 seconds</td>
<td>PillCam recorder DR3 has stopped receiving capsule signals for more than 5 seconds.</td>
</tr>
<tr>
<td>Constant on in white with main screen icon</td>
<td>PillCam recorder DR3 has stopped recording because the memory card is full.</td>
</tr>
<tr>
<td>Blinking in green</td>
<td>There is an instruction on the PillCam recorder DR3 screen.</td>
</tr>
<tr>
<td>Constant on in red</td>
<td>PillCam recorder DR3 is malfunctioning.</td>
</tr>
<tr>
<td>Blinks in red</td>
<td>PillCam recorder DR3 detects capsule signal, but is not recording it. This is a malfunction. Check the sensor connection or have patient move to a different location.</td>
</tr>
<tr>
<td>Blinking in blue</td>
<td>The navigation buttons blink in blue every 5 seconds when the PillCam recorder DR3 is on, either in or out of the cradle, and the LCD screen is off. To turn the LCD screen back on, press any button on the PillCam recorder DR3.</td>
</tr>
</tbody>
</table>

### General Indications

**LEDs**

- Blinking in green: PillCam recorder DR3 has started downloading.
- Constant on in green: PillCam recorder DR3 has completed downloading.
- Blinks in yellow/orange every 5 seconds: PillCam recorder DR3 has stopped receiving capsule signals for more than 5 seconds.
- Constant on in white with main screen icon: PillCam recorder DR3 has stopped recording because the memory card is full.
- Blinking in green: There is an instruction on the PillCam recorder DR3 screen.
- Constant on in red: PillCam recorder DR3 is malfunctioning.
- Blinks in red: PillCam recorder DR3 detects capsule signal, but is not recording it. This is a malfunction. Check the sensor connection or have patient move to a different location.
- Blinking in blue: The navigation buttons blink in blue every 5 seconds when the PillCam recorder DR3 is on, either in or out of the cradle, and the LCD screen is off. To turn the LCD screen back on, press any button on the PillCam recorder DR3.

### Navigation Buttons Legend

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action when pressed</th>
<th>Icon</th>
<th>Action when pressed</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Mark displayed frame." /></td>
<td>Mark displayed frame.</td>
<td><img src="image" alt="Activate Real-Time viewing" /></td>
<td>Activate Real-Time viewing (followed by pressing the left then right buttons within 6 seconds).</td>
</tr>
<tr>
<td><img src="image" alt="Switch video head" /></td>
<td>Switch video head (in Real-Time viewing mode).</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Screen Icons**

These icons appear as recorder status on the rightmost icon of the top status line of the PillCam recorder DR3 screen:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Explanation</th>
<th>Icon</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>No capsule is paired.</td>
<td><img src="image2.png" alt="Image" /></td>
<td>No sensor is connected.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>Pairing succeeded.</td>
<td><img src="image4.png" alt="Image" /></td>
<td>PillCam recorder DR3 is checked in.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td>Data has downloaded.</td>
<td><img src="image6.png" alt="Image" /></td>
<td>PillCam recorder DR3 is waiting for check-in.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Image" /></td>
<td>End of procedure (appears in the top right corner of the screen).</td>
<td><img src="image8.png" alt="Image" /></td>
<td>AFR</td>
</tr>
<tr>
<td><img src="image9.png" alt="Image" /></td>
<td>Indicates that AFR mode was activated in the capsule. With the COLON2/Crohn’s capsule, appears after detection of gas- tric passage. With the SB3 capsule, appears 3 minutes after AFR mode activation.</td>
<td><img src="image10.png" alt="Image" /></td>
<td>This icon appears in the top right corner or on the main screen and indicates that the recording has completed, but data has not downloaded.</td>
</tr>
<tr>
<td><img src="image11.png" alt="Image" /></td>
<td>End of procedure icon appears on the main screen and indicates that the procedure has ended and equipment may be removed. It occurs when a predefined reception gap from the paired capsule is encountered.</td>
<td><img src="image12.png" alt="Image" /></td>
<td>Regimen reminder numbers appear on the main screen to alert the user to perform dietary instructions. In Real-Time Viewing mode, the Regimen Reminder number appears on the top right corner of the screen.</td>
</tr>
</tbody>
</table>

**Check-in Screen Icons**

After performing patient check-in, these icons appear on the PillCam recorder screen data area:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Explanation</th>
<th>Icon</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image13.png" alt="Image" /></td>
<td>Patient name</td>
<td><img src="image14.png" alt="Image" /></td>
<td>Procedure type and capsule ID</td>
</tr>
<tr>
<td><img src="image15.png" alt="Image" /></td>
<td>Patient ID</td>
<td><img src="image16.png" alt="Image" /></td>
<td>Regimen Delay first instruction status indicator and navigation button designator</td>
</tr>
</tbody>
</table>
Error Messages

During operation, the following messages may appear in the PillCam recorder main screen.

<table>
<thead>
<tr>
<th>Popup</th>
<th>Explanation</th>
<th>Popup</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>60</td>
<td>No approved memory card is detected. Verify you are using an approved card.</td>
<td>61</td>
<td>Do not remove the PillCam recorder DR3 from the cradle.</td>
</tr>
<tr>
<td>61</td>
<td>Memory card is write-protected.</td>
<td>51</td>
<td>Sensor hardware failure. Consult a technician.</td>
</tr>
<tr>
<td>62</td>
<td>Memory card error. Remove and reinsert card.</td>
<td>52</td>
<td>Wrong sensor type.</td>
</tr>
<tr>
<td>63</td>
<td>Insufficient memory on card.</td>
<td>41</td>
<td>Fatal error. Consult a technician.</td>
</tr>
</tbody>
</table>

Real-Time Viewing with DR3

To activate real-time viewing with PillCam recorder DR3, press the middle navigation button below the Real-Time icon, then immediately press the left then right buttons one after the other.
The following screen appears on the PillCam recorder.

![Screen Image]

**Note**
Using Real-time Viewing on the PillCam recorder with an external real-time viewer (laptop) is not supported.

In procedures with AFR mode capsules (PillCam SB 3 and PillCam COLON 2/PillCam Crohn’s), the AFR icon appears above the right navigation button while the capsule is not in AFR mode to allow the user to manually activate the AFR mode of the capsule even before automatic activation. After activation of the AFR mode in the capsule (either manually or automatically), the recorder status icon in the top status line changes from **paired** to AFR **AFR**. The icon displayed above the right navigation button is the **mark** icon that allows the marking of the displayed image for automatic creation of a thumbnail and to facilitate further scrutiny of the image off-line in the created video.

In procedures with non-AFR capsules (PillCam SB 2 and PillCam UGI) the icon that appears above the right navigation button in real-time viewing is the **mark** icon.

**For colon visualization procedures:** instruction #1 on the PillCam recorder screen appears after the capsule enters the small bowel, usually within two hours of ingestion. The AFR icon simultaneously appears in the status line at the top of the PillCam recorder screen, designating the fact that the PillCam COLON 2/PillCam Crohn’s capsule passed into the AFR mode operation.

If the system does not show instruction #1 or the AFR icon two hours after ingestion, you can monitor the capsule location in the GI tract using the real-time viewing. The system will activate by default the AFR mode and instruction #1 at 4 hours post-ingestion at the latest.

If you need to verify (after instruction #1 on the PillCam recorder screen) that the capsule has left the stomach, use the real-time viewer:
- If capsule is still in the stomach, repeat real-time viewing to check capsule location every 30 minutes until you can confirm that it has left the stomach.
- If you visually confirm that the capsule has left the stomach while the AFR indication in the top right corner of the status line still hasn’t changed to AFR **AFR**, press the right navigation button under the AFR icon **AFR** at the right bottom of the screen for 5 seconds. This triggers instruction #1 and activates recording mode AFR frame rate. The AFR icon **AFR** appears at the top right corner in the status line of the screen. The video created from this procedure will start at this point. The **mark** icon **mark** will appear above the right navigation button instead of the AFR **AFR** icon.
• Once instruction #1 occurs, the PillCam recorder automatically continues to provide instructions according to the post-ingestion regimen selected during check-in.

**Note**
For colon visualization procedures:
- If the PillCam recorder does not detect that the capsule has entered the small bowel (either automatically or by the manual procedure described in step 2, above), the following message appears when opening the video: **Gastric-to-SB passage not detected**. In this case, the video is very short (the first 3 minutes only).
- Some patients may require close supervision to ensure they comply with post-ingestion instructions. Other patients may be able to function independently as long as they have access to all needed doses of laxatives and/or prokinetics and are capable of following instructions during the procedure.

When in Real-Time viewing the PillCam recorder screen turns off and returns to the main screen after:
- 2 minutes of inactivity for COLON/Crohn’s procedures and SB procedures,
- 30 minutes of inactivity for UGI procedures.

**Note**
AFR should be activated only after visually confirming entry into the small bowel.

### Setting Delay First Instruction in PillCam Recorder

**For PillCam COLON/PillCam Crohn’s only**

Before ingestion of the PillCam COLON 2/PillCam Crohn’s capsule, you need to make sure that the settings match the procedure circumstance: patient stays in clinic after ingestion or is instructed to go home immediately after ingestion.

**Note**
The **Delay first instruction** option enforces a minimum 60 minute delay between the time of ingestion and the first patient instruction (DR3 alert).

If the patient stays in clinic, the **Delay first instruction** flag on the PillCam recorder DR3 needs to be OFF, otherwise it needs to be ON. If this flag has not been set properly during check-in, it needs to be set before ingestion directly on the PillCam recorder prior to pairing with the PillCam COLON 2/

PillCam Crohn’s capsule by using the right navigation button with the icon above it to toggle the flag. The default setting for the PillCam recorder DR3, without changing the **Delay first instruction** field during check-in, is OFF—first instruction is not delayed. Repetitive use of the right button will
toggle the status of the PillCam recorder DR3 and its status will show in the fourth icon (from above) in the left most side of the fourth procedure data line.

The fourth line status icon and the button designation icon in the lower right corner of the screen above the right navigation button will always be opposite. After pairing, the Delay first instruction icon will disappear and the status will not be changeable any more.

**Connecting a PillCam Recorder to a Personal Computer (PC)**

The PillCam recorder needs to be connected to a PC with PillCam Desktop in the following cases:

- **Connect for initialization:** For initialization before the procedure: to check-in a patient.
- **Connect for downloading:** For downloading data from the recorder after the procedure: to create a video or copy the video data from the recorder to the computer.
- **Connect for charging:** For charging the PillCam recorder after the procedure: to prepare the recorder for the next procedure.
- **Connect for upgrading:** When the software version of the PillCam recorder is lower than the latest one internally specified in PillCam Desktop, the user is prompted to allow a recorder upgrade the first time the recorder is connected to PillCam Desktop for check-in. It is highly recommended to allow the upgrade. The latest software versions for both PillCam recorder DR2
Performing Capsule Endoscopy with DR3

and PillCam recorder DR3 are stored in PillCam Desktop and when prompted and allowed, the appropriate upgrade will be performed.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>It is recommended to use an external hub when connecting multiple PillCam recorders.</td>
</tr>
</tbody>
</table>

The PillCam recorder is connected to the PC only through its cradle, each model through its cradle. The PillCam recorder is passive during these cases and no controls need be operated on it.

Removing the Sensors and the PillCam Recorder

If the patient has not already removed equipment, do so as follows:

1. Disconnect the sensors from the PillCam recorder.
2. Remove the PillCam recorder from the patient.
3. Remove the sensors from the patient.
4. Remove the PillCam recorder from the pouch and place it in the cradle.
5. After each procedure, make sure to clean the equipment (see PillCam Sensor Cleaning on page 189) and charge the PillCam recorder (see Charging on page 70).
Performing Capsule Endoscopy with DR2

This chapter covers the following tasks, which guide you through performing capsule endoscopy using the PillCam recorder DR2:

- **Preparing the Patient** on page 83
- **Preparing the Required Equipment** on page 84
- **Creating Patient Instructions for the Procedure** on page 85
- **Performing Patient Check-in** on page 86
- **Fitting the Equipment on the Patient** on page 91

### Preparing the Patient

Once it is decided that the patient should undergo capsule endoscopy:

1. Verify that no contraindications apply to the patient (see Indications, Contraindications, Warnings, Cautions on page 11).

2. Inform the patient of the following:
   a. Inform the patient of the small possibility of bowel obstruction.
   b. Inform the patient of the importance of a clean bowel for the success of his or her PillCam examination.
   c. Instruct the patient what to expect before, during, and after the procedure.
   d. Instruct the patient on the proper use of the PillCam recorder:
      - The patient must treat the PillCam recorder with care. Avoid any sudden movements. Avoid bumping it.
      - The patient should not remove or disconnect the PillCam recorder at any time during the procedure.
      - The patient should contact the medical staff if the PillCam recorder is blinking red or white.
      - The patient must follow the dietary instructions from the medical staff or when alerted by the PillCam recorder.
   e. If the patient experiences any abdominal pain, nausea, or vomiting after ingesting the PillCam capsule, the patient should immediately inform the medical staff.
   f. After ingesting the PillCam capsule and until it is excreted, the patient should not go near any source of a powerful electromagnetic field, such as one created near an MRI device and should avoid direct exposure to bright sunlight.
Preparing the Required Equipment

Before the patient arrives for the procedure, verify that the necessary equipment and accessories are available.

<table>
<thead>
<tr>
<th>Checklist - Preparing the equipment</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PillCam Desktop</strong></td>
</tr>
<tr>
<td>Make sure PillCam Desktop has been installed, configured, and opened after accepting the license agreement.</td>
</tr>
<tr>
<td><strong>PillCam capsule</strong></td>
</tr>
<tr>
<td>Take note of PillCam handling instructions. See Handling PillCam Capsules on page 6.</td>
</tr>
<tr>
<td><strong>PillCam recorder</strong></td>
</tr>
<tr>
<td>Make sure that the PillCam recorder is charged.</td>
</tr>
<tr>
<td><strong>PillCam recorder pouch</strong></td>
</tr>
<tr>
<td>Prepare PillCam recorder pouch with the shoulder strap.</td>
</tr>
<tr>
<td><strong>Printed instructions</strong></td>
</tr>
<tr>
<td>Print the patient instructions.</td>
</tr>
<tr>
<td><strong>PillCam sensor belt or PillCam sensor array</strong></td>
</tr>
<tr>
<td>Prepare the sensor belt. For sensor arrays, insert the sensors into the sleeves.</td>
</tr>
<tr>
<td><strong>Sensor Location Guide</strong></td>
</tr>
<tr>
<td>Prepare the sensor location guide.</td>
</tr>
<tr>
<td><strong>Water and drinking cup</strong></td>
</tr>
<tr>
<td>Prepare a cup and water for the patient to swallow the capsule.</td>
</tr>
<tr>
<td><strong>Medication</strong></td>
</tr>
<tr>
<td>Prepare any medication prescribed for the patient during the procedure.</td>
</tr>
</tbody>
</table>

**Caution**

For instructions on how to handle PillCam capsules and how to avoid accidental activation (blinking) of the capsule while in its box, see Handling PillCam Capsules on page 6.
Creating Patient Instructions for the Procedure
Patient Instructions are handouts used to guide the patient in preparing for the PillCam capsule endoscopy procedure.

Note
When performing check-in with PillCam Desktop v9.0, video download must be done using PillCam Desktop v9.0.

Pre-ingestion Instruction Handouts
PillCam SB procedure goes with predefined pre-ingestion instruction text.

Pre-ingestion instructions for the respective PillCam procedures are printed and given to the patient before the day of the procedure.

General Patient Guidelines During the Procedure
Make sure that the patient has the printed post-capsule ingestion instructions or patient instructions with your contact information included, and is aware of the instructions below.

<table>
<thead>
<tr>
<th>Patient Guidelines During the Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Avoid any physical activity that involves sweating, bending, or stooping.</td>
</tr>
<tr>
<td>• Remain active. Do not sleep.</td>
</tr>
<tr>
<td>• Use the bathroom as often as needed (do not suppress the urge). The use of wet wipes and cream to protect the skin is recommended.</td>
</tr>
<tr>
<td>• Avoid any source of powerful electromagnetic field (such as an MRI device).</td>
</tr>
<tr>
<td>• If the LED of the top of the PillCam recorder stops blinking blue before the timeouts specified in the next section for the different capsules, contact the medical staff.</td>
</tr>
<tr>
<td>• In the event that no transmissions are received from the capsule (the PillCam recorder stops blinking blue) for more than 60 minutes, the PillCam recorder will shut down.</td>
</tr>
<tr>
<td>• At the end of the procedure, remove the PillCam recorder and sensors. If you need assistance, or were instructed to do so, return to the clinic to have this done.</td>
</tr>
<tr>
<td>• Contact the medical staff in case of any unexpected event or doubt.</td>
</tr>
</tbody>
</table>
Performing Patient Check-in

Connecting the PillCam Recorder for Patient Check-in
The PillCam recorder must be connected to the PillCam Desktop computer during patient check-in. The check-in process allows entering patient and procedure data for the procedure and saves the correct patient and procedure information to the PillCam recorder.

The PillCam recorder connects to the PillCam Desktop computer via the cradle.

Caution
The PillCam recorder must be connected to the PillCam Desktop computer via the cradle for patient check-in, video download, and recorder upgrade.

Completing the Patient Check-in Wizard
If you are working in a HIS-enabled networked environment, you can import the patient check-in data to automatically complete the check-in fields. It is also possible to enter the data manually.

Note
Do not remove the PillCam recorder from its cradle before the end of the check-in process.

To complete the wizard:
1. Make sure the PillCam recorder is fully charged and connected to PillCam Desktop.
2. In the Home screen, select Patient Check-in. The Procedures screen appears.
3. In the Procedures screen, click the Recorder bar.

The following function buttons are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identify Recorder</td>
<td>Identifies the PillCam recorder for the selected recorder bar. When you click this button, all the LEDs on the associated PillCam recorder and cradle blink.</td>
</tr>
<tr>
<td>Check-in Patient</td>
<td>Prepares the PillCam recorder for the capsule endoscopy procedure by entering patient data.</td>
</tr>
<tr>
<td>Copy raw data</td>
<td>Copies the raw video data to the computer. This button is available when the Enable raw data copying checkbox is selected in Tools &gt; Settings &gt; Video tab (see Managing PillCam Software Video Data on page 104). (Not available for PillCam Reader.)</td>
</tr>
</tbody>
</table>
4. Click Check-in Patient.

**Caution**
If the PillCam recorder needs a software update, this message appears:

*This recorder requires a software update. Do you want to update the recorder software version?*

- Click Yes and follow the instructions on the screen. When the update is done, remove the PillCam recorder from its cradle and reinsert it.
- To ignore the update, click No. You may continue the check-in and perform the update later.
- Selecting the Don't show this message again checkbox will disable further updates to this specific recorder. This option is available only if you are logged in as the administrator.

The Patient Check-in wizard opens.

5. Click Next to continue.
   The first Patient Check-in window appears.

6. Enter patient data by importing from the HIS (Hospital Information System) or by typing in manually.

**HIS Import**

a. Click Import. The Import Patient Data screen appears. The available data for patients not yet checked in appears on the screen sorted by planned Procedure Date. You can sort the studies by any of the column headings in either ascending or descending order.

b. To select a patient, select the relevant line and click OK. This automatically adds check-in data into the appropriate fields in PillCam Desktop.

At the end of patient check-in process, the patient data is removed from the Available for Check-in list and appears in the Already imported list. In the list next to Display at the top of the screen, you can select which patient list you wish to see: Available for Check-in or Already imported.

To delete a patient from the Already imported list, select the relevant line and click Delete.
Once you click OK, the first check-in screen appears again, with all available information already entered. You may need to complete additional mandatory or optional procedure information (such as capsule ID) not auto-populated from the HIS (see the PillCam Desktop IT Guide). When all necessary data entry is completed, you may proceed to the Procedure info confirmation screen by clicking the Next or Finish buttons or by changing any of the information fields.

**Manual Data Entry**

a. Enter the patient’s Last, First, and Middle names into the appropriate fields. Use alphanumeric, underscore, hyphen, and space characters. Use the TAB key to move to the next field.

b. Enter the patient ID number in ID.

c. Select the Gender.

d. In Birth Date, set the patient’s date of birth.

e. In Procedure Date, enter the date on which the procedure is to be performed. By default, it is set for current date.

f. In Capsule ID, if filling this field during check-in, enter the capsule ID code that is printed on the bottom of the capsule box (by typing it in or by using a barcode). The capsule type field is automatically populated according to the capsule type encoded in the capsule ID entered.

g. In Capsule Type, if you have not filled in Capsule ID in the previous field, select the SB procedure. If you have filled in the Capsule ID field, this field will auto-populate with the corresponding capsule type.

h. In the Sensor Type drop-down list, select the sensor type. Only those sensor types appropriate for the selected capsule type field value will appear in the selection menu. To ensure accurate localization information use only the sensor type that you defined in the check-in process.

7. Click **Next** to continue.

8. Complete physician and insurance details:
   a. Enter Referring Physician and Ordering Physician.
   b. In Check-in by, enter your name.
   c. Enter Insurance, Group Number, and ICD Code, as required.
   d. Click **Next** to continue.
9. Type in the **Reason for Referral**, if it is known, and click **Next**.

10. Complete the patient physical description (**Height**, **Weight**, **Waist**, and **Physique**). Click **Next**.

11. Complete the protocol and materials details:
   
a. Fill in **Protocol number** or name if you are performing a clinical trial.
   
b. For **Capsule lot number**, enter the LOT # from the back of the capsule box.
   
c. For **Sensor serial number**, enter the SN from the sensor array cable.
   
d. For **Battery pack serial number**, enter the DR2 recorder battery pack serial number.
   
e. For **Recorder serial number**, enter the PillCam recorder serial number.
   
f. Click **Next** to continue.
12. In the **Procedure Information Confirmation** screen, verify that the patient and procedure data is correct:

- If the data is incorrect, click **Back** and return to a previous screen to correct the mistake.
- If the data is correct, select **Accept**, and then click **Finish** to continue. When the **Patient Check-in complete** screen appears, click **Ready** to proceed.

**Note**

When the patient check-in is complete, the capsule LED on the PillCam recorder lights up in orange.

After patient check-in, keep the PillCam recorder in its cradle until the capsule ingestion procedure begins.

**Updating Patient Details**

Patient details are collected during the Patient Check-in process. However, PillCam Desktop allows you to change or update all the patient information after a video creation.

**To update patient details:**

1. Find the study in the Study Manager.
2. Right-click the study and select **Update Patient Details**. The Update Patient Details screen appears. Make the required changes and click **Next** until you have completed your update.
3. Click **Save** on the last screen.
Fitting the Equipment on the Patient

This section guides you through preparing and fitting the patient with the recording equipment required for the capsule endoscopy procedure, and includes the following steps:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Applying the PillCam Sensor Belt</td>
</tr>
<tr>
<td>2</td>
<td>Applying the PillCam Sensor Array</td>
</tr>
<tr>
<td>3</td>
<td>Attaching the Sensors to the PillCam Recorder</td>
</tr>
</tbody>
</table>

Before You Start

Verify that the required equipment has been prepared.

---

**Checklist - Preparing for the CE procedure**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PillCam Sensor Belt</td>
<td></td>
</tr>
<tr>
<td>PillCam Sensor Array</td>
<td></td>
</tr>
<tr>
<td>PillCam Capsule</td>
<td></td>
</tr>
<tr>
<td>Sensor Location Guide</td>
<td></td>
</tr>
<tr>
<td>Adhesive sleeves, to hold each of the sensors securely in place</td>
<td></td>
</tr>
<tr>
<td>Razor and disinfectant (not supplied), to shave the area of the sensors on the abdomen</td>
<td></td>
</tr>
</tbody>
</table>

---

**Applying the PillCam Sensor Belt**

The sensor belt is used for PillCam SB procedures and consists of a flat, flexible belt-like sensor arrangement. The sensor belt is worn around the patient's waist over a single, thin layer of natural fabric, such as a T-shirt. Depending on the sensor belt, for sanitary purposes some models may require the fitting of a single-use disposable protective sleeve while other models feature a reusable washable external fabric sleeve.

---

**Note**

- The image of the PillCam sensor belt is for reference only. Sensor belt models may differ from the image.
- Refer to the product insert supplied with your sensor belt for full instructions on fitting, usage, cleaning, and technical description.
Applying the PillCam Sensor Array

The sensor array allows the PillCam recorder to collect localization data during a procedure. The prescribing physician may request this.

To prepare the sensor array:

1. Insert each sensor into an adhesive sleeve. The sensor markings (dots or this side up) should face away from the adhesive side of the sleeve.

2. To secure the sensor in the sleeve, remove the liner from the topside of the lower lip at the opening of the adhesive sleeve and press both lips together.

3. Place the sensors on the patient according to the sensor location guide (see SB Sensor Locations on page 94).

Note
Sensor arrays must be applied directly to smooth skin. Anything that comes between the patient's skin and the sensors, including hair or air, and any changes in the sensors' arrangement, may interfere with the quality of the data.

Warning
Do not use the sensor array if it is torn or damaged.

To attach the sensor array:

1. With the patient standing and exposing the thorax and abdominal area, place the sensor array loop on the patient's left shoulder. If the loop is too long, gather and fasten the surplus in the fastener.

2. Ask the patient to lie down.

3. Use the Sensor Location Guide to identify the location of each sensor on the patient's body and mark it with a dot.

4. The sensor array sleeves should be applied to hairless skin. If needed, wipe the patient's skin with disinfectant and shave the areas where sensors are to be applied.

5. With the sensor array connector at the patient's side, lay the prepared sensor array on the patient's abdomen and match the letters and colors on each sensor wire to the letters and colors on the Sensor Location Guide.

6. To attach each sensor, remove the protective backing from its adhesive sleeve.

Note
Since the sensors are placed on the body according to anatomical reference points, the distances between sensors may vary from patient to patient.
If you are using a sensor array with a downlink loop, adjust the downlink loop to remove excess cable so that it fits closely to the patient's body. To prevent damage to the wires do not forcibly bend the downlink loop in any way.

7. When the patient gets dressed, make sure that the sensor array connector remains outside of the patient's clothing and make sure that the patient is not uncomfortable with the equipment.

**Note**
Adjust the downlink loop to remove excess cable so that it fits closely to the patient's body. To prevent damage to the wires do not forcibly bend the downlink loop in any way.

**Caution**
- Make sure that there is no other PillCam capsule or other diagnostic capsule in the patient's gastrointestinal tract.
- Verify that the capsule expiration date has not passed (see the date next to the icon on the packaging).
- If you are performing the procedure for the first time, read the capsule package insert.
### SB Sensor Locations

<table>
<thead>
<tr>
<th>Sensor Label</th>
<th>Sensor Color</th>
<th>Sensor Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Black</td>
<td>Intersection of right 7th intercostal space and right mid-clavicular line</td>
</tr>
<tr>
<td>B</td>
<td>Yellow</td>
<td>Xiphoid process</td>
</tr>
<tr>
<td>C</td>
<td>Brown</td>
<td>Intersection of left 7th intercostal space and left mid-clavicular line</td>
</tr>
<tr>
<td>D</td>
<td>Blue</td>
<td>Right lumbar region at umbilical level</td>
</tr>
<tr>
<td>E</td>
<td>Purple</td>
<td>Above umbilicus (navel)</td>
</tr>
<tr>
<td>F</td>
<td>White</td>
<td>Left lumbar region at umbilical level</td>
</tr>
<tr>
<td>G</td>
<td>Green</td>
<td>Right mid-inguinal region</td>
</tr>
<tr>
<td>H</td>
<td>Red</td>
<td>Left mid-inguinal region</td>
</tr>
</tbody>
</table>
Performing Capsule Endoscopy with DR2

Attaching the Sensors to the PillCam Recorder

The PillCam recorder is worn by patients during the procedure in the recorder pouch with the shoulder strap or in the recorder belt with suspenders. Make sure that these accessories fit the patient comfortably.

Recorder Pouch

To fit the recorder pouch:

1. With the patient standing, hang the recorder pouch from the patient’s shoulder as displayed in the illustration.

2. Adjust the shoulder strap so that the recorder hangs at the patient's side at waist level with the supplied strap securing the recorder to the waist.

PillCam Recorder Belt

Note

There are three belt configurations for PillCam recorder DR2:

- the standard recorder belt for patients over 85 lbs (40 kg),
- the small recorder belt for patients under 85 lbs (40 kg),
- the standard recorder belt with the belt extension for very large patients.

To fit the recorder belt:

1. With the patient standing, place the belt around the patient’s waist.

2. Adjust the belt to fit the patient. Add the belt extension if needed.

3. Make sure that the PillCam recorder DR2 pouch is at the patient’s hip as shown in the image. The belt has a Velcro strap for attaching the pouch, allowing the patient to adjust the pouch as needed.

4. Adjust the suspender length and location to fit the patient.
PillCam Recorder

To assemble the PillCam recorder accessories:

1. Remove the PillCam recorder from the cradle. If the PillCam recorder is properly initialized and ready for the procedure, the capsule LED is constantly on in orange.

2. Verify that the battery is fully charged. All battery LEDs should light up.

3. Insert the PillCam recorder into its pouch. Instruct the patient to keep wearing the PillCam recorder during the examination. The pouch or belt is ready and the patient can wear it.

Warning

While the PillCam recorder is connected to a sensor array worn by a patient:

- Do not connect the PillCam recorder to a computer that is connected to an electrical outlet.
- Do not put the PillCam recorder into a cradle or connect it to a charger.
- Attach the sensor connector to the PillCam recorder immediately prior to capsule ingestion.
- If the blue LED is blinking before you open the PillCam capsule box, reinitialize the PillCam recorder.

Positioning PillCam Recorder DR2

1. If you are using the recorder pouch, hang it from the patient’s shoulder while the patient is standing.

   If you are using the recorder belt, secure it around the patient’s waist, while the patient is standing.

   Note

   The sensor array connector and wire should hang over the top of the recorder belt.
2. Make sure the locking handle at the back of the PillCam recorder is open. Slide the two protrusions on the connector into the matching grooves in the PillCam recorder.

3. Verify that the connector is inserted completely, and then lock it by closing the handle on the PillCam recorder.

4. Make sure that the PillCam recorder is on (the battery LEDs light up once every 5 seconds).

**Note**
- Remind the patient about wearing and handling the PillCam recorder with care (see General Patient Guidelines During the Procedure on page 85).
- Make sure the patient has the printed instructions (see Printing the Patient Instructions on page 30).
- When securing the sensor belt, make sure the fabric of the patient’s shirt is not folded beneath the front portion of the sensor belt.
- Make sure nothing other than a single, thin layer of fabric is allowed to come between the sensor belt and the abdomen.
- In order to avoid pulling the sensor belt out of position, do not attach or anchor anything to the sensor belt.
- Be sure that the PillCam recorder is worn over the sensor belt and that the PillCam recorder pouch is not attached to the PillCam sensor belt.
- Another layer of clothing may be worn over the sensor belt as long as the sensor belt connecting wire can be attached to the PillCam recorder.
Capsule Ingestion

Capsule ingestion is the process of having the patient swallow the PillCam capsule.

Before you start

Verify that the required equipment has been prepared.

<table>
<thead>
<tr>
<th>Checklist - Capsule Ingestion</th>
</tr>
</thead>
<tbody>
<tr>
<td>PillCam capsule</td>
</tr>
<tr>
<td>Glass of water</td>
</tr>
<tr>
<td>Read the note that follows regarding Multiple Procedures</td>
</tr>
</tbody>
</table>

Before allowing the patient to swallow the capsule, take note of the following issues regarding Multiple Procedures:

Multiple Procedures

When performing more than one PillCam capsule endoscopy procedure in the same vicinity, follow these guidelines to prevent signal interference with other procedures:

- After patient check-in, keep the PillCam recorder in the cradle without sensors attached until capsule ingestion procedure begins. Return it to the cradle when the procedure is complete.
- If the blue PillCam recorder LED is blinking before you open the box of the capsule you intend to use, repeat check-in with the PillCam recorder.
- Perform only one capsule ingestion at a time with no other active PillCam recorder or capsules present in the room.
- Attach sensors to the PillCam recorder immediately prior to the ingestion after sensors are properly positioned on the patient.
- Do not permit patients wearing PillCam recorders to stay directly next to other patients with ingested capsules.
- To minimize the potential for radio frequency interference from the capsule after it is removed from the box, verify that the capsule LEDs are blinking and have the patient ingest it immediately.
- Once the PillCam Desktop video is created, check to be sure the video is complete.

To perform capsule ingestion:

1. Make sure that the capsule and the capsule LED on the PillCam recorder are blinking in time with each other.

2. Position the patient on the bed, with a pillow (6 cm or 2.5 inch high) under their head to facilitate drinking and ingestion.

3. Instruct the patient not to talk during the procedure.

4. To verify that the system is operating properly, hold the capsule in front of the patient’s abdomen very close to the sensors (practically touching through the clothes one of the sensors). Hold it for at least 15 seconds and check that the capsule LED on the PillCam recorder blinks at the same rate as the capsule.

5. Have the patient swallow the capsule with a sip of water.
**Working with the PillCam Recorder DR2**

**General**
The PillCam recorder DR2 battery is limited to 350 use cycles. Contact customer service for a replacement battery when necessary.

**Note**
Once the number of uses exceeds 350, the following message appears (in the log file only): DR2 battery must be replaced before further use. Contact customer support to arrange replacement.

**Turning the PillCam Recorder DR2 On and Off**
This illustration shows the front and back view of the PillCam recorder DR2:

The On/Off button is on the top left side on the back of the PillCam recorder DR2:
- To turn on, press and hold the On/Off button until you hear a long beep followed by a short one and the LEDs start flashing.
- To turn off, press and hold the On/Off button until you hear a beep and the LEDs turn off.

**Note**
**Automatic shutdown:** After the PillCam recorder DR2 has been checked in, it goes into standby mode and is ready to receive capsule signals. When removed from its cradle, the PillCam recorder DR2 starts recording as soon as a signal is received from a transmitting capsule. If after removal from the cradle no signal is received for 90 minutes, the PillCam recorder DR2 automatically shuts down.

After starting to receive signals from a capsule, if there is a gap of 60 minutes of no signal reception, the recorder shuts down.
Charging

The cradle provided with the PillCam recorder DR2:

- Charges the PillCam recorder when it is placed in the cradle
- Charges a spare battery externally when a stand-alone battery is placed in the cradle
- Performs battery maintenance by discharging the battery when needed (the cradle detects when the battery needs refreshing and automatically discharges it before recharging)

To charge the PillCam recorder DR2:

1. Insert the PillCam recorder DR2 into the cradle.
2. Push the PillCam recorder DR2 all the way down into the cradle and make sure you hear a series of beeps, indicating that connection is complete.

![Warning]

Do not connect the PillCam recorder DR2 to the sensor array while the PillCam recorder DR2 is in its cradle.

There are four connections on the back panel of the cradle. Only the power connector and the USB cable connection are used with standard operation of the cradle.

The cradle connects the PillCam recorder to the Personal Computer (PC):

- The green LED on the cradle indicates that the PillCam recorder DR2 is fully charged and ready for use.
- The red LED, when lit continuously, indicates a defective battery.
- The red LED, when blinking, indicates that there is a problem with the cradle.

PillCam Recorder DR2 LEDs

When the PillCam recorder DR2 is on, it starts recording as soon as it receives a signal from a PillCam capsule. A blinking capsule LED indicates that the PillCam recorder DR2 is receiving data. When the signal from the PillCam capsule is too weak, the LED does not blink.
These are the LED indicators and their statuses and colors for the most common PillCam recorder DR2 events and statuses:

<table>
<thead>
<tr>
<th>LEDs</th>
<th>PillCam Recorder DR2 Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>🍎</td>
<td>PillCam recorder is ON but not initialized. PillCam recorder does not capture capsule signals.</td>
</tr>
<tr>
<td>🍎</td>
<td>PillCam recorder is initialized with patient data and ready to capture capsule signals. PillCam recorder shuts down if no capsule signals are received for more than 30, 60, or 90 minutes, depending on the PillCam recorder software version.</td>
</tr>
<tr>
<td>🌟</td>
<td>PillCam recorder is exchanging status or data with PillCam Desktop or PillCam Desktop RT. LED blinking rate varies according to the communication flow.</td>
</tr>
<tr>
<td>🍎</td>
<td>PillCam recorder is capturing capsule signals. Blinking rate = capsule frame rate.</td>
</tr>
<tr>
<td>🌟</td>
<td>PillCam recorder has stopped capturing capsule signals for more than 5 seconds. PillCam recorder is detecting a capsule in sleep mode. Blinking rate = every five seconds (in any color).</td>
</tr>
<tr>
<td>🍎</td>
<td>PillCam recorder is malfunctioning. PillCam recorder is malfunctioning. PillCam recorder is malfunctioning.</td>
</tr>
<tr>
<td>🌟</td>
<td>PillCam recorder is synchronizing with a capsule. This is normal functioning. PillCam recorder detects capsule signal, but is not recording it. This is a malfunction. Check the sensor array connection or have patient move to a different location.</td>
</tr>
<tr>
<td>🍎</td>
<td>maximum Battery charge level:</td>
</tr>
<tr>
<td>🍎</td>
<td>25% When charging, the battery LEDs do not blink.</td>
</tr>
<tr>
<td>🌟</td>
<td>below 10% When PillCam recorder is out of the cradle, the battery LEDs blink once every 5 seconds.</td>
</tr>
</tbody>
</table>
Connecting the PillCam Recorder DR2 to the Real-Time Viewer

The PillCam recorder may be connected to an external real-time viewer, which is a dedicated tablet PC with real-time viewing software and special setup, for viewing in real-time the images captured and stored in the recorder.

For a real-time viewing session, both recorder types connect to the external real-time viewer (tablet PC) through a USB cable, while the tablet PC or anything connected to it must not be connected, directly or indirectly to any wall outlet. The real-time viewing software in the tablet PC controls the session and the PillCam recorder is passive in this configuration. There is no need to use any control button of the recorders.

Connecting a PillCam Recorder to a Personal Computer (PC)

The PillCam recorder needs to be connected to a PC with PillCam Desktop in the following cases:

- **Connect for initialization:** For initialization before the procedure: to check-in a patient.
- **Connect for downloading:** For downloading data from the recorder after the procedure: to create a video or copy the video data from the recorder to the computer.
- **Connect for charging:** For charging the PillCam recorder after the procedure: to prepare the recorder for the next procedure.
- **Connect for upgrading:** When the software version of the PillCam recorder is lower than the latest one internally specified in PillCam Desktop, the user is prompted to allow a recorder upgrade the first time the recorder is connected to PillCam Desktop for check-in. It is highly recommended to allow the upgrade. The latest software version is stored in PillCam Desktop and when prompted and allowed, the appropriate upgrade will be performed.

**Note**
- It is recommended to use an external hub when connecting multiple PillCam recorders.
- The PillCam recorder is only connected to the PC through its cradle.
- The PillCam recorder is passive in the situations described above; no controls need be operated on it.
This chapter covers the following tasks, which guide you through downloading video data and creating a video:

- **PillCam Recorder Download** on page 103
- **Managing Data** on page 104
- **Creating Videos** on page 111

### PillCam Recorder Download

After the capsule endoscopy examination, the video data in the PillCam recorder must be copied to a computer and compiled into a video. There are two ways of doing this:

- Copy the data and compile the video as a single task. Although very convenient, this option takes longer to complete and free up the PillCam recorder.

  or,

- Copy the data only and perform compilation later. This method requires some additional steps, but makes the PillCam recorder available faster (see *Copying Data from a PillCam Recorder on page 104*).

When creating a video, the PillCam Desktop software:

- Creates a folder for the new video. This folder is inside the preset default folder (see *Working with Studies on page 123*).
- Displays the images being copied from the PillCam recorder during video creation.
- Creates the PillCam Desktop video from this raw data and saves it in the new folder. The new video name and its folder name are the same.
- Notifies you once video creation is complete so you may disconnect the PillCam recorder.

**Note**

- In the rare case that the video creation fails, PillCam Desktop prompts you to save the raw data for customer support.
- You can reduce the file size while copying data (see *Managing PillCam Software Video Data on page 104*).
- When downloading from four recorders simultaneously ensure that there is at least to 40 gigabytes of hard disk space.
- Make sure that the computer power settings are not set to sleep or to hibernate modes.
Managing Data

Managing PillCam Software Video Data
You can copy the video data from the PillCam recorder to the computer, a USB storage device, or a DVD without compilation into a video. Video data management is disabled by default.

To enable video data management:

1. From the Home screen, select **Tools > Settings**.
2. Select the **Video** tab.
   Under **Video Data Management**, make sure **Enable copy raw data** is selected. You can copy the video data from the USB storage device or a DVD onto a workstation for video creation (see *From Raw Data Files/USB Storage Devices on page 113*).
3. After making the changes to the settings, click **Apply** to accept the new settings or click **Cancel** to close the Settings screen without accepting any changes. Clicking **OK** will accept the new settings and close the Settings screen.

Copying Data from a PillCam Recorder

To copy video data from a PillCam recorder:

1. Place the PillCam recorder in the cradle. Make sure that the cradle is connected to the personal Computer (PC).
2. From the Home screen, click **Recorder Download**.
   The Procedures screen appears with the **Recorders** tab on top.
3. Click the **Recorder** bar that corresponds to the PillCam recorder with the necessary data:

- When the correct **Recorder** bar is activated and you click on the **Identify Recorder** button, the corresponding PillCam recorder’s LEDs blink.
- The relevant patient information is displayed on the **Recorder** bar.
- PillCam recorder's last use is displayed.

The **Copy raw data**, **Create Video**, and **Check-in Patient** buttons become available.

4. Click **Copy raw data**.

5. Select the location for the copied data. Click **Change** if you wish to copy the data to a different location (on the computer, network, or external device) than the default (E:\datatransfer). To change the default directory, see *Managing PillCam Software Video Data on page 104*.

6. Click **Start Copy**.

During raw data copy the **Recorder** bar displays:
- The **Compiling raw data** or **Copying data** message, depending on the video settings.
- The status and progress bar.
- The patient name ID.
• The name of the video to be created.
• The battery status.
• The Do not remove recorder message flashes below the battery status until all data is copied.

Once the process is complete, a message appears on the screen notifying you that the data copy is complete. The PillCam recorder may be disconnected at this point.

**Managing Raw Data Files**

The Raw Data Files screen allows you to manage and monitor all video data files on your PC or connected USB storage device.

To open the Raw Data Files screen, select Recorder Download from the Home screen. The Procedures screen appears. Select the Raw Data Files tab.

A list of raw data files appears; their status and location are displayed in the recorder bar. On the right side, the following buttons appear:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Video</td>
<td>Creates a video from the video data file that was copied to the computer.</td>
</tr>
<tr>
<td>Delete file</td>
<td>Deletes the video data file that was copied to the computer.</td>
</tr>
<tr>
<td>Copy or Burn File</td>
<td>Copies the video data file to a CD/DVD, to a different folder, or a USB storage device.</td>
</tr>
<tr>
<td>Safely Remove</td>
<td>Ejects the USB device once the video data file is copied and deleted from a USB storage device. This button appears only if raw data files are connected to the computer via a USB device.</td>
</tr>
</tbody>
</table>
Batch Data Copy

The PillCam Desktop software can perform multiple video data copy for any combination of up to four PillCam recorder cradles and USB storage devices, and for any number of video data files.

From PillCam Recorders

Place PillCam recorders into the connected cradles. In the Recorders screen, click Manage Video Data for each one, separately.

From Video Data Files/USB Storage Devices

Connect USB Storage devices. In the Raw Data Files screen, click Copy or Burn File for each one of the devices or any video data files already on the computer.

Backing up Data

When you have confirmed that the video was created successfully, you may delete the raw data files from your computer. We recommend this since these raw data files are very large.

Back up the PillCam Desktop folders (which contain created videos) by saving them on removable discs (CD/DVD or USB storage device). After saving them on removable media, you may delete them from the PC's hard disk if they are not to be reviewed on that PC.

Backup/Restore Offline Studies

The PillCam Desktop Study Manager displays information about studies stored on removable storage media, such as CDs, DVDs, and some USB storage devices, that have been connected to the computer during use of PillCam Desktop and are currently disconnected from the computer. After clicking the Offline Studies button in the Study Manager a list of recently viewed studies which are currently not connected to the computer is displayed. The offline study list is updated whenever the removable storage media is disconnected or reconnected.

To back up the list of the Offline Studies to a database file, use the PillCam Desktop Backup & Restore Offline Studies utility.

Note

Label all USB storage devices used for Video Data Copy or for transport of PillCam Desktop videos, stating that they may contain clinical data and should not be used for other purposes.

Note

Make sure that the PillCam Desktop software is completely shut down before removing the PillCam recorder from its cradle.
To backup Offline Studies:

1. You can backup the Study Manager Offline Studies by clicking the Windows Start button and then selecting Given Imaging > Backup and Restore Offline Studies. The following screen appears.

2. Select Export Directory and click Next. The following screen appears.

3. In the following screen, click the Directory button to launch the Export directory screen.

4. Click the Browse button and navigate to the location to export the backup.

5. Enter the file name of the backup and click Save.

6. When the process is complete, a message appears that it was completed successfully. Click OK.
To import backup Offline Studies:

1. In order to restore Study Manager Offline Studies, click the Windows **Start** button > **Given Imaging** > **Backup and Restore Offline Studies**. The following screen appears.

2. Select **Import directory** and click **Next**.

3. In the following screen click the **Directory** button to launch the **Import directory** screen.

4. Navigate to the database file (with Microsoft Access *accdb* file extension) and click the **Open** button to load the offline studies to the PillCam Desktop Study Manager.
Freeing Space on Your Computer

Deleting Videos
If you start to create a video while there is not enough space on your computer, you will be prompted
to empty the Recycle Bin and if more space is needed, to delete PillCam Desktop folders.
To free space for new videos, delete PillCam Desktop studies from your hard disk or from E:\Videos.

To delete videos from your hard disk:
1. From the Home screen click Tools > Delete Videos.
The Delete Video Folder window appears.
2. Select the video folder you wish to delete.
The Delete button becomes available.
3. Click Delete.
The selected PillCam Desktop folder and all its contents will be deleted.
4. Empty the Recycle Bin.

Deleting Raw Data Files after Video Creation
When creating videos in default mode, the PillCam Desktop software clears previous raw data files it
may have copied to the computer in the video creation process. However, if you select the optional
Copy raw data method for video creation in the Settings screen, raw data files are not automatically
deleted after the video is created. As multiple raw data files can rapidly fill your disk, you must
manually clear raw data files as follows:

To clear raw data files:
1. From the Home screen, click Recorder Download and select the Raw Data Files screen.
2. To confirm that you no longer need a raw data file, you can refer to the Last Use status, and you
   may delete files after Successful video creation or data copy.
3. Click the bar displaying the file you wish to delete and click Delete file.
Backup System Logs
The system log file records all system events on the Workstation, such as log in, print, delete, etc. The size of this file is limited, and when it reaches 80% of its capacity, the following message is displayed immediately after logging in: *The log files need to be backed up. Please notify PillCam Desktop Workstation administrator.*

Only the system administrator can back up the system log.
This message appears at every login, until the backup procedure is performed.

Creating Videos

Creating a Video from the PillCam Recorder

To create a video from the PillCam recorder:

1. Place the PillCam recorder in the cradle. Make sure that the cradle is connected to the computer on which PillCam Desktop is installed and open.

2. From the Home screen, click [Recorder Download](#).
The Procedures screen appears with the **Recorders** tab on top.

3. Click the Recorder bar that corresponds to the PillCam recorder with the necessary data:
   - When the correct Recorder bar is activated and you click on the **Identify Recorder** button, the corresponding PillCam recorder LEDs blink.
   - The relevant patient information is displayed on the Recorder bar.
   - PillCam recorder’s last use, such as **Recording, Creating video**...

   The Create Video and Check-in Patient buttons become available.

4. Click **Create Video**.
   - If there is enough space on the PC’s hard disk, the new video is created. If not, you are prompted to free up space (see *Freeing Space on Your Computer on page 110*).
   - During video creation, in the PillCam recorders window, the Create Video button becomes the End video creation button. The Recorder bar displays the following:
     - The status and progress bar.
     - The patient name and ID.
     - The name of the video to be created.
     - The battery status.
     - The **Do not remove recorder** message flashes below the battery status until all data is copied or compiled into a video.

   The images that are being copied to the computer are displayed in the Compiling Images window above the function buttons.
Creating a Video from USB Storage Device or DVD

PillCam Desktop supports video creation from media (a removable USB storage device or DVD). This can be useful if you have copied raw data from the PillCam recorder.

To create a video from a media:

1. Plug the USB storage device into one of the USB 2.0 ports of the PC, or insert the DVD into the DVD drive.
2. From the Home screen, click **Recorder Download**.

   ![Recorder Download Screen](image)

   The Procedures screen appears.

3. Click the **Raw Data Files** tab.
   Find the bar that corresponds to the USB storage device you want to select. The relevant patient information is displayed on the button.

4. Click **Create Video**.

5. After a video has been created, click **Safely Remove** to safely remove the USB storage device.

**Batch Video Creation**

PillCam Desktop can perform multiple video creations for any combination of up to four PillCam recorder cradles, and for any number of raw data files. Once the process begins, the videos are created consecutively.

**From PillCam Recorders**

Place PillCam recorders into the connected cradles. In the **Recorders** screen, click **Create Video** for each one, separately. The order in which you click **Create Video** determines the order in which the videos are created. If you cancel one of the video creations after activating it, this PillCam recorder is skipped and the next one starts automatically.

**From Raw Data Files/USB Storage Devices**

Connect USB Storage devices. In the **Raw Data Files** screen, click **Create Video** for each one of the devices or any raw data files already on the computer. The order in which you click **Create Video**...
determines the order in which the videos are created. If you cancel one of the video creations after activating it, this raw data file is skipped and the next one starts automatically.

**Pause/End Video Creation**

During video creation, the End video creation button becomes available.

To cancel video creation:

1. Click End video creation.
2. Click Yes to end the compilation, or click No to continue compilation.
After completing the patient procedure and downloading the procedure data to the computer, PillCam Desktop Software processes and transforms the raw image data from studies into conveniently viewable videos. This chapter describes the PillCam Software interface, how to open studies, view procedure videos, annotate images of interest, add comments and markings to the images, and create a Report.

This chapter guides you through the typical workflow, which includes the following main actions:

- Using the Study Manager on page 115
- Working with Studies on page 123
- Familiarizing Yourself with the PillCam Desktop Main Screen on page 129
- Viewing Videos on page 147
- Working with Findings on page 163
- Creating a PillCam Capsule Endoscopy Report on page 165

**Using the Study Manager**

The Study Manager allows you to conveniently access, manage, sort, and search patient studies.

The Study Manager connects to a directory of procedure studies, called an Archive. Archives can be stored at different locations for example, on the local computer or on a network, on a removable drive connected to the computer, or on a CD/DVD. Each line in the Study Manager represents a separate PillCam capsule procedure study.

This section provides an overview of the Study Manager screen and describes the tasks you can perform in the Study Manager.
Opening the Study Manager

You can access the Study Manager in one of the following ways:

- In the Home screen, click View Study and select Study Manager from the drop-down list.
  
  Or:

- If you are already viewing a study, click the icon in the top left corner of the screen.

The Study Manager is divided into the following sections:

- Archives
- Studies
- Search
- Status bar
- Action buttons

Archives

The Archives section displays the study archives that are currently accessible in PillCam Software. The Study Manager can connect to study archives located on the local computer, on an accessible network, or a removable storage media such as a flash drive or a CD/DVD:

- Represents an archive on a fixed drive, such as the computer’s hard disk or a drive on the network. The default archive is defined in Settings > Video > Video directory. For details on adding archives, see Adding an Archive on page 117.
Right-clicking on a selected archive in the Study Manager displays the following options:

- **Remove**: Removes the archive path from the Study Manager. To remove the CD/DVD from the disk drive or any portable drive from the USB connection click **Eject**.

  - **Note**: DO NOT remove the USB storage device until after any actions performed with it are completed.

- **Rename**: Allows changing the name of the selected archive.
- **Move Up**: Moves the selected archive up in the archive list.
- **Move Down**: Moves the selected archive down in the archive list.

**Adding an Archive**

The instructions below describe how to add an archive containing procedure studies to the Study Manager. Studies on CDs, DVDs, and portable drives connected to the computer's USB port are detected and added automatically. Renaming or deleting an archive will not affect the archive’s source directory.

- **Note**: After upgrading your software, click **Refresh** when connecting to any archive for the first time. This process may take some time.

- **Note**: Adding an archive provides a visual link to the directory using the Study Manager. It does not copy the data locally to your computer. Removing an archive using the **Remove** button does not delete data from the directory, but only the path to the directory.

**To add an archive:**

1. Click the **Add** button at the bottom left of the Study Manager screen. The **Add Archive** screen appears.

2. Enter the archive path. If necessary, click the **Browse** button to browse for the archive on the local computer or on the network.

3. Define the archive name. This name will appear below the archive icon in the Study Manager.
4. Click **Finish**. The Study Manager scans the archive and a progress indicator appears next to the archive.

In the Status bar, the **Loading studies**... message appears until all studies are loaded and then changes to **Loading studies successful**.

**Note**
During archive scanning, it is possible to open studies that already appear in the Study Manager screen.

**Studies**

The Study Manager displays all the studies located in the selected archive in tabular format. Each line represents a different study.

By default, the studies are sorted by the Procedure Date column. The primary sort column is represented by an arrow.

The studies are identified by several parameters that define the study, such as the patient name, capsule procedure type, and referring physician. A check mark indicates the availability of the following:

- **Video Created**: The study includes a video of the procedure.
- **Findings**: The study includes a findings file created for this procedure.
- **Reports**: The study includes a report of the procedure.

Right-clicking on a selected study in the Study Manager displays the following options:

- **Manage Columns** enables adding, deleting and creating Study Manager columns (see **Managing Columns on page 120**).
- **Update Patient Details** changes or updates all the patient and procedure information even after a video is created (see **Updating Patient Details on page 54**).
- **Print Preview Regimen** opens a print preview layout of the Regimen for this procedure (see **Using the Regimen Manager to Prepare Regimens for Colon Procedures on page 25**).
- **Open Video Only** opens the procedure video without the findings. If findings are added during the video review, when trying to save you will be prompted to overwrite any existing findings file (see **Opening a Study on page 123**).
- **Export Table Information** saves the selected archive data to an Excel file displaying all the studies for that archive (see **Exporting Studies on page 124**).
- **Show all search results** displays the screen of results of the search performed (see **Search Options on page 119**).

For a detailed description on working with studies (see **Working with Studies on page 123**).
### Search Options

The search and filter options at the top of the Study Manager screen enable searching for a study in a selected archive, using the following search criteria:

- **Text**: Allows entering free text to search the study and findings data for a match.
- **Capsule Type**: Filter the search by selecting the type of capsule procedure from the drop-down list.
- **Procedure Date**: Filter the search by selecting the procedures performed in a specific time window (in the last days or weeks or even by a specific date) from the drop-down list.

After defining one or more search criteria, the Study Manager will search and display only relevant studies. The criteria that match the filters are highlighted in green.

When using the Text filter, right-click a study and select **Show all search results** to see where the text appears in the study.

If opening, deleting, or exporting the study, the finding will remain highlighted to allow for its selection.

### Status Bar

A status bar at the bottom of the screen shows the number of studies displayed, the number of studies selected, the amount of free space on the selected archive, and loading status of the studies.

### Action Buttons

The action buttons located on the bottom of the Study Manager screen enable several commands like opening a study, deleting studies, and exporting studies. To perform an action on a study, select the study by clicking the row containing the relevant study and click one of the following action buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>📎</td>
<td>Adds an archive to the Study Manager screen (see <em>Adding an Archive on page 117</em>).</td>
</tr>
<tr>
<td>🔄</td>
<td>Ejects a CD/DVD from CD drive and ejects any flash drive connected to USB. This will remove the archive from the Study Manager.</td>
</tr>
<tr>
<td>📺</td>
<td>Opens the video and findings of the selected study (see <em>Opening a Study on page 123</em>).</td>
</tr>
</tbody>
</table>
Managing Columns
By default, the Study Manager displays the following columns displaying information entered during the Check-in process:

- Last Name
- First Name
- ID
- Capsule Type
- Procedure Date
- Video Created
- Findings
- Report

These columns are mandatory and cannot be changed or removed. Additional columns can be added, based on the check-in information fields. It is also possible to create user-defined columns (User Column).
To add or remove columns:

1. Right-click anywhere in the area where the studies are displayed and select **Manage Columns**. The **Manage Columns** screen appears. On the right is the list of currently **Displayed Columns** in the Study Manager. The columns with a star icon ☀ next to them are fixed and cannot be removed or renamed. The left is a list of available columns to choose from.

2. To change the left to right order of the displayed columns in the **Study Manager** screen, select the column you wish to move in the window on the right and click ✉️ or 📋️.

3. Select any column names that are listed in **Available Columns** on the left side and click the right arrow ✈️ to display them in the **Study Manager** screen. They will be added to the end of the list in the window on the right. The position in the list can also be changed.

4. Select any columns that are listed in **Displayed Columns** and click the left arrow 🔄️ to remove them from the **Study Manager** screen.

5. To create a new column, click **Create**.

6. Type in the name of your new column and click **OK**. The new column will appear in the **Available Columns** list with a user column icon 📖 next to it.

7. To display this new column, select it and click the right arrow ✈️. It will appear at the bottom of the **Displayed Columns** list.

8. To change the name of your column, select it and click **Rename**.

9. To remove the column from the Study Manager, select it and click **Delete**.

10. In the Study Manager, the **User Column** will require manual input of the data. To enter data in your column, first select the relevant study. Click in the cell of the study in your column. Type in
your text in the separate window that opens. When you are done, click OK. In the example below, a user column named Reviewed By was created.

Defining Study Manager Settings
User-created columns in the Study Manager can be made available for use by other users by defining the Shared Data Directory.

To define the shared directory:
1. From the Home screen select Tools > Settings > Other tab.
2. In the Shared data directory field, type the location of the shared directory or click Browse to navigate to it. It is also possible to define a folder on the network.
3. After making the changes to the settings, click Apply to accept the new settings or click Cancel to close the Settings screen without accepting any changes. Clicking OK will accept the new settings and close the Settings screen.
Working with Studies

A PillCam Software study is the collection of files associated with a specific PillCam capsule endoscopy procedure. Studies include the video file downloaded from the PillCam recorder and all associated findings files (for more information on findings, see Working with Findings on page 163).

Studies use the *.gvi file extension and are saved in the default video directory which is defined in Tools > Settings > Video. The study folder name and video name incorporate the parameters entered during the check-in process, such as the patient name, patient ID, and procedure date.

For example: the PillCam Software folder with the name Doe F. John (12345) 21 Feb 2008, located in E:\Videos, contains the video file named Doe F. John (12345) 21 Feb 2008.gvi.

Opening a Study

You can open videos and other files in the study via the Study Manager.

You can open files in the following ways:

- **To open a study** (both the video and the findings): Either double-click a study in the study list, or select the study and then click the Open button at the bottom of the Study Manager screen. If more than one findings file is associated with the selected video, you will be prompted to select the related findings file you wish to open (for more information on working with findings, see Working with Findings on page 163). The video of the selected study opens.

- **To open a video only**: Right-click on the required study and select Open Video Only from the menu that appears. The video of the selected study opens.

- In the Home screen, select View Study > Open Video.

- In the Home screen, View Study > Recent Videos.

- While viewing a video, you can select Open Video from the File menu.

**Note**

In some cases, especially when working with network archives, you may not immediately see the updated Study file in the Study Manager, after making changes to the file. In this event, click the Refresh button in the top right corner of the Study Manager to make sure the most recent data is shown.

A detailed description of the main PillCam Desktop Software screen appears in Familiarizing Yourself with the PillCam Desktop Main Screen on page 129.
Exporting Studies

The Export function allows you to save a study or one of its files in a different place or under a different name. These options can be used when reorganizing the PillCam Software archives, to back up studies, to free space on the PillCam Software computer, and to copy studies for use on another computer or by another physician.

Studies can be exported using one of the following methods:

- Burning a study or a file to a CD/DVD
- Saving a study or a file to another archive, such as a USB storage device
- Saving a study or a file to a specific location
- Saving a study as Zip file

A description of each option follows.

Burning a Study to a CD/DVD

The Study Manager allows you to burn a study or specific files of a study to a disc, with the following restrictions:

- No multi session disc burning: once a disc is burned, you cannot add any other data to it.
- You can burn either the whole study (all the files in the folder) or a single file.

To save a study to a disc:

1. Insert a blank CD/DVD in the drive.
2. Open the Study Manager and select the study to export.
3. Click the Export button at the bottom of the Study Manager screen. The Export Study screen appears.
4. Select either Entire study or Specific files. If you select Specific files, you will be prompted to select the files.
5. Select the De-identify check box if you wish to remove all personal patient information. Take note that the size of the file is displayed below the check box.
6. Click Next. You are prompted to select the destination.

7. Select **Specific location** and click Next. The **Save** screen appears.

8. Browse to the CD/DVD drive on your computer and type in a volume name for your disc.

9. Click Save. A screen appears showing the progress of the study export. Upon completion, a message appears notifying that the file export was successful.

10. Click OK. PillCam Software will eject the CD or DVD when the burning operation is complete.

11. Write the volume name on the disc.

### Saving a Study to Another Archive

The Study Manager allows you to save a study to another archive, such as a USB storage device. When you connect a USB storage device to one of the USB ports of the computer, the Study Manager treats it as an archive and the icon appears on the left side of the screen.

**Note**

USB storage devices used for Raw Data Copy or for transport of PillCam Software videos should be labeled as such, stating that it may contain clinical data and should not be used for other purposes.

**To save a study to another archive:**

1. Select the relevant study and click **Export**. The **Export Study** screen appears.

2. Select either **Entire study** or **Specific files**. If you select **Specific files**, you will be prompted to select the files.

3. Select the **De-identify** check box if you wish to remove all personal patient information.

   Any reports created for this study will also be included in the file export, so make sure that sensitive data is already de-identified if needed (see **Generating a Report** on page 166).

   Take note that the size of the file is displayed below the check box.

4. Click **Next**. You are prompted to select the destination.
5. Select Another archive under Select destination and click Next.

6. In the Select Archive dialog box, click the relevant USB icon and click OK.

   A screen appears showing the progress of the study export. Upon completion, a message appears notifying that the file export was successful.

7. Click OK.

After saving data to the USB storage device is complete, you can remove the USB device. Follow the instructions below to correctly remove the USB device.

To safely remove a USB storage device:

1. Click the icon on the left side of the Study Manager screen to select the USB storage device.

2. Click Eject.

3. When the message that you can safely remove the hardware appears, unplug the USB storage device.

**Saving a Study as a Zip File**

Study Manager uses WinZip to zip the files. Zipping files includes all the files in a selected study.

To zip files:

1. Select the relevant study and click Export.

2. Select either Entire study or Specific files. If you select Specific files, a window opens prompting you to select the files for selection.

   If you wish to remove all personal patient information, select the De-identify check box. Any reports created for this study will also be included in the file export, so make sure that sensitive data is already de-identified if needed (see Generating a Report on page 166).

   Take note that the size of the file is displayed below the check box.

3. Click Next. You are prompted to select the destination.

4. Select Zip file under Select destination and click Next. The Save screen appears.

5. If you would like to save to a different location, click Browse and navigate to the required location. Click Save.

   A screen appears showing the progress of the study export. Upon completion, a message appears notifying that the file export was successful.

6. Click Close.
Deleting Studies

The delete function allows you to remove studies entirely or partially from archives.

To delete a study:

1. In the Study Manager, select the relevant study or, use the Control button on the keyboard to select multiple studies.

2. Click Delete. The Delete Study screen appears:
   - If you wish to delete the entire study, select the Delete entire study check box.
   - If you wish to delete specific files only, select the check boxes next to the files.

3. Click Delete.

Note
Deleting a study in the Study Manager deletes all data including procedure videos from the source directory. This action cannot be undone.

Working with Offline Studies

The Offline Studies screen displays information about studies stored on removable storage media, such as CDs, DVDs, and some USB storage devices, that have been connected to the computer during use of PillCam Software but are currently disconnected. This allows you to keep track of studies in archives which are currently not connected to the computer.

The Offline Studies list is updated when the removable storage media is disconnected or reconnected. When the storage media is reconnected, it appears in the left side of the Study Manager screen and the study no longer appears in the Offline Studies list.

Preexisting studies will appear in the Offline Studies list only after the storage media have been connected and then disconnected from the computer during use of PillCam Software.

The information in the Offline Studies list includes the Volume Name and Volume Type or kind of media. Volume names for CDs and DVDs are allocated at the time the disc is burned. For USB devices, a unique name (rather than the name designated by the manufacturer) must be allocated before use.

To save the Offline Studies list, use the Backup/Restore feature for Offline Studies (see Backup/Restore Offline Studies on page 107).

Note
In order to easily locate a study, it is recommended to clearly mark the disc or other media with its volume name when exporting studies (see Exporting Studies on page 124).

To access an offline study:

1. In the Study Manager, click the Offline Studies button.
2. Find the study in the **Offline Studies** list.

3. Locate the volume listed and connect it to the computer.

**Note**

DO NOT remove the USB storage device until after any actions performed with it are completed.
Familiarizing Yourself with the PillCam Desktop Main Screen

The main screen is divided into different sections to allow optimum viewing of the PillCam Software video and provide easy access to the various commands that are available when viewing a video. Commands are organized in logical groups, which are collected together under the View and Report tabs.

This section includes a description of the main screen and describes how to use the commands and features.
Ribbon Tab

The Ribbon Tab provides access to the controls you need for viewing, annotating, and creating reports. Each tab includes groups that show related items together.

View Screen

The View screen, accessed by the View tab, allows viewing PillCam Software videos, marking and annotating thumbnails of interest, and adding comments to the study.

In the View screen, you can perform the following actions while reviewing the patient study:

- Review the patient procedure video.
- Use viewing layouts and image adjustment features to enhance or to focus on the video image.
- Annotate thumbnails for later viewing and commenting.
- Designate thumbnails as anatomical landmarks in the GI tract.
- Use the GI Map feature to show the location of the capsule in the GI tract and display the gastric passage times.

The View ribbon is divided into the following groups which include different functions:

- Review
- Viewing Layouts
- Image Adjustment
- Show
Review Group

The Review group allows using different viewing modes to view the video. The following options are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Standard Review mode" /></td>
<td><strong>Standard Review mode</strong>: This button sets the standard review mode for PillCam capsule procedure videos. Display rate can be set by the user by moving the viewing speed slider.</td>
</tr>
<tr>
<td><img src="image" alt="A-mode Review mode" /></td>
<td><strong>A-mode Review mode</strong>: This button sets the review mode to show the A-mode (Automatic) video created for all PillCam SB 2 as well as for all PillCam SB 3 with PillCam recorder DR2 procedure videos.</td>
</tr>
<tr>
<td><img src="image" alt="M-mode Review mode" /></td>
<td><strong>M-mode Review mode</strong>: This button sets the review mode to show the M-mode (Manual) video created sequentially from all captured images for PillCam SB 2 as well as for all PillCam SB 3 with PillCam recorder DR2 procedure videos if creation of M-mode video is enabled in Settings. By default, creation of manual mode video is disabled during download. To enable manual mode, see <a href="#">Defining Video Creation Settings</a> on page 41.</td>
</tr>
<tr>
<td><img src="image" alt="Collage view" /></td>
<td><strong>Collage view for PillCam COLON 2/Crohn’s procedures only</strong>: In the Collage view, relevant parts from selected images of interest are cropped and arranged in a matrix to provide an overview of the most interesting image elements from the study video. Use the navigation buttons or the scroll wheel on the mouse to view the next matrix. Click an image to select that image and view the enlarged image on the left. A white border appears around the selected image. Collage view must be enabled by selecting <a href="#">Enable Collage Viewing</a> under <a href="#">Tools &gt; Settings</a>. Collage view is not intended for diagnostic review and should not be used as a substitute for reviewing the video in one of the other viewing layouts.</td>
</tr>
<tr>
<td><img src="image" alt="SBI mode" /></td>
<td><strong>SBI mode</strong>: Sets the Suspected Blood Indicator (SBI) previewing mode to show marked images suspected of containing blood for fast review in sequence. SBI image locations are marked on the color bar (see <a href="#">SBI View on page 150</a>). This option is only available for SB2 studies.</td>
</tr>
</tbody>
</table>
Familiarizing Yourself with the PillCam Desktop Main Screen

Viewing Layout Group
This group includes tools for customizing the video display from one video head: Single, Dual, Quad, and Mosaic view. The tools maximize reading efficiency by simultaneously displaying consecutive images in one easily viewed image.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>QuickView mode:</td>
<td>Sets the QuickView (QV) previewing mode to show only significant images that may be of interest in the video stream to provide fast previewing and landmarking of a video. The number of images to be considered images of interest can be set as a percentage of the video, by clicking the icon. This allows fast previewing and landmarking of a small bowel video. PillCam Software scans all images and scores them according to the possible level of significance. Then, according to the percentage level defined, it displays a short video to provide an overview of the case prior to full review (see QuickView on page 147). The QuickView feature is not intended to detect pathology in lieu of a physician and should not be used as a substitute for reviewing the entire video.</td>
</tr>
<tr>
<td>Complementary QuickView mode:</td>
<td>Available under the QV option. Sets the Complementary QuickView previewing mode to show the complementary part of the video (that is, everything that was not included in QuickView) (see Viewing a Video with Complementary QuickView on page 148). Only a review of both QuickView and Complementary QuickView is equivalent to a full video read. The Complementary QuickView feature is not intended to detect pathology in lieu of a physician and should not be used as a substitute for reviewing the entire video. Review of both QuickView and Complementary QuickView is required for full video review.</td>
</tr>
<tr>
<td>Top 100:</td>
<td>Provides a preview of the one hundred images that most likely include an ulcer, bleeding, or a polyp. The drop-down option allows viewing these images as a video. See Viewing the Top 100 Images on page 151. The Top 100 feature is not intended to detect pathology in lieu of a physician and should not be used as a substitute for reviewing the entire video.</td>
</tr>
<tr>
<td>Note</td>
<td>Dual and Quad views are available only when viewing the video from one video head (that is, from one end of the capsule).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single view:</td>
<td>Shows the video in Single view, one single frame on the screen.</td>
</tr>
</tbody>
</table>
This group allows using preset or custom controls to adjust the displayed video image. This includes controls for adjusting sharpness, brightness, color, and FICE or Blue-processed image. This option is available when the Enable FICE Viewing option is enabled under Tools > Settings.

This group includes the following options:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Turns Image Adjustment off.</td>
</tr>
<tr>
<td>Adjust</td>
<td>Opens the Image Adjustment dialog box, described below.</td>
</tr>
</tbody>
</table>

Image Adjustment tools provide an alternative image view via a single click, using proprietary technology with enhanced sharpness and contrast. Sharpness, Color, and Brightness controls enable customizing of the image to user preferences. When clicking the Adjust button the following screen appears:
The following options are available:

- **Off**: Resets the image adjustment parameters
- **FICE**: FICE 1, FICE 2, or FICE 3. FICE viewing tool aids the reader in observing tissue surface characteristics and vascularity and by visually enhancing suspected structures.
  
  All FICE settings are available when viewing SB videos; only FICE 1 is available when reviewing a COLON 2/Crohn’s video.
- **Blue**: Blue mode provides another view of the mucosa that may assist in the interpretation process by rendering a bluish image to enhance contrast.

**Note**
The image adjustment tools have not been cleared by FDA for polyp diagnosis purposes.

### Show Group
This ribbon group allows displaying or hiding the following video viewing features:

- **Thumbnails**: For more information on using thumbnails, see [Working with Thumbnails](#) on page 152.
- **GI Map**: For more information on the GI Map, see [GI Map](#) on page 160.
- **Comments Editor**: For more information on the Comments Editor, see [Comments Editor](#) on page 154.
- **Dynamic Player Control**: For more information on the Dynamic Player Control, see [Using Dynamic Player Control](#) on page 148.
- **Full Screen**: Shows the video in full screen on the computer screen, without any of the other elements of the View screen, including the ribbons. To return to normal view, press ESC. Pressing F11 on the keyboard has the same functionality.
Compare Group

The Compare Group is available when viewing Crohn’s Videos and includes the following options:

- **Compare Tables**: Allows comparing GI Tables for the current and prior study.
- **Compare Findings**: Allows comparing thumbnails for the current and prior study.
- **Prior Video**: Allows viewing the prior study video. An icon appears in orange in the ribbon tab, which allows closing the prior video.

Report Screen

The **Report** ribbon is divided into several groups enabling many different functions. The buttons and commands are organized in the following logical groups:

- Configure
- Report
- Thumbnails
- Image Data
- Clinical Tools

This section includes a description of the report options.

Configure Group

The **Configure** group includes options that allow:

- Selecting templates for report generation.
- Excluding any patient information from the report. To do this, select the **De-Identify** option.

  **Note**

  Any disclosure of images taken by the PillCam Capsule Endoscopy System without the patient’s consent might violate the patient's privacy rights. To export findings without patient information, click the **De-Identify** check box in the ribbon.

- Signing a report electronically. For more information on the **Electronically Sign Reports** option, see **Signing Reports Electronically** on page 167.
- Defining how thumbnails will be displayed in the report. See **Configure Dialog Box** on page 136.
Selecting a Report Template

The template drop-down list shows templates, per capsule type, that can be selected before generating a report. The templates differ from each other in the inclusion or exclusion of the SB Progress Indicator associated with each thumbnail (for PillCam SB videos) and the size of thumbnails displayed in the final report.

Configure Dialog Box

Allows defining thumbnail settings. When using the FICE or Blue Mode options when viewing thumbnails, you can include a “normal” thumbnail image alongside the FICE/Blue thumbnail when creating a report.

To include a normal image alongside the FICE or Blue thumbnail in the Report:

1. From the Report screen, click the dialog box launcher ( ) of the Configure ribbon group. The following screen appears:

2. Select the Include normal image alongside FICE or Blue thumbnail checkbox and click OK. When you generate a report, you will see both images, as in the example that follows.
**Thumbnails Group**

This group includes the following options for viewing thumbnails:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thumbnails View</td>
<td>Displays an enlarged view of captured thumbnails.</td>
</tr>
<tr>
<td>Select All</td>
<td>Select all thumbnails for inclusion in the capsule endoscopy report or when saving clips and images.</td>
</tr>
<tr>
<td>Unselect All</td>
<td>Unselect all thumbnails to exclude them from the capsule endoscopy report or when saving clips and images.</td>
</tr>
<tr>
<td>Delete Thumbnail</td>
<td>Deletes the currently viewed thumbnail.</td>
</tr>
</tbody>
</table>

**Note**

This group is not available when creating reports for PillCam Crohn’s videos.

**Thumbnails View**

For easier viewing of captured thumbnails, PillCam Software includes a screen that displays an enlarged view of the thumbnails. You can use this screen to review and select thumbnails for inclusion in the report.

**To view a screen with magnified thumbnails:**

1. In the **Report** tab, select the **Thumbnails View** button.

![Thumbnails View Screen](image)

An enlarged view of the thumbnails appears. Thumbnails that were selected in the regular view are also selected in this view. You can select or unselect thumbnails as required.

2. To return to the previous screen, click the **Thumbnails View** button again or click the **X** button in the upper right corner of the screen.
Report Group

Below is a description of the Report button group buttons and the commands that can be performed for managing the capsule endoscopy reports:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Preview" /></td>
<td>Preview the capsule endoscopy report before printing. Clicking this button opens a print preview page of the report. The buttons on top of the print preview screen also enable to print, save, save as, or email the report as an attachment.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Select the printer, number of copies, page range, and other printing options before printing. A version of the report is also saved after printing.</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Save the report with a date and time stamp in the current location with the current file name.</td>
</tr>
<tr>
<td><img src="image" alt="Email" /></td>
<td>Send a copy of the capsule endoscopy report in an email message as an attachment, using your default email program.</td>
</tr>
</tbody>
</table>

The Export button drops down to display the following export options:

- Export the **Results** of the capsule endoscopy to a folder in a directory defined in Settings, for use by a hospital information system. This folder can contain thumbnail images and markings, video clips, PDF report, and an XML file containing the report data, including the path to these files. This option enables hospital administrators to later import the files with related attachments from this predefined directory. To enable this data sharing, the structure of the input and output of the files must be defined for PillCam Software. Consult the PillCam Desktop IT Guide for more information.

- Export a **Patient Summary** of the capsule endoscopy to a folder in a directory defined in Settings. This folder can contain thumbnail images, PDF report, and video clips that can be played in Windows Media Player. This option enables the patient to keep the procedure data archived or to use as the summary for a physician referral.
The **Image Data ribbon group** includes advanced tools for working with images, video clips and segments. Short video segments can be created and combined from different points in the procedure video. Images can be saved in JPEG format for viewing later. Additionally, video clips centered on selected images can be generated for the patient to be viewed in Windows Media Player.

- **Save Clips/Images**: Create an image from a thumbnail or a video clip from a selection of thumbnails. Click the **Save Clips/Images** button and select from the different options in the drop-down list, and then choose the directory to save the file(s):
  - **Images Only**: Creates (a) jpeg(s) of the selected thumbnail(s) and saves to a folder.
  - **Clips Only**: Creates mpeg video clip(s) surrounding the selected thumbnail, created from 50 before and 50 after the selected thumbnail. Video clips can be viewed in Windows Media Player. The number of images used in creating a video clip from a selected thumbnail is determined in Image Data settings. Click the dialog launcher on the bottom right of the **Image Data** button group.
Familiarizing Yourself with the PillCam Desktop Main Screen

This will launch the Image Data screen.

The default length of clips is 100 images. Change and select the number of desired images for each thumbnail (50, 100 or 150) and click OK. If upgrading from RAPID v7 or earlier versions, the setting was 200 images for each thumbnail then need to redefine it in this screen.

- **Clips and Images:** Creates jpeg(s) as well as mpeg clip(s) of the selected thumbnail. Using this feature will create a jpeg image of each selected thumbnail and a video clip surrounding the selected thumbnail. The number of images used in creating a video clip from a selected thumbnail is determined in Image Data settings described previously. The images and clips are saved to a selected directory.

- **Create Video Clip:** Creates a video clip from the first selected thumbnail to the last selected thumbnail. This feature is enabled only if at least two thumbnails are selected. Video clips can be viewed in Windows Media Player.

- **Save Video Segment:** Creates a short video segment from the first thumbnail to the last thumbnail selected. The video can only be viewed with PillCam Software. The segment is saved in a folder with a copy of the findings file. This feature is enabled only if at least two thumbnails are selected.

- **Save Joined Segments:** Joins video segments created from selected thumbnails. The video can only be viewed with PillCam Software. The segment is saved in a folder with a copy of the findings file.

**Note**

To export video clips and images without patient information, click the De-Identify check box in the ribbon.

**Clinical Tools Group**

The Clinical Tools button group provides access the two diagnostic tools, the **PillCam Software Atlas** and the **Lewis Score** that are available in PillCam Software.

**PillCam Software Atlas**

from case studies. Reference images are searchable by Capsule Endoscopy Structured Terminology (CEST), by Diagnosis or by Lewis Score terms.

You can access the PillCam Desktop Atlas in the following ways:

- **Home screen**: Click Tools > Atlas.
- **View screen**: Right-click any thumbnail or video image and select Open Atlas.
- **Report screen**: Click the Atlas button on the Report ribbon.
- **Edit Thumbnail dialog box**: Click the Open Atlas button in the Edit Thumbnail dialog box.

**Note**
You can activate the Atlas regardless of whether or not a video is open. If there is no video open, the space for the Current Image in the top left corner is left blank.
If there are more than six images available in the Atlas under a certain category, a scroll bar appears at the bottom of the screen to allow you to scroll to the rest of the images.

Note
The Atlas by no means replaces careful diagnosis from a trained physician.

Comparing Video Images to Atlas Images

To compare an image from the current video (Current image) with any of the images from the Atlas, select CEST, Diagnosis or Lewis Score tabs to display images in that category.

Select from the images that appear on the right side of the screen by clicking on the image. A comparison screen with the current image and the Atlas provided image appears.

Both images appear enlarged, side by side. The Current Image on the left and the image from the Atlas on the right, including all the comments, case history and any additional available information on the Atlas image. If there is more text than available space on the screen, a scroll bar appears next to the text.
Atlas Image Export

You can export images from the Atlas to your computer as follows:


2. Browse to the location to which you want to save the image. If necessary, you can rename the image. Click OK to save the image.

Lewis Score

The Lewis Score is an aid to diagnosis that provides an approximate measure of degree and extent of mucosal damage based on direct visual imaging of the small intestine not provided by current methodologies. The index is based on quantitative and qualitative descriptors relating to three endoscopic variables: villous edema, ulceration, and stenosis. Combined with other clinical parameters (symptoms, patient and family history, previous diagnostic tests, lab values), the score could provide a threshold for differential diagnosis and be used to monitor the progress of treatment.

- An automated scoring system provides greater standardization of disease activity assessment.
- Provides an additional point of evaluation to assist in determining appropriate patient management.
- The Lewis Score facilitates communication and standardization for assessing disease states before, during, and after treatment.
- Monitoring therapy effectiveness with a standardized score has clinical value.

When clicking the Lewis Score button, a scoring index is displayed and the currently selected thumbnail is shown on the right side.
The tool is used for calculating the Lewis Score and is enabled only when all of the following conditions are met:

- The video is a PillCam SB/PillCam Crohn’s video.
- Thumbnail images of the small bowel have been created.
- The first duodenal and first cecal images are marked as landmarks.

**To use the Lewis score:**

1. Click **Lewis Score** in the Report ribbon. The Lewis Score screen appears:
   - The current thumbnail is visible at the right side of the screen.
   - The Lewis score (which appears at the top of the screen) and the panel entitled **Stenosis** (next to the thumbnail), relate to the entire small bowel.
   - The left of the screen is divided into three tabs, relating to video tertiles. A tertile is one third of the small bowel as calculated by the transit time of the PillCam capsule in the small bowel. The **1st SB Tertile** is the proximal third, the **2nd SB Tertile** is the middle third, and the **3rd SB Tertile** is the distal third of the small bowel.

2. Select the tertile you are referring to by clicking the appropriate tab. The selected tertile on the color bar and the thumbnails selected within it are in color, whereas the rest of the color bar and thumbnails are darkened.

3. Under **Villi**, select the:
   - Degree of **Appearance**
   - Length of segment for **Longitudinal extent**
   - Correct **Distribution**

4. Under **Ulcers**, select the:
   - Appropriate **Number**
   - Length of segment for **Longitudinal extent**
   - Correct range for **Circumferential extent**

5. Select the next tertile and repeat.

6. Under **Stenosis**, select:
   - The appropriate **Number**
   - **Yes** or **No** for **Ulcerations**
   - **Yes** or **No** for **Traversed**

The Lewis Score at the top of the screen updates automatically.
### Lewis Score Glossary:

<table>
<thead>
<tr>
<th>Term</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appearance (of villi)</td>
<td>Edema where width of villi is equal or greater than height of villi. Evaluated villi in mucosa distinct and separated from an ulcer rather than contiguous to a mucosal break.</td>
</tr>
<tr>
<td>Circumferential Extent</td>
<td>Portion of the entire image involved by the lesion, based on the entire lesion including its collar. This value is entered for the largest ulcer in the tertile.</td>
</tr>
<tr>
<td>Few (ulcers)</td>
<td>2-7 lesions.</td>
</tr>
<tr>
<td>Lewis Score</td>
<td>A capsule endoscopy scoring index for small intestinal mucosal disease activity (<a href="https://doi.org/10.1111/j.1365-2044.2006.04004.x">Aliment Pharmacol Ther 27, 146-154</a>).</td>
</tr>
<tr>
<td>Long segment</td>
<td>Equal to 11-50% of a tertile.</td>
</tr>
<tr>
<td>Multiple (ulcers)</td>
<td>8 or more lesions.</td>
</tr>
<tr>
<td>Short segment</td>
<td>Less than or equal to 10% of a tertile.</td>
</tr>
<tr>
<td>Tertile</td>
<td>One third of small bowel as calculated by the transit time of the PillCam capsule in the small bowel.</td>
</tr>
<tr>
<td>Whole segment</td>
<td>Greater than 50% of a tertile.</td>
</tr>
<tr>
<td>Ulceration</td>
<td>Mucosal break with white or yellow base surrounded by a red or pink collar.</td>
</tr>
</tbody>
</table>

### Keyboard Shortcuts

The shortcuts listed below allow you to easily access frequently used PillCam Desktop options and features.

<table>
<thead>
<tr>
<th>Key</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>Play/Pause Video</td>
</tr>
<tr>
<td>Left arrow</td>
<td>Go to next image</td>
</tr>
<tr>
<td>Right arrow</td>
<td>Go to previous image</td>
</tr>
<tr>
<td>Page-Down</td>
<td>Go 10 images forward</td>
</tr>
<tr>
<td>Page-Up</td>
<td>Go 10 images backwards</td>
</tr>
<tr>
<td>Home</td>
<td>Go to first image</td>
</tr>
<tr>
<td>End</td>
<td>Go to last image</td>
</tr>
<tr>
<td>Enter</td>
<td>Capture Thumbnail</td>
</tr>
<tr>
<td>Control + S</td>
<td>Save Findings</td>
</tr>
<tr>
<td>Control + O</td>
<td>Open Findings</td>
</tr>
<tr>
<td>Key</td>
<td>Operation</td>
</tr>
<tr>
<td>-----</td>
<td>-----------</td>
</tr>
<tr>
<td>Control + P</td>
<td>Report Print</td>
</tr>
<tr>
<td>Enter</td>
<td>Capture Thumbnail (in single frame view)</td>
</tr>
<tr>
<td>Control +S</td>
<td>Save Findings (if filename is known) or Save Findings As (if filename not known)</td>
</tr>
<tr>
<td>F11</td>
<td>Toggle full screen mode</td>
</tr>
<tr>
<td>Control +R Shift</td>
<td>Align text to the right</td>
</tr>
<tr>
<td>Control +L Shift</td>
<td>Align text to the left</td>
</tr>
<tr>
<td>ESC</td>
<td>Closes the current dialog box</td>
</tr>
<tr>
<td>Tab / Shift + Tab keys</td>
<td>Navigate to next/previous field</td>
</tr>
</tbody>
</table>
Viewing Videos

Before loading a PillCam Software Capsule Endoscopy video, it is important to review the patient history prior to reading the video in order to:

- Consider all possible indications as per the patient history.
- Prepare for identification of relevant pathology as per the possible indications identified.

To read PillCam studies efficiently, the reading process is divided into three main stages:

- **Preview:** During this phase you should scan the capsule endoscopy video using QuickView mode to establish a preliminary interpretation. This can be followed by a Complementary QuickView scan to perform a complete review of the video. You may also augment your preview by previewing in SBI mode (SB2 studies) to quickly scan the bleeding-suspicious images.
- **Review:** Review the complete capsule endoscopy video in normal viewing mode.
- **Report:** Complete a Patient Report that summarized the interpretation of the study. Refer to Creating a PillCam Capsule Endoscopy Report on page 165.

QuickView

Use the QuickView feature to perform a fast preview of the video. QuickView makes PillCam Desktop video review more efficient by displaying only images that may be of interest in the video stream to provide fast previewing and land marking of a small bowel video. The number of images to be considered images of interest can be set as percentage of the video by the user. The PillCam Desktop scans all images and scores them according to the possible level of significance. Then according to the percentage level set by the user it displays a short video to provide an overview of the case prior to full review. The recommended viewing speed is 7-10 frames per second using Single View layout.

Scan the entire video in QuickView mode to:

- Establish approximate landmarks for the first gastric, first duodenal, and first cecal images.
- Capture thumbnails of images of interest.
- QuickView may be used to review gastric and colon images.

Note

The QuickView feature is not intended to detect pathology in lieu of a physician and should not be used as a substitute for reviewing the entire video.

- The absence of a particular frame from the QuickView display should not be interpreted to mean that no abnormal finding is present in that frame.
- SBI images are also included in the QuickView.
- The QuickView by no means replaces a thorough viewing of the entire video by a qualified physician.
- Using the mouse scroll wheel in this mode also displays each frame of this mode one by one.

- In the QuickView mode, the video navigation buttons change to the following:
- The user can determine the number of images of the PillCam Desktop video to be viewed in the QuickView mode, by changing the percentage rate of images to be shown and hence the sampling rate, which is by default 10%.
To change the QuickView sampling rate:

1. From the View screen, click the dialog box launcher ( ) of the Preview ribbon group. The QuickView Settings screen appears.

2. Type in the desired sampling rate (between 2% and 80%) for the QuickView and click OK to save it.

Note
When viewing a video in Complementary QuickView (CQV) mode, you cannot change the QuickView sampling rate.

Viewing a Video with Complementary QuickView

After viewing the video in QuickView mode, click the Complementary QuickView (CQV) button to view the rest of the video not shown in QuickView mode. In CQV mode, PillCam Desktop displays only the images that are not included in the QuickView mode. Playing a video from start to end in QV mode and then in CQV mode results in viewing all video images.

Using Dynamic Player Control

The Dynamic Player Control allows you to control the speed at which you view the video, using your computer mouse.

Use the controls as follows:

- Click anywhere in the rectangle around the backward or forward arrow to play the video in the required direction. Click again to stop the video.

- While the video is playing, move your mouse cursor UP and DOWN to control the speed at which the video plays. When you stop the video, a number appears showing the rate at which you are viewing the frames.
- The Dynamic Player Control includes a Turbo Mode function which allows speeding up viewing a segment of the video. To view the video in Turbo Mode, while the video is playing, click and hold the mouse button. The playing speed accelerates and the rectangle changes to orange.

- The orientation indicator appears briefly above the backward/forward arrows to show the viewing direction when you switch between the backward or forward arrows.

- The orientation indicator appears above the backward/forward arrows when you pause viewing, and shows your current viewing location. Use the mouse wheel to scroll backward/forward in the video. Click the gray location indicator to go back to the previous location, and continue viewing from that point.

- The Area of rapid change alert is available in PillCam COLON 2/PillCam Crohn’s videos only. The Approaching area of rapid change notification appears when you approach a segment of the video where the capsule travels at a higher speed. This notification is followed by the Area of rapid change alert. When this alert appears, you can use the Dynamic Player Controls to adjust viewing speed.

This option is available when the Enable Reviewer Alert option is enabled under Tools > Settings.

Note
The Reviewer Alert functionality is only available for PillCam COLON 2/Crohn’s videos compiled with RAPID v8.3 and above.

**Dual Head View**

PillCam COLON, UGI and Crohn’s capsules have two video heads and by default, two images are displayed: one for each head of the capsule. Note that two images displayed thus side-by-side is not DualView: the two side-by-side images are from different video heads.

The capsule icon as shown below is both the control and the indicator for the dual head video display mode. The icon consists of three buttons: left (green if active), right (yellow if active) and the middle (activates both displays green and yellow).

<table>
<thead>
<tr>
<th>Capsule Icon</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Default view for PillCam COLON, Crohn’s and UGI videos: images of both heads are displayed. Click either the far left side or the far right of the icon to view one single video.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>View only the images from one head. Click the other side to view the video from the other head. Click the middle of the icon to return to viewing both videos.</td>
</tr>
</tbody>
</table>
When typing thumbnail comments in PillCam UGI and PillCam COLON/Crohn’s videos, the comments appear green for thumbnails captured from the left represented capsule video head and yellow for thumbnails captured from the right represented capsule video head.

**SBI View**

![Note](Image)

This option is only available for SB2 studies.

The Suspected Blood Indicator (SBI) feature automatically marks images suspected of containing blood and provides the ability to review them in sequence. SBI image locations are marked on the Color Bar.

In the SBI mode, PillCam Software shows the SBI marked images. The video control buttons turn red and you can play the SBI-images-only back and forth by the controls. SBI images are also included in the QuickView.

This viewing mode feature is available only:

- After the first landmark is entered for the first duodenal image or any later landmark.
- If suspected images are found.
- The PillCam Software video is a PillCam SB video.

The Suspected Blood Indicator (SBI) feature is a guide to areas of suspected fresh GI bleeding. The SBI display feature becomes available only from the first duodenal image on. Hence the SBI feature is available only after labeling the first image of the Duodenum.

When SBI is activated, red ticks appear above the time bar and they indicate the location of SBI images.

![Color Bar](Image)

SBI lines are not displayed in the area before the first duodenal image, which becomes gray.

**To display the SBI images:**

1. Identify and label the first image of the duodenum (see Using Localization and Landmarks on page 159).

2. Click ![SBI](Image). The video navigation buttons turn red.

3. Use the video navigation buttons to view the SBI images.
Viewing the Top 100 Images

Provides a preview of the one hundred images that most likely include an ulcer, bleeding, or a polyp. The drop-down option allows viewing these images as a video.

**Note**
The Top 100 feature is not intended to detect pathology in lieu of a physician and should not be used as a substitute for reviewing the entire video.

**Note**
- This option is only available for videos compiled using PillCam Software v9.0.
- For PillCam SB3/PillCam Crohn's videos, the first duodenal landmark must be defined in order to view the Top 100 images.
- The SBI feature is available for PillCam SB2 capsules only.

To view the Top 100 images:

1. Open a video and select the View tab.
2. Click the Top 100 button.
3. In the screen that appears, you can:
   - Select an image to see an enlarged view. Use the scroll wheel on the mouse to scroll through the video, while still displaying the Top 100 images.
   - Click the arrow in the bottom right corner of the screen to scroll between the Top 100 images.
   - From the Top 100 drop-down list, select the Top 100 Video option to view the top 100 images as a video.
**Time Bar/Color Bar**

The Time bar/Color bar displays the total length of the video and the average color of the selected images for easy anatomical segmentation of the corresponding image. The unit of time is hours, minutes, and seconds. Take note of the following:

- The slider moves along the time bar as the video is played. You can also use the slider to move the video forwards or backwards.

- Moving your mouse over the time bar displays the time at the position of the cursor. If the mouse stays at a location on the time bar for longer (about 2 seconds), the image at that location is displayed in a small window, with the time indication of that image at the top.

- You can move the video display to a certain location by clicking that location on the color bar.

- Small red ticks appear in the top part of the Time bar/Color bar indicating the Top 100 images.

- GI regions are colored in a narrow strip below the Color Bar according to defined Landmarks. The regions have specific colors.

<table>
<thead>
<tr>
<th>Color</th>
<th>Region of GI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>Esophagus</td>
</tr>
<tr>
<td>Turquoise</td>
<td>Stomach</td>
</tr>
<tr>
<td>Orange</td>
<td>Small intestine</td>
</tr>
<tr>
<td>Green</td>
<td>Colon (large intestine)</td>
</tr>
</tbody>
</table>

- Lines in region-specific colors connect the location on the time bar and the thumbnails.

- Bookmarks show the last three images viewed.

- Before defining the landmarks, the narrow strip below the Color Bar is gray.

**Time Indication**

The time indication box displays the time of the frame in hours, minutes, and seconds after the capsule starts acquiring images in the procedure.

**Working with Thumbnails**

Thumbnails are images captured from the video. Some images are created automatically, such as those that are marked during real-time viewing with the PillCam recorder DR3. These thumbnails have the default annotation of **Thumbnail marked in recorder**.

While reviewing the video, you can capture any image of interest for further scrutiny. The images appear at the bottom of the screen in the **Thumbnail** section.

---

**Note**

The thumbnails and associated comments are saved in the Findings file (see **Working with Findings** on page 163).
To create a thumbnail:

- Double-click the current video image or click the right-mouse button and select **Capture Thumbnail**.

To view a thumbnail in the video display:

- Click the thumbnail in the **Thumbnail** section at the bottom of the screen. PillCam Software automatically displays the associated image on the screen, and the cursor in the Time Bar jumps to the thumbnail location in the video. The thumbnail in the thumbnail section will be highlighted with a blue filled outline.

To view the adjacent images:

- In the **View** screen, use the and buttons to view the adjacent images, or roll the mouse wheel forward or backward.

To scroll through the thumbnails:

If there are more thumbnails than fit on the screen, use the scrollbar below the thumbnails to scroll through the thumbnails.

Thumbnails can also be annotated, saved, exported as images, deleted or selected for inclusion in the capsule endoscopy report.

**Thumbnail Status**

The thumbnails are displayed at the bottom of the **View** screen. The thumbnail appearance changes to designate different statuses, as described below.

<table>
<thead>
<tr>
<th>Thumbnail</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Thumbnail" /></td>
<td>This is a thumbnail without any visual effects. When you move the pointer over the thumbnail, the background changes to gray and two checkboxes appear: the one on the left allows selecting the thumbnail for the report, while the one on the right allows editing the thumbnail.</td>
</tr>
</tbody>
</table>

Use the Scroll bar to scroll through the thumbnails.
154 Viewing Videos

Thumbnail Comments

Use one of the following methods to add a comment to a thumbnail:

- Click the Comments Editor check box in the ribbon of the View screen to display the Comments Editor.
- Right-click a thumbnail in the View or Report screen and select Edit Thumbnail. The Edit Thumbnail dialog box appears.
- Use your mouse pointer to hover over a thumbnail in the Thumbnail section, and click in the top right corner of the thumbnail. The Edit Thumbnail dialog box appears.

Note

If necessary, press the ALT and SHIFT keys simultaneously to toggle between left-to-right and right-to-left writing, as supported by Windows.

Comments Editor

The Comments Editor on the left side of the screen allows you to type comments about a specific thumbnail or about the entire study. When typing comments in the Comments Editor the following tools are available:

- **GI Dictionary**: Allows selecting terms and phrases from a pre-populated and customizable database of terms and phrases. PillCam Software preserves the GI Dictionary customizations from previous versions during software upgrade.

To use the GI Dictionary:

- Type a part of a word in the text box. The dictionary will show the closest approximations of words starting with the same letters. Double-click a word to use it in the comment.
- To add a new word to the dictionary, type the word in the text box and click .
• Click the button to view and edit the GI Dictionary. The **Edit GI Dictionary** dialog box appears.

![Edit GI Dictionary dialog box]

• **Spell checker:** When the spell checker is activated, a wavy red line appears below any word not recognized by PillCam Software. To select one of the suggested corrections, right-click and select the new word.

**Note**

If you write more than 256 characters in the text box of a thumbnail comment, the final printout of the thumbnail comment may be split between two pages. Any thumbnail after that will start on a new page, leaving the space after the split comment blank.

**To enable or disable the GI Dictionary or the Spell Checker:**

1. From the Home screen, select **Tools > Settings**.

2. On the **General** tab, under the **Regional Settings**, select the check box next to the feature.

3. After making the changes to the settings, click **Apply** to accept the new settings or click **Cancel** to close the Settings screen without accepting any changes. Clicking **OK** will accept the new settings and close the Settings screen.
Edit Thumbnail

The Edit Thumbnail dialog box appears when you right-click a thumbnail in the View or Report screen, or when you click the Edit Thumbnail button in the top right corner of a thumbnail.

You can perform the following actions in the Edit Thumbnail dialog box:

- Enter a thumbnail comment. If necessary, you can use the GI Dictionary.
- Open the Atlas to compare images.
- Click the check box in the top left corner to add the thumbnail to the report. Any comments entered for the thumbnail will appear below it in the report.
- Use the Marking Tools to point out or emphasize certain areas of interest. For a detailed description of these options, see Marking Tools on page 156.
- Delete the thumbnail.

In PillCam Crohn’s videos, the following additional options are available:

- **Segment:** Allows you to select which segment the thumbnail appears in.
- **Severity Level:** Allows you to define the severity level and presence of a stricture.

Marking Tools

You can add marks to a thumbnail to point out or emphasize certain areas of interest.

**Note**

Marks on a thumbnail are saved together with the thumbnail and appear as such in the report and on the thumbnail itself.

The marking tools are available when viewing thumbnails in the View and Report screens.

Mark Circle

Creates a circle around an area of interest:

1. Click 🔄.
2. Place cursor over area of interest.
3. Click and drag without releasing to create a larger circle to include area of interest.
Mark Arrow

Creates an arrow pointing to an area of interest:

1. Click .
2. Place cursor to the side of the area of interest.
3. Click and drag without releasing toward area of interest. The arrow points to region of interest.

Undo Mark

Clears the last mark created:

• Click repeatedly to successively clear all marks.

Circumference Scale

For UGI procedures only: PillCam Software provides an optional circumference scale for estimating the circumferential involvement of esophageal varices. The circumference scale displays 12 equivalent ticks on the image periphery.

1. Click .

2. Point the cursor and click anywhere on the circle to rotate the scale to facilitate estimation of the circumferential involvement of a finding.

3. You can rotate the grid as follows:
   a. Move the cursor over the periphery of the image.
   b. Click and drag the scale around to match it to the varices you want to measure.
Polyp Size Estimation

For PillCam COLON 2/PillCam Crohn’s procedures only: This tool allows estimating the size of a suspected polyp.

1. Click .
2. Place the cursor at one end of the polyp.
3. Click and drag (without releasing) to create a double pointed arrow from one end to the other end of the polyp for which you wish to estimate the size.
4. The size estimate appears at the end where you release the mouse button. If you make more than one size estimate for the same image, the estimates are counted: #1, #2, etc.
5. To remove a marking, click the Undo Mark button . The last marking disappears. Click repeatedly to successively clear all marks.

Note
The Polyp Size Estimation measurement is only an estimate. Use discretion when making diagnostic or treatment decisions.

Ulcer Size Estimation

For PillCam Crohn’s procedures only: When the Ulcer Size Estimation tool is selected, moving the mouse pointer over the lesion displays a ruler consisting of two orthogonal lines, which are a constant 5 mm in length.

The ruler changes visually based on the software’s estimation of the depths in the image. The relation between the constant size of the tool and the ulcer being visualized allows estimating the ulcer size.

Note
Ulcer Size Estimation is a tool for research purposes only and the values displayed should not be used in making diagnostic or treatment decisions.
Using Localization and Landmarks

Landmarks
Landmarking an image labels it as one of the anatomical landmarks along the GI tract. A different default landmark menu is displayed for each PillCam Software video type, as follows:

<table>
<thead>
<tr>
<th>Video type</th>
<th>Landmarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>UGI video</td>
<td>First esophageal image</td>
</tr>
<tr>
<td></td>
<td>Z-Line image</td>
</tr>
<tr>
<td></td>
<td>First gastric image</td>
</tr>
<tr>
<td>SB video</td>
<td>First gastric image</td>
</tr>
<tr>
<td></td>
<td>First duodenal image</td>
</tr>
<tr>
<td></td>
<td>First ileocecal image</td>
</tr>
<tr>
<td></td>
<td>First cecal image</td>
</tr>
<tr>
<td>COLON/Crohn's</td>
<td>First cecal image</td>
</tr>
<tr>
<td>video</td>
<td>Last cecal image</td>
</tr>
<tr>
<td></td>
<td>Hepatic flexure image</td>
</tr>
<tr>
<td></td>
<td>Splenic flexure image</td>
</tr>
<tr>
<td></td>
<td>First rectal image</td>
</tr>
<tr>
<td></td>
<td>Last rectal image</td>
</tr>
</tbody>
</table>

To create a landmark:
- Right-click on video image you identify as the landmark and select the correct landmark label.
- If, for the video you are viewing, you wish to enter a landmark other than the default landmarks, select **Capture Other Landmarks**. This option displays all the landmarks for selection.
Suggested Flexure Landmarks for PillCam COLON/PillCam Crohn’s Videos
This feature is available (active) only if a PillCam sensor array was used during the procedure. If a PillCam sensor belt was used, this option is inactive and grayed out.

After you have marked the first cecal image, PillCam Software can suggest the Colon Flexure landmarks.

To allow PillCam Software to suggest Flexure Landmarks:
2. Double-click the suggested flexure thumbnails for review.
3. To accept the suggested flexure landmarks, right-click the thumbnails and select the appropriate landmark option.

Suggested Landmarks for PillCam SB 3 Videos
To use this feature to suggest the SB 3 landmarks:
2. Double-click the suggested thumbnails for review.
3. To accept the suggested landmarks, right-click the thumbnails and select the appropriate landmark option.

GI Map
The GI Map provides a graphical representation of the small bowel and colon and shows the progress of the capsule in the small bowel/colon. A white dot indicates the estimated position of the current frame being viewed. The passage time appears at the bottom of the image. For PillCam SB videos, an estimate of the percentage of the small bowel viewed appears in the top left corner.

Note
Localization of the capsule is only an estimate. Use of reader defined landmarks may improve this tool. Discretion should be used when relying on the capsule progress indicator and localization tools to make diagnostic or treatment decisions.
Passage Times

Passage time is the time the capsule spent in a given region of the GI tract. Calculation of passage times is enabled only after you segment the video from the GI tract by labeling the first images of the different sections of the GI tract. When you identify and label the first and last images of the gastric, SB, or cecal section of the GI tract, PillCam Desktop Software calculates the relevant passage times based on the time tags of the landmarked thumbnails.

The software displays this data at the bottom of the GI Map.

Note

Localization of the capsule is only an estimate. Use of reader defined landmarks may improve this tool. Discretion should be used when relying on the capsule progress indicator and localization tools to make diagnostic or treatment decisions.

Comparing Thumbnails

There are three ways to compare images in PillCam Desktop:

- **Atlas comparison**: Compare a PillCam Desktop video thumbnail to Atlas images (see Comparing Video Images to Atlas Images on page 142).

- **One thumbnail comparison**: Compare a thumbnail to itself in different display modes (i.e. FICE or Blue mode).

- **Two thumbnail comparison**: Compare two different thumbnails in the same video.

To compare a thumbnail to itself (One frame comparison):

1. Click the thumbnail you wish to examine. A dark blue background appears around the thumbnail.
2. Right-click the thumbnail and select **Compare Thumbnails**. A separate window appears, showing the same thumbnail duplicated, side by side.

3. Use the **Image Adjustment** tools at the top of the window of one of the thumbnails to compare the two images.

   **Note**
   You can scroll through the video by moving your mouse wheel in either direction. Both sides will move together.

To compare two images in the same video:

1. Click the first thumbnail you wish to use for comparison.

2. Hold down the CTRL key on your keyboard and select the second thumbnail.

3. Click one of the selected thumbnails and select **Compare Thumbnails**. A separate window appears, showing both thumbnails side by side.

   **Note**
   - You can scroll through the video by moving your mouse wheel in either direction, for each thumbnail separately.
   - If other applications on your computer use keyboard shortcuts, they may be activated when you use the shortcuts in PillCam Software.
Working with Findings

A findings file contains:

- All the thumbnails with their comments or other annotations (see Working with Thumbnails on page 152).
- Check-in information.
- All the study comments.

Saving Your Findings

It is possible to save your findings. You can open and view this file with the video on any computer with PillCam Software installed.

To save findings in new location:
1. Select File > Save Findings As. The Save Findings As screen appears.
2. Select a location for saving:
   - If you intend saving to a disc, insert a formatted writable disc into the appropriate drive and select it from the screen.
   - If you intend saving on a USB device, plug in the USB device and select the USB device.
   - The default location is the PillCam Software folder of the currently displayed video.
3. Click Save.

   The findings file is saved. The name of the associated PillCam Software directory, the associated PillCam Software video file and the findings are saved.

To save findings to the last saved findings file:
- Click the button in the Quick Access toolbar located at the top of the PillCam Software screen, or click Save Findings from the File menu.

   The findings file is saved to the same location and under the same name.

Opening a Findings File

You may load only a findings file associated with the currently displayed video. If you attempt to load a findings file that is not associated with the loaded PillCam Software video, an error message appears notifying you of the mismatch. If you load another findings file associated with the same
video, the open findings file closes. A message appears asking you to save the open findings file before closing it.

Under **Tools > Settings > Other** tab, you can enable opening findings automatically. When this option is selected, opening a video from the Study Manager will open the findings file as well (if available).

To open a findings file:

1. **Select File > Open Findings.**
   
   If a findings file is open, PillCam Software asks if you want to save the current findings file.
   
   The **Open Findings File** window appears, showing the folder of the current video. A findings file can also be opened using the Study Manager (see **Opening a Study** on page 123).

2. **Select the findings file you wish to open.**
   
   To open a findings file stored in another location, navigate to the desired location by clicking **Browse**.

3. **Click Open.**
   
   Once the findings file is loaded, the saved thumbnails with their annotations appear in the **Thumbnail** section. If the findings contain landmarks, the following note appears:

4. **Click OK to continue.**
Creating a PillCam Capsule Endoscopy Report

After viewing the capsule endoscopy video and creating the findings, an interpretation of the study can be summarized in a patient report. This phase should be performed after the Preview and Review phases.

The data created during the Review phase is now stored in the corresponding video folder. The PillCam Desktop Software Report ribbon enables the creation of reports and exporting of video clips and images to another directory or to a CD for later use.

The Report ribbon enables the following functions to prepare the patient report and complement the patient study:

- Add additional thumbnails and study comments.
- Add markings (circles and arrows around lesions for emphasis and size estimates) to all thumbnails.
- Add comments to all thumbnails.
- Save images and create video clips for later use in presentations or referrals.
- Use the Atlas or Lewis Score clinical tools in the Report ribbon for diagnostic comparison or evaluation using a scoring index.
- Generate a patient report that can also be printed and emailed.
- Export the results or patient summary.
Generating a Report

1. Click on the checkbox on the top left of the thumbnail to include it in the report.

   - To unselect the thumbnail, click the checkbox again.
   - To select all the images, click the Select All button.
   - To unselect all images, click the Unselect All button.

2. Check De-Identify to exclude any patient information from the report.

   Note
   Any disclosure of images taken by the PillCam Capsule Endoscopy System without the patient’s consent might violate the patient’s privacy rights. To export findings without patient information, click the De-Identify check box in the ribbon.

3. Select a template from the list in the ribbon.

4. If necessary, select the Electronically Sign Reports option. For a description of this option, see Signing Reports Electronically on page 167.

   When you save, email, print, or export the report, you will be prompted to enter the Windows login password.

5. If you have marked thumbnails in FICE or Blue Mode, you can create a report that includes these thumbnails alongside the normal thumbnail.

   To do this, click the dialog box launcher of the Configure ribbon group and select the Include normal image alongside FICE or Blue thumbnail check box. Click OK to save the settings.

6. After setting up the report, you can use the options in the Report group to perform the following actions:

   - Preview the report on your computer screen.
   - Save the report.
   - Send the report by email.
   - Print the report.
   - Export the report results, patient summary, or GI map. For details on the export options, see Report Export Options on page 168.
An example of a report follows.

Sample report:

Signing Reports Electronically
An electronic signature is a way to allow authorized personnel to approve and validate a document without having to physically print it out and sign it manually. With this feature you may produce a signed capsule endoscopy report with the signing physician’s name appearing in the signature field, where the electronic signature feature is the only way to achieve this, thus signifying signature of the document. Electronic signatures are widely accepted as legally valid.

Once the electronic signature is activated, the signature will be displayed when creating or printing a report. The signature will appear as electronically signed by: your first and last name, as it appears in your user profile (in Windows).

To enable the electronic signature option:
1. While viewing a study, select the REPORT tab.
2. In the Configure group, select Electronically Sign Reports.
Whenever a report is saved, printed, exported or sent as an attachment by email, you will be prompted to enter your password in order to sign the report.

3. Enter your login password and click **Sign Report**.

**Report Export Options**

The following export options are available:

- **Results**: Exports the report along with an XML file and the report images (for HIS use).
- **Patient Summary**: Exports the report and the report images.
- **GI Map**: Exports the GI Map only. See **GI Map** on page 160 for details on working with the GI Map.

The data can be exported to a drive directory (which is pre-defined in **Settings**) or to a CD.

**To enable Results and Patient Summary export:**

1. From the Home screen select **Tools > Settings > Report** tab.
2. Select the **Include video clips in export data** checkbox to enable saving clips and images during export.
3. Select the **Export to directory** option and type the location to where to export. This can be done for both the **Results Export** and **Patient Summary Export**. If the **Export to directory** is not enabled, you will be prompted to define an export location each time you export a report. When exporting the results or patient summary, a copy is also saved locally on the computer.

4. After making the changes to the settings, click **Apply** to accept the new settings or click **Cancel** to close the **Settings** screen without accepting any changes. Clicking **OK** will accept the new settings and close the **Settings** screen.
Working with PillCam Crohn’s Videos

The PillCam Crohn’s capsule allows visualization of the small bowel and colonic mucosa. While viewing PillCam Crohn’s videos, additional assessment tools are available for comparing previous studies, reviewing treatment over time, and for the observation and interpretation of the presence, extent and severity of the pathologies.

The chapter is divided into the following main steps:

- **Overview** on page 169
- **Using the Prepare Screen** on page 171
- **Viewing PillCam Crohn’s Videos** on page 174
- **Creating a PillCam Crohn’s Report** on page 182

**Overview**

Working with PillCam Crohn’s videos is based on a segmental approach to video review. Using this approach, three main parameters can be assessed per segment:

- The most severe lesion (MSL)
- The most common lesions (MCL)
- The linear extent of inflammatory involvement.

This segmental approach includes three phases: segmentation, segmental review, and segment assessment. This segmental assessment is represented in a GI Table and graphically in the GI Map.

**Segmentation**

In order to enable the PillCam Crohn’s study features, the following landmarks need to be captured:

- First Duodenal Image
- First Cecal Image
- Last Rectal Image

In addition to manually reviewing the videos, identification and capturing of these anatomical landmarks is facilitated and expedited using the following options in the PillCam Desktop software:

- **Anatomical landmarks’ pane**—Enables one click selection and annotation of the image that is presented on the screen.
- **Suggested range/image**—Highlights the ranges in which there is the highest probability of identifying the anatomical landmarks, on the Color Bar.
• **Color Bar hover-over**—When passing the mouse cursor over the tissue-bar, a small preview image appears on the screen enabling quick review of the images, and specifically the suggested ranges.

Once the three landmarks have been captured, PillCam Desktop automatically segments the video into three small bowel segments and a colon segment, and displays the GI Table and GI Map.

![Note](image)

Localization of the capsule is only an estimate. Use of reader defined landmarks may improve this tool. Discretion should be used when relying on the capsule progress indicator and localization tools to make diagnostic or treatment decisions.

**Segmental Review**

After the video has been segmented, each segment can be reviewed while assessing the three parameters discussed previously, per segment. The assessment results are then presented in the GI Table in the upper-left part of the screen.

While reviewing the video, any inflammatory lesion that is identified can be graded using the Severity Ruler using a three-tiered grading system (i.e. 1-mild, 2-moderate, 3-severe). In addition, the presence of a stricture of the lumen can also be marked, indicated by an “S”. Grading the severity or adding the stricture indication to an image will automatically create a thumbnail for that image.

While conducting the segmental review, PillCam Desktop will automatically include all severity/stricture graded images as examples in the respective segment in the GI Table. Similarly, the most severely graded image in the segment is automatically populated as the Most Severe Lesion in the respective segment. This encourages “escalating-severity” based review, in which the reviewer pauses and grades lesions only if they are the first lesion, or if they have a higher severity grade than the previous lesions identified for that segment. In this way, less time is devoted to capturing and grading images.

While reviewing the video, it is possible to edit images using the thumbnail marking tools (arrow, circle, comment, Polyp Size Estimator, and Ulcer Size Estimator). A description of these tool appears in **Marking Tools** on page 156.

**Segment Assessment**

When the reviewer reaches the end of a segment, PillCam Desktop automatically prompts the reviewer to assess the severity of most common lesions in the reviewed segment, and the extent of inflammatory linear involvement for that segment.

During segment review, the GI Table and GI Map are automatically updated with the Most Severe Lesion (MSL), Most Common Lesion, Extent, and examples of graded images for that segment. Four sub-segment regions can be evaluated independently regarding their involvement or lack of
involvement in the inflammatory process. These regions (duodenum, terminal ileum, right colon and left colon) can be assessed either at the end of review for the respective segment, or via the GI Table.

This process is repeated for each of the four segments, constituting the complete assessment of the small bowel and colon.

**Using the Prepare Screen**

When working with PillCam Crohn's videos, an additional screen is available in PillCam Desktop that allows you to review demographic and procedural information, add or modify the reason for referral, and view/edit the list of current medications, prior to the clinical review of the PillCam Crohn's video.

You can progress to the PillCam Crohn's video review either by clicking the **View** button at the top of the screen, or by clicking the **Proceed To Video** button at the bottom of the Patient Details section of the screen.
Viewing Current Procedure Information

The current procedure information appears on the left side of the Prepare window. This information includes demographic and procedure details that were entered during the check-in process. While viewing the procedure information, you can edit the reason for referral and view or edit the current medications.

Viewing and Editing Current Medications

The Medication History log allows maintaining the patient’s medication history by adding prominent disease management medications, whether on-going or previously discontinued. This information allows investigating the correlation between the use of specific medications over a period of time and the mucosal status assessment of the patient. For further details, see Viewing Treatment Over Time on page 174.

To view and edit the list of current medications:

1. In the Prepare screen, click the Edit Medications icon next to Current Medications.
2. In the **Edit Medications** dialog box, edit existing medications or click the **Add Medication** icon to add a new entry:
   - Under **Medication**, manually define a new medication or select a medication from the predefined list.
   - Under **Medication Period**, define the period for which the medication applies. If the patient is currently taking medication, leave the end date empty.
   - Under **Dose**, define the dose that was defined for the medication. The dose is defined in milligrams per day or week.

3. Click **Save** to save the list of medications.

**Viewing a Study from a Previous Procedure**

The Previous Procedure feature enables the reviewer to revisit prior patient capsule studies to familiarize themselves with the previous findings and mucosal manifestations of the patient’s disease.

When opening a study, PillCam Desktop automatically searches for previous studies with the same details in all defined video archives, based on the following criteria: ID, first and last name, and date of birth. If a partial match occurs, a notification appears showing the mismatch.

If more than one previous study is found, the studies will be available via a drop-down list; the most recent previous study appears at the top of the list. When a prior study is selected, the information displayed is according to the study conducted and the report that was compiled at the initial time of the study review.

After studying the previous procedure information, click **Proceed to Video** to view the current study.
Viewing Treatment Over Time

When viewing PillCam Crohn’s videos, it is possible to view capsule endoscopy results and medications over a period of time, when one or more previous PillCam Crohn’s studies are available. This provides a correlation between the patient’s medications and the mucosal status assessment over time and allows monitoring disease progress.

The Treatment History includes the GI Map and a time-line that maps medication use. The treatment history can be saved as an image file.

**Note**
This option is also available via the REPORT screen.

To view treatment history:

1. Open a PillCam Crohn’s study. The study opens in the **PREPARE** window and shows the previous procedure.
2. In the **COMPARE** ribbon group, select the **Treatment over time** option.
3. If necessary, click **Save as File** to save the treatment history as a graphic file, or click **Close** to close the window.

Viewing PillCam Crohn’s Videos

In addition to the regular viewing options available for all PillCam capsule videos, the following additional options are available when viewing PillCam Crohn’s videos:

- Defining the severity and extent of disease for the segment.
- Comparing GI Tables between a patient’s current and previous studies.
- Comparing findings between a patient’s current and previous studies.
- Viewing a video from a patient’s previous study.
Defining Severity and Extent of Lesions in PillCam Crohn’s Videos

While viewing PillCam Crohn’s videos, it is possible to rate the extent and severity of the disease. In order to do this, the video is divided into segments based on the three main anatomical landmarks: First Duodenal Image, First Cecal Image, and Last Rectal Image. This segmentation is reflected in the GI Table on the left side of the screen. For each segment, it is then possible to define the most severe lesion, most common lesion, extent of the disease, and the occurrence of strictures.

Refer to the Overview on page 169 for a detailed description on viewing PillCam Crohn’s videos.

Guidelines for Defining Severity and Extent of Lesions in PillCam Crohn’s Videos

The process of defining the severity and extent of lesions in PillCam Crohn’s videos consists of four main steps, as illustrated below.
Use the illustration that follows to familiarize yourself with the PillCam Crohn’s VIEW screen.

Click to see thumbnails in this segment for which the severity level was defined

Hover over a number to see a tooltip and view examples for this severity level

Click to view the selected segment

Allows defining whether the sub-segment is involved or not involved in the disease

Shows the approximate location of the capsule in the GI tract

The GI Map reflects the severity ratings in the GI Table

Bookmarks show the last three images viewed

Highlights the segment currently selected in the GI Table

---

**Defining Anatomical Landmarks**

The following main anatomical landmarks need to be defined in order to segment the video into three small bowel segments and a colon segment, and display the GI Table and GI Map:

- First duodenal image
- First cecal image
- Last rectal image

You can define these landmarks manually, or allow PillCam Desktop to show the range in which it is most likely that the associated landmark appears. After defining the anatomical landmarks, the GI Table and GI Map appear.

**Note**

If the last rectal image cannot be ascertained, marking of the last rectal image can be skipped.
To define anatomical landmarks manually:

1. Open a PillCam Crohn’s video and select the VIEW tab.
2. View the video and use the right-click menu to capture the landmark, or click the Capture Left Image or Capture Right Image button to capture the thumbnail.
   
   After capturing an image, the button changes to Captured. After defining all the anatomical landmarks, the GI Table and GI Map appear.

To allow PillCam Desktop to suggest where landmarks occur:

1. Open a PillCam Crohn’s video and select the VIEW tab.
2. Under Please identify Anatomical Landmarks, you can use the Show suggested ranges check-box to allow PillCam Desktop to show the range in which it is most likely that the associated landmark appears.
   
   The Go to suggested range options are enabled for each landmark.

   Note
   The Go to suggested range option is dimmed if the software is unable to suggest the range. In this event, select the image manually.

3. Next to each landmark, select the Go to suggested range option.
   
   The video will skip to the suggested range. You can then either scroll/play video/mouse hover-over the area to pinpoint the required landmark image.

4. Click the Capture Left Image or Capture Right Image button to select the landmark image.
   
   After selecting (capturing) an image, the button changes to Captured. After defining all the anatomical landmarks, the GI Table and GI Map appear.
Working with the GI Table

The GI Table appears after defining the anatomical landmarks, and is divided into segments and sub-segments.

While viewing the video and grading lesions, the most severely graded lesion is automatically populated in the associated cell in the GI Table. Assessment of the most common lesion and the extent of the disease are done at the end of segment viewing, and also automatically appear in the GI Table.

The contents of the GI Table can be edited at any time, by toggling the drop-down lists for each of the parameters.

To rate lesions and edit the GI Table:

1. Click on the segment name (e.g. SB II) in order to go to that segment of the video. The selected segment will be highlighted in the Time bar. (See Time Bar/Color Bar on page 152).
2. Use the View tools to view the video.
3. When you see a finding that you want to rate, click on the image to see the Severity Ruler:
4. Rate the severity as follows:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Mild</td>
</tr>
<tr>
<td>2</td>
<td>Moderate</td>
</tr>
<tr>
<td>3</td>
<td>Severe</td>
</tr>
<tr>
<td>5</td>
<td>Stricture</td>
</tr>
</tbody>
</table>

The GI Table is automatically updated as you rate the lesions.

5. Continue viewing the video and rate new lesions or lesions with a higher level of severity than the previously rated lesion.

At the end of the segment, you will be prompted to grade the most common lesion and the extent (and involvement of sub-segment where applicable) for that segment.

Note
Prompting of grading of the most common lesion and extent at the end of segment viewing is an optional feature. To enable this feature, select the Pause video after each segment option under Tools > Settings > Video tab.

All of this information is automatically populated into the respective cell in the GI Table and on the GI Map. If necessary, you can use the drop-down lists in the GI Table to edit the severity rating parameters.
Comparing GI Tables

While viewing PillCam Crohn’s videos, it is possible to view a side-by-side view of the current and previous GI Table and GI Map. This feature facilitates the side-by-side review and comparison of the current study GI Table to prior study GI Tables, providing a visual representation of the disease dynamics over time in terms of distribution, extent and severity.

To compare tables:
1. Open a PillCam Crohn’s video and select the VIEW or REPORT tab.
2. Click the Compare Tables button in the COMPARE ribbon group.

The current and prior GI Table and GI Map appear (based on the selection in the PREPARE screen):
- In the prior GI Table, you can click on the Image icons to view severity rated images from the prior video.
- In the current table you can edit any of the segment parameters (Most severe lesion, Most common lesion, Extent) for any of the segments in the current video.

Comparing Findings

While viewing PillCam Crohn’s videos, it is also possible to compare findings in the current video with findings from the previous video. This feature allows the comparison of all of the thumbnails captured in the current study to those found in previous studies.

To compare findings:
1. Open a PillCam Crohn’s video and select the VIEW tab.
2. Click the Compare Findings button in the View ribbon. In the Compare Findings window, use the scroll bar to view the thumbnails for the current and prior video.
3. While viewing the findings, take note of the following:
   - The location of the thumbnail is shown on the Color Bar. The line that connects between the thumbnail and the Color Bar is color-coded per GI organ.
   - When you click on a thumbnail, an enlarged view appears on the right side of the window.
   - When applicable, the severity level and presence of a stricture is shown in the top right corner of the thumbnail.
Viewing a Prior Video

When working with PillCam Crohn's videos, you can view videos from prior PillCam capsule studies associated with the patient. The findings for the prior video are read-only and cannot be edited.

To view a prior video:
1. Open a PillCam Crohn's video and select the VIEW tab.
2. Click the Prior Video button in the COMPARE ribbon group. The VIEW PRIOR tab is added to the ribbon tabs and the prior video appears.
3. To close the video, click the X in the top right corner of the VIEW PRIOR button.
Creating a PillCam Crohn’s Report

When working with PillCam Crohn’s videos, you can create a report that includes the GI Table, GI Map, comments, and thumbnails selected during viewing. In addition to the regular reporting options, the REPORT screen also includes additional comparison options:

- **Compare Tables:** Provides a side-by-side view of the current and prior GI Table and GI Map. For details on using this option, see Comparing GI Tables on page 180.
- **Compare Report:** Shows the previous report. For details on using this option, see Viewing a Prior Report on page 182.
- **Treatment over Time:** Shows capsule endoscopy results and medications over a period of time. For details on using this option, see Viewing Treatment Over Time on page 174.

These options allow you to get a clearer picture of the severity of the disease in the prior study, and allow you to fine-tune your current report.

Detailed instructions for creating reports appear in Creating a PillCam Capsule Endoscopy Report on page 165. The sections that follow describe how to compare previous reports and how to create a PillCam Crohn’s report.

Viewing a Prior Report

Viewing the prior report allows you to compare the current report information with the previous report. This provides a clearer clinical picture and enables evaluating changes in the distribution and severity of the disease.

To view the prior report:

1. Open a PillCam Crohn’s video and select the REPORT tab.
2. Click the Compare Report button to see the previous report.
3. After viewing the report, click the X to close.
Creating a Report

The Report tab for PillCam Crohn’s videos displays the GI Table, GI Map, and comments on the left side of the screen. The right side of the screen displays thumbnails that will be included in the report. These thumbnails are selected automatically by PillCam Desktop. By default, PillCam Desktop will automatically include the thumbnail with the most severe rating per segment, and all thumbnails for which a stricture was defined.

To create a report:

1. Open a PillCam Crohn’s video and select the REPORT tab.

2. Review the GI Table and comments on the left side of the screen. Make any adjustments as necessary.

3. Click the Edit Thumbnail Selections button to view and select the thumbnails that will be included in the report.

   The Select Thumbnails for Report window appears and displays all thumbnails marked while viewing the video, thumbnails with anatomical landmarks, and all thumbnails for which the severity level or a stricture was defined. The thumbnails are organized by segment.

4. Select the check box in the top left corner of the thumbnail to include it in the report. After selecting the thumbnails, click Close.

5. If necessary, you can edit the thumbnail comment, use the Marking Tools, delete thumbnails, and make changes to the severity rating. To do this, move the mouse cursor over the thumbnail and click the Edit Thumbnail icon.

   In the Edit Thumbnail Comment dialog box, you can perform the following actions:
   - Select the segment from the Segment drop-down list.
• Select the check box to include or exclude the thumbnail from the report.
• Change the severity rating in the Severity Ruler, or define a stricture.
• Add or edit a thumbnail comment.
• Delete a thumbnail using the **Delete Thumbnail** button.
• Use the Marking Tools.
• Click the **Open Atlas** button to compare the thumbnail image with PillCam Atlas reference images.

6. In the **REPORT** ribbon, you can select the following options as necessary:
   • Select a template from **Template** drop-down list in the ribbon.
   • Select the **De-Identify** check box to exclude any patient information from the report.
   • If you have selected the **Electronically Sign Reports** option, (for more information on this option, see **Signing Reports Electronically** on page 167), enter the Windows login password.
   • If you have marked thumbnails in FICE or Blue Mode, you can create a report that includes these thumbnails alongside the normal thumbnail. To do this, click the dialog box launcher (▲) of the **Configure** ribbon group and select the **Include normal image alongside FICE or Blue thumbnail** check box. Click **OK** to save the settings.

7. After setting up the report, you can preview, save, email, print, or export the report.
PillCam Recorder Maintenance

Use only a fully charged (eight or more bars displayed on the battery icon) PillCam recorder. In general, including first-time use, charging the PillCam recorder is an overnight process and should not be performed in the vicinity of the patient. When you receive the PillCam recorder after an examination, charge it immediately until the green LED is lit, and leave it in its cradle.

**Warning**
Charge the PillCam recorder **only** with the supplied cradle. Once you have placed it into the cradle, the PillCam recorder automatically starts charging.

**Caution**
The SD card should never be removed or reinserted when the PillCam recorder DR3 is ON.

**Disclaimer**
The PillCam recorder cradle is a non-medical device, used for charging the PillCam recorder from Given Imaging. For full specifications, see System Specifications on page 204.

**Important Safety Instructions**

**Note**
Before using the PillCam recorder cradle, read all instructions on cautionary markings on the cradle, on the battery, and on the PillCam recorder.

**Warning**
Changes or modifications to this equipment not expressly approved by the party responsible for compliance (Given Imaging) could void the user’s authority to operate the equipment.
PillCam Recorder Maintenance

PillCam Recorder DR3

The PillCam recorder DR3 cradle has the following LEDs:

<table>
<thead>
<tr>
<th>LED</th>
<th>Status</th>
<th>Battery pack is…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>On</td>
<td>ready for use</td>
</tr>
<tr>
<td>Yellow/Orange</td>
<td>Blinking</td>
<td>charging</td>
</tr>
</tbody>
</table>

To charge the PillCam recorder:

1. Plug the power cable into the cradle and plug the power cable into the wall outlet.

2. Insert the PillCam recorder into the cradle. The bottom LED is orange when charging the battery. When the PillCam recorder is fully charged, the bottom LED turns green.

3. Leave the PillCam recorder in its cradle until the next examination.

Warning

- The cradle is for indoor use only.
- Never charge non-rechargeable batteries.
- All cells containing mercury, cadmium, lithium or lead as electrochemical substances are subject to special waste disposal requirements.
- This charger is a class A product. In a domestic environment, this charger may cause radio interference.

Note

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

LED Status

Battery pack is…

Green On ready for use
Yellow/Orange Blinking charging
PillCam Recorder DR2

Charging

Make sure the PillCam recorder is at least 80% charged (eight or more battery bars displayed on the battery icon) for SB and COLON/Crohn’s procedures, and at least 50% charged (five or more bars displayed on the battery icon) for UGI procedures.

The cradle has the following LEDs:

<table>
<thead>
<tr>
<th>LED</th>
<th>Status</th>
<th>Battery pack is…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>On</td>
<td>ready for use</td>
</tr>
<tr>
<td>Orange</td>
<td>Blinking</td>
<td>discharging</td>
</tr>
<tr>
<td>Red</td>
<td>On</td>
<td>faulty (malfunctioning)</td>
</tr>
</tbody>
</table>

To charge the PillCam recorder:

1. Plug the power cable into the cradle and plug the power cable into the wall outlet. All three LEDs turn on for a self-test that takes 5 seconds. After 5 seconds, all LEDs turn off and the cradle is ready for use.
   
   If during the self-test the red LED blinks, the cradle is faulty. Contact Given Imaging Customer Support.

2. Insert the PillCam recorder or its Li-Ion battery with its adaptor into the cradle. All three LEDs of the cradle blink for 4 seconds. When the orange LED is on, charging has started.
   
   As soon as the PillCam recorder or its battery pack are fully charged, the green LED turns on, and the orange LED turns off.

3. Leave the PillCam recorder in its cradle until the next examination.
4. To check the status of the PillCam recorder before an examination, remove it from the cradle and push the button on the back.

Manual Discharge
If the cradle detects that the battery needs refreshing, it automatically discharges the battery before recharging it. The orange LED on the cradle blinks during discharging. Discharging is an overnight process that may take up to 12 hours.

We recommend that you manually discharge the battery every three months, even if it is not used.

To discharge the battery:
1. Open PillCam Desktop.
2. Make sure the appropriate battery is inside the PillCam recorder.
3. Insert the PillCam recorder into the cradle.
4. From the Procedures screen, select the relevant PillCam recorder by clicking the Recorder bar. The buttons on the right side of the screen become available.
5. Click to open the Recorder Information screen.
6. At the bottom of the screen, click Start Discharge.
   A message appears: Recorder discharge may take more than 12 hours. Do you wish to continue?
7. Click OK.
   While the battery is being discharged, its battery status indicates Discharging:
   - In the bottom left corner of the Recorder Information screen.
   - In the PillCam recorder DR2 bar in the Recorders screen.
   - The orange LED on the cradle blinks.
8. To return to other PillCam Desktop functions, click Close.
9. If you need to stop the discharge (also for automatic discharge) while it is in progress, return to the Recorder Information screen and click Cancel Discharge.
   If you stop the automatic discharge process in the middle, the battery LEDs may not indicate the correct battery status.

Note
Do not charge or discharge the battery in the vicinity of the patient.
PillCam Sensor Cleaning

This section includes instructions for cleaning the PillCam equipment.

Cleaning the PillCam Sensor Belt

Note
To clean the PillCam equipment surfaces, we recommend using alcohol wipes (up to 70%). Usage of other classes of disinfectants (Aldehydes, Oxidizing Agents, Quaternary Ammonium, Chlorine compounds, Iodophor, Phenolic compounds) may stain or damage the materials.

Cleaning the PillCam Sensor Array

For mild cleaning (dirt, sweat), wipe the sensors gently with alcohol wipes (up to 70%). The alcohol will not remove the adhesive. Use alcohol sparingly and allow the sensor array to dry for 20 minutes.

To remove adhesive from the sensor array (not from the human body), use white benzene.

Warning
Use white benzene only in a well ventilated area according to all precautions and instructions on the label.

Alternatively, use one of the following medical adhesive removers to remove adhesive:

- B-508 Secure Solvent
- B-202 Hollister Solvent
- B-206 Detachol Adhesive Remover

Use all precautions as defined by the manufacturer.

Cleaning the Recorder Pouch

To clean the recorder pouch, wipe down all surfaces with alcohol (70% isopropyl or ethyl alcohol) making sure that all surfaces are exposed to alcohol for at least 1 minute.
Appendix B

Troubleshooting

This chapter provides Troubleshooting information on the following main topics:

- **PillCam Capsule Video** on page 191
- **Saving and Opening Videos** on page 192
- **Printer** on page 193
- **CD/DVD** on page 193
- **Sensor Array** on page 193
- **Sensor Belt** on page 193
- **Capsule** on page 194
- **Cradle** on page 194
- **PillCam Recorder DR3** on page 194
- **PillCam Recorder DR2** on page 195
- **Error Messages** on page 196
- **Low Signal** on page 197

### PillCam Capsule Video

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
</table>
| **Short video** | • Capsule  
• PillCam recorder battery  
• PillCam recorder mishandling | • Contact Customer Support  
• Send video on CD/DVD  
• Inform capsule lot#  
• Do not use the same PillCam recorder  
• Save the raw data locally on your computer |
| **Gaps** | • Capsule  
• Interference  
• Mishandling  
• Physiological | |
| **Bad image quality** | • Stripes in video  
• Pixilation/confetti  
• Dark/red/orange image | |
| **Video shorter than capsule operating time without either ingestion phase images or body exit images** | • Capsule  
• PillCam recorder battery  
• Interference | • Send video on CD/DVD  
• Save the raw data locally on your computer  
• Contact Customer Support |
## Saving and Opening Videos

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot open PillCam Atlas</td>
<td>Atlas installation incomplete or incorrect</td>
<td>• Reinstall Atlas&lt;br&gt;• Save the raw data locally on your computer&lt;br&gt;• Contact Customer Support</td>
</tr>
<tr>
<td>Cannot view COLON 2 video using RAPID v7.0</td>
<td>COLON 2 videos compiled in RAPID v8.0 cannot be viewed using RAPID v7.0</td>
<td>Download and use RAPID Reader v8.0 to view video</td>
</tr>
<tr>
<td>Unable to perform various operations</td>
<td>The PillCam Desktop computer is “stuck” typically after a prolonged period in the ON state without restarting</td>
<td>It is recommended to restart your computer at least once a month to ensure optimal performance</td>
</tr>
</tbody>
</table>

---

### Saving and Opening Videos

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot locate video</td>
<td>• Video was not saved in E:\Videos&lt;br&gt;• Video was not created&lt;br&gt;• Incorrect patient’s name</td>
<td>• Search for video in PillCam Desktop Work Directories or in Study Manager (video creation)&lt;br&gt;• Contact Customer Support</td>
</tr>
<tr>
<td>Cannot locate findings</td>
<td>• Findings were not saved under patient’s folder&lt;br&gt;• Findings were saved with the wrong name</td>
<td>• Refer to Saving Findings File in Saving Your Findings on page 163&lt;br&gt;• Contact Customer Support</td>
</tr>
<tr>
<td>Study cannot be selected in Study Manager</td>
<td>Changing an archive location that appears in the Study Manager screen, the archive remains on the archives list but its study cannot be selected</td>
<td>Modify the archive location manually</td>
</tr>
<tr>
<td>Cannot open a video from an archive in Study Manager and an error message requests user to click the refresh button</td>
<td>Archive privileges set with no access to read or write</td>
<td>Allow Read and Write access to the archive folder</td>
</tr>
</tbody>
</table>
### Printer

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot print report</td>
<td>Printer is turned off</td>
<td>Turn printer on</td>
</tr>
<tr>
<td></td>
<td>Printer is not set as default printer</td>
<td>Set printer to <strong>Default Printer</strong></td>
</tr>
<tr>
<td></td>
<td>Printer has a malfunction</td>
<td>Contact Customer Support</td>
</tr>
</tbody>
</table>

### CD/DVD

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot burn CD/DVD</td>
<td>CD/DVD is not blank or compatible with CD/DVD ROM</td>
<td>Contact Customer Support</td>
</tr>
<tr>
<td></td>
<td>Wrong burning procedure</td>
<td></td>
</tr>
<tr>
<td>Cannot eject CD/DVD</td>
<td>A video on the disc is open</td>
<td>Close the video and retry</td>
</tr>
</tbody>
</table>

### Sensor Array

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector is damaged</td>
<td></td>
<td>Contact Customer Support</td>
</tr>
<tr>
<td>Sensor is torn from its wire</td>
<td>• Mishandling</td>
<td></td>
</tr>
<tr>
<td>Insulation of the sensor wire is damaged</td>
<td>• End of Life</td>
<td></td>
</tr>
</tbody>
</table>

### Sensor Belt

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector is damaged</td>
<td>• Mishandling the sensor belt</td>
<td>• Stop using this sensor</td>
</tr>
<tr>
<td>Insulation of the sensor wire is damaged</td>
<td>• End of Life</td>
<td>• Contact Customer Support</td>
</tr>
</tbody>
</table>
## Capsule

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
</table>
| DOA (Dead On Arrival)         | Capsule failure     | 1  Send capsule to Given Imaging.  
                                  |                     | 2  Open another capsule.  
                                  |                     | 3  If second capsule from 10-  
                                  |                     |  pack is DOA, contact  
                                  |                     | Customer Support.     |

## Cradle

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
</table>
| Cradle LEDs turn red                | All LEDs are flashing red              | 1  Disconnect cradle from mains power.  
                                  |                                        | 2  Reconnect cradle to mains power.  
                                  |                                        | 3  If problem persists, contact  
                                  |                                        | Customer Support.     |
| Cradle orange LED is blinking, but  | Hardware/Software problem              |                                                                       |
| cradle is not in discharge mode     |                                        |                                                                       |
| PillCam recorder DR2 cannot be      | Hardware malfunction                   | Contact Customer Support                                              |
| placed in cradle                    |                                        |                                                                       |

## PillCam Recorder DR3

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capsule LED blinking red</td>
<td>Interference</td>
<td>Refer to PillCam recorder DR3 LEDs Indications</td>
</tr>
<tr>
<td>Capsule LED blinking white</td>
<td>Capsule not paired yet</td>
<td>Refer to PillCam recorder DR3 LEDs Indications</td>
</tr>
<tr>
<td>SD card errors</td>
<td>Wrong or damaged SD card</td>
<td></td>
</tr>
<tr>
<td>Sensor connection</td>
<td>Wrong or damaged sensor</td>
<td></td>
</tr>
</tbody>
</table>
| PillCam recorder freezes                     | Possible static electricity discharge      | • Perform Hard Reset on the PillCam recorder  
                                  |                                        | • Contact Customer Support          |
| Cannot initialize PillCam recorder DR3       | Wrong recorder bar is selected             | Select correct recorder bar                                           |
| No communication between the PillCam recorder and PillCam Desktop software | Recorder not inserted into cradle properly | • Clean the contacts with alcohol wipes  
                                  |                                        | • Firmly insert the recorder into the cradle |
## PillCam Recorder DR2

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot initialize PillCam recorder DR2</td>
<td>Wrong recorder bar is selected</td>
<td>Select correct recorder bar</td>
</tr>
<tr>
<td>Computer does not recognize PillCam recorder DR2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cannot create video</td>
<td>Wrong recorder bar is selected</td>
<td>Select PillCam recorder DR2 Recorder bar</td>
</tr>
<tr>
<td>Error message is displayed</td>
<td></td>
<td>Send error message to Customer Support</td>
</tr>
<tr>
<td>Not enough free space... message is displayed</td>
<td></td>
<td>Delete PRRs from hard drive</td>
</tr>
<tr>
<td>Workstation freezes during video creation</td>
<td></td>
<td>Contact Customer Support</td>
</tr>
</tbody>
</table>
| Capsule LED (right) does not blink in blue when capsule is activated (LED is orange) | • Capsule failure  
• PillCam recorder DR2 failure | 1 Return capsule to blister.  
2 Activate second capsule.  
3 If problem persists, contact Customer Support.  
4 Send malfunctioning capsules to Given Imaging. |
| Capsule LED (right) blinks in orange once every five seconds when more than six hours have passed since ingestion | • Capsule failure  
• PillCam recorder DR2 failure | 1 Wait until 8 hours have passed and take off the sensors.  
2 Send video on CD/DVD. |
| Capsule LED (right) blinks in orange once every five seconds when less than six hours have passed since ingestion | • Capsule failure  
• PillCam recorder DR2 failure | Contact Customer Support |
| PillCam recorder DR2 shuts down during the procedure | PillCam recorder DR2 malfunction | 1 Turn PillCam recorder DR2 off.  
2 Take out the battery pack and place it back in.  
3 Turn PillCam recorder DR2 on.  
4 If problem persists, contact Customer Support |
| Battery exhausted | | Replace battery and continue procedure. |
| Canceling Data Copy displays error message that Video Copy was unsuccessful | Canceling the Data Copy in mid-sequence triggers Video Copy message | |
## Error Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Full name not defined for this user.</strong></td>
<td>In order to enable electronic signatures in the CE report, the full name field (full name will appear in electronic signature) must be defined in the user’s relevant Windows account.</td>
</tr>
<tr>
<td><strong>Please contact your IT system administrator.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Electronic signature failed.</strong></td>
<td>In order to enable electronic signatures in CE report, the user’s relevant Windows account must be enabled for remote connection login. Possible reasons for this error message include:</td>
</tr>
</tbody>
</table>
| **Please contact your IT system administrator.**                       | • Password Expired  
• Account Restrictions  
• Invalid Logon Hours  
• Account Lockout (or expired or disabled)                                                                                                     |
| **You do not have permission to access the Regimen Manager.**          | In order to allow physicians to edit and approve their regimens, in the Settings screen, under the Other tab, define an existing folder as the Regimens Directory.                                               |
| **Please contact your system administrator.**                          | This folder must be open for read and write permissions for the relevant users.                                                                                                                                 |
| **Patient Check-in procedure failed. Reason: Failed to update recorder software version.** | Turn the recorder off and then on before the next check-in attempt. If the upgrade fails again, contact customer support.                                                                               |

For LED behavior, see [LED Display](#) on page 72. For error messages displayed on the PillCam recorder screen, see [Error Messages](#) on page 196.
Low Signal

If a low signal is detected during the examination, the following message appears.

A low signal detected during the examination may be due to:

- Improper use of the sensor array/sensor belt
- A defective sensor array/sensor belt
- A PillCam recorder malfunction

If this message is displayed, Contact Customer Support.

Click **OK** to close the message.
Appendix C

Technical Description

This section provides an overview of capsule endoscopy and provides a description of the PillCam Endoscopy System.

This chapter includes the following main topics:

- **System Labeling** on page 199
- **Essential Performance** on page 201
- **Warnings** on page 201
- **Cautions** on page 202
- **System Specifications** on page 204
- **Guidance and Manufacturer's Declarations** on page 213

### System Labeling

The following table lists the labels attached to various components of the PillCam Capsule Endoscopy System.

<table>
<thead>
<tr>
<th>Labeling</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="MR_icon" alt="MR icon" /></td>
<td>PillCam capsules are MR unsafe.</td>
</tr>
<tr>
<td><img src="CAUTION_icon" alt="CAUTION icon" /></td>
<td>The PillCam capsule should not be stored and used near any powerful magnetic fields such as the one created by an MRI.</td>
</tr>
<tr>
<td><img src="X_icon" alt="X icon" /></td>
<td>The PillCam capsule is intended for single use only.</td>
</tr>
<tr>
<td><img src="i_icon" alt="i icon" /></td>
<td>Attention! Consult the documentation provided with the PillCam Capsule Endoscopy System.</td>
</tr>
<tr>
<td><img src="Temperature_limits_icon" alt="Temperature limits" /></td>
<td>Temperature limits</td>
</tr>
<tr>
<td><img src="Non-ionizing_radiation_icon" alt="Non-ionizing radiation" /></td>
<td>Non-ionizing radiation</td>
</tr>
<tr>
<td><img src="Type_BF_equipment_icon" alt="Type BF equipment" /></td>
<td>Type BF equipment</td>
</tr>
<tr>
<td><img src="RoHs_icon" alt="RoHs" /></td>
<td>RoHs</td>
</tr>
</tbody>
</table>
Capsule Labeling

Each box has a label at the bottom as shown below. Each capsule is marked with the expiration date, lot number, and a unique capsule ID code.

<table>
<thead>
<tr>
<th>Labeling</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>FCC</td>
<td>FCC compliance</td>
</tr>
<tr>
<td>CE mark</td>
<td>Ingress protection</td>
</tr>
<tr>
<td>C-Tick mark</td>
<td>Do not Iron</td>
</tr>
<tr>
<td>CSA mark</td>
<td>Latex free</td>
</tr>
<tr>
<td>Expiration date</td>
<td>Machine wash - warm</td>
</tr>
<tr>
<td>Recycle</td>
<td>Do not tumble dry</td>
</tr>
<tr>
<td>Lot number</td>
<td>Do not dry clean</td>
</tr>
<tr>
<td>Indoor use only</td>
<td>Do not use bleach</td>
</tr>
</tbody>
</table>
Essential Performance

PillCam Capsules

ON-Mode
Data transmitting to PillCam recorder is considered to be essential performance of the PillCam capsules. The PillCam capsules shall transmit data continuously monitored by on-line image display as received by PillCam recorder.

OFF-Mode
No unintentional transmissions are allowed.

PillCam Recorder DR2 and PillCam Recorder DR3
Data receiving by PillCam recorder is considered to be essential performance of the PillCam recorder DR2 and PillCam recorder DR3.

Warnings

• PillCam Capsule Endoscopy System and its components need special precautions regarding EMC and need to be installed and put into service according to the EMC information provided in the accompanying documents.
• Portable and mobile RF communications equipment can affect the PillCam video capsule and the PillCam recorder.
• PillCam video capsules and PillCam recorder should not be used adjacent to or stacked with other equipment and that if adjacent or stacked use is necessary, the equipment or system should be observed to verify normal operation in the configuration in which it will be used.
• PillCam video capsules and PillCam recorder may be interfered with by other equipment, even if that other equipment complies with CISPR emission requirements.
• Do not disassemble or modify the battery pack. The battery pack is equipped with built-in safety/protection features. Should these features be disabled, the battery pack can leak acid, overheat, emit smoke, burst and/or ignite.
• Do not use or leave the battery pack of the PillCam recorder near a heat source such as a fire or a heater (+80°C or higher). If the resin separator should be damaged owing to overheating, internal short-circuiting may occur to the battery pack, possibly leading to acid leakage, smoke emission, bursting and/or ignition of the battery pack.
• Do not immerse the battery pack in water or seawater and do not allow it to get wet. Otherwise, the protective features in it can be damaged, it can be charged with extremely high current and voltage, abnormal chemical reactions may occur in it, possibly leading to acid leakage, smoke emission, bursting and/or ignition.
• Do not recharge the battery pack near fire or in extremely hot weather. Otherwise, hot temperatures can trigger its built-in protective features, inhibiting recharging, or can damage the built-in protective features, causing it to be charged with an extremely high current and voltage.
and, as a result, abnormal chemical reactions can occur in it, possibly leading to acid leakage, overheating, smoke emission, bursting and/or ignition.

- To recharge the battery pack, use the PillCam recorder cradle and observe the recharging conditions. A recharging operation under non-conforming recharging conditions (higher temperature and larger voltage/current than specified, modified battery charger, etc.) can cause the battery pack to be overcharged, or charged with extremely high current, abnormal chemical reaction can occur in it, possibly leading to acid leakage, overheating, smoke emission, bursting and/or ignition.

- Do not pierce the battery pack with a nail or other sharp objects, strike it with a hammer, or step on it. Otherwise, the battery pack will become damaged and deformed, internal short-circuiting can occur, possibly leading to acid leakage, overheating, smoke emission, bursting and/or ignition.

- Do not strike or throw the battery pack. The impact might cause leakage, overheating, smoke emission, bursting and/or ignition. Also, if the protective feature in it becomes damaged, it could become charged with an extremely high current and voltage, abnormal chemical reactions can occur, which can lead to acid leakage, overheating smoke emission, bursting and/or ignition.

- Do not use an apparently damaged or deformed battery pack. Otherwise, acid leakage, overheating, smoke emission, bursting and/or ignition of the battery pack may occur.

- If the battery pack leaks and the electrolyte gets into the eyes, do not rub them. Instead, rinse the eyes with clean running water and immediately seek medical attention. Otherwise, eye injury may result.

- If recharging operation fails to complete even when a specified recharging time has elapsed, immediately stop further recharging. Otherwise, acid leakage, overheating, smoke emission, bursting and/or ignition can occur.

- Do not put the battery pack into a microwave oven or pressurized container. Rapid heating or disrupted sealing can lead to acid leakage, overheating, smoke emission, bursting and/or ignition.

- If the battery pack leaks or gives off a bad odor, remove it from any exposed flame. Otherwise, the leaking electrolyte may catch fire and the battery pack may emit smoke, burst or ignite.

- If the battery pack gives off an odor, generates heat, becomes discolored or deformed, or in any way appears abnormal during use, recharging or storage, immediately remove it from the equipment or cradle and stop using it. Otherwise, the problematic battery pack can develop acid leakage, overheating, smoke emission, bursting and/or ignition.

- The use of accessories, transducers and cables other than those supplied or approved by Given Imaging, as replacement parts for internal PillCam recorder components, may result in increased emissions or decreased immunity of the PillCam Capsule Endoscopy System.

**Cautions**

- Do not use or subject the battery pack to intense sunlight or hot temperatures such as in a car in hot weather. Otherwise, acid leakage, overheating and/or smoke emission can occur. Also, its guaranteed performance will be lost and/or its service life will be shortened.

- The battery pack incorporates built-in safety devices. Do not use it in a location where static electricity (greater than the manufacturer’s guarantee) may be present. Otherwise, the safety devices can be damaged, possibly leading to acid leakage, overheating, smoke emission, bursting and/or ignition.
• The guaranteed recharging temperature range is 0°C to +45°C. A recharging operation outside this temperature range can lead to acid leakage and/or overheating of the battery pack and may cause damage to it.

• If acid leaking from the battery pack comes into contact with your skin or clothing, immediately wash it away with running water. Otherwise, skin inflammation can occur.

• For recharging procedures, refer to Charging on page 70.

• If you find rust, a bad odor, overheating and/or other irregularities when using the battery pack for the first time, return it to your supplier or vendor.
# System Specifications

### Note
- Specifications are subject to change without prior notice and without any obligation to users on the part of the manufacturer.
- Specifications are rounded to the appropriate decimal place.

## PillCam SB 2 Capsule

<table>
<thead>
<tr>
<th>Properties</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Physical</strong></td>
<td></td>
</tr>
<tr>
<td>Dimensions</td>
<td>Length: 26.3 mm&lt;br&gt;Diameter: 11.4 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>2.9 g</td>
</tr>
<tr>
<td>Material</td>
<td>Biocompatible plastic</td>
</tr>
<tr>
<td><strong>Optical</strong></td>
<td></td>
</tr>
<tr>
<td>Illumination</td>
<td>4 white light emitting diodes</td>
</tr>
<tr>
<td># of imaging heads</td>
<td>1</td>
</tr>
<tr>
<td>Field of view</td>
<td>156° (Optical field of view at 4.5 mm from top cover per ISO-8600-3)&lt;br&gt;130° (Optical field of view from entrance pupil per FDA Method)</td>
</tr>
<tr>
<td>Effective visibility</td>
<td>Distance: 3 cm</td>
</tr>
<tr>
<td>Min. detectable object</td>
<td>At least 0.1 mm</td>
</tr>
<tr>
<td>Frequency</td>
<td>434.1 MHz</td>
</tr>
<tr>
<td>Band width</td>
<td>1.6 MHz</td>
</tr>
<tr>
<td>Modulation</td>
<td>MSK</td>
</tr>
<tr>
<td>ERP [nW]</td>
<td>16</td>
</tr>
<tr>
<td><strong>Operational</strong></td>
<td></td>
</tr>
<tr>
<td>Frame rate</td>
<td>either 2 or 4 fps (two capsule versions)</td>
</tr>
<tr>
<td>Operating time</td>
<td>≥ 8 hours</td>
</tr>
<tr>
<td>Chemical safety</td>
<td>Resistant to dissolution in pH=2 to pH=8</td>
</tr>
<tr>
<td>Battery type</td>
<td>Silver Oxide batteries, Mercury Free</td>
</tr>
<tr>
<td>Operating temperature</td>
<td>20-40 °C</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>0-25 °C</td>
</tr>
</tbody>
</table>
## PillCam SB 3 Capsule

<table>
<thead>
<tr>
<th>Properties</th>
<th>Physical</th>
<th>Optical</th>
<th>Operational</th>
<th>Downlink communication</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dimensions</strong></td>
<td>Length: 26.2 mm</td>
<td>Illumination 4 white light emitting diodes</td>
<td>Frame rate 2 fps or 2-6 fps</td>
<td>Operating frequency 13.6 MHz</td>
</tr>
<tr>
<td></td>
<td>Diameter: 11.4 mm</td>
<td># of imaging heads 1</td>
<td>Operating time ≥ 8 hours</td>
<td>Receiver Bandwidth ± 150 kHz</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>3.0 g</td>
<td>Field of view 156° ISO-8600-3</td>
<td>Chemical safety Resistant to dissolution in pH=2 to pH=8</td>
<td></td>
</tr>
<tr>
<td><strong>Material</strong></td>
<td>Biocompatible plastic</td>
<td>Effective visibility 156° (Optical field of view at 4.5 mm from top cover per ISO-8600-3)</td>
<td>Battery type Silver Oxide batteries, Mercury Free</td>
<td></td>
</tr>
<tr>
<td><strong>Optical Illumination</strong></td>
<td>3.2 MHz @ 2.7 Mbps; 6.5 MHz @ 5.4 Mbps</td>
<td>Min. detectable object At least 0.07 mm</td>
<td>Operating temperature 20-40 °C</td>
<td></td>
</tr>
<tr>
<td><strong>Frequency</strong></td>
<td>434.1 MHz</td>
<td>Modulation MSK</td>
<td>Storage temperature 0-25 °C</td>
<td></td>
</tr>
<tr>
<td><strong>Band width</strong></td>
<td>ERP [nW] ~20</td>
<td>ERP [nW] ~20</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Modulation</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>ERP [nW]</strong></td>
<td>~20</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Downlink</strong></td>
<td>Receiver Bandwidth ± 150 kHz</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# PillCam UGI Capsule

| Properties | Dimensions | Length: 32.3 mm $\pm$ 0.5 mm
| Material | Biocompatible plastic |
| Optical | Illumination | 4 white light emitting diodes on each side |
| # of optical heads | 2 |
| Field of view | 172° ISO-8600-3 |
| Effective visibility | Distance: 3 cm |
| Min. detectable object | At least 0.1 mm |
| Frequency | 434.1 MHz |
| Band width | 9.7 MHz |
| Modulation | MSK |
| ERP [nW] = 8 |
| Operational | Frame rate | 18–35 fps |
| Operating time | 90 min |
| Chemical safety | Resistant to dissolution in pH=2 to pH=8 |
| Battery type | Silver Oxide batteries, Mercury Free |
| Operating temperature | 20-40°C |
| Storage temperature | 0-25°C |
# PillCam COLON 2 Capsule

<table>
<thead>
<tr>
<th>Properties</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Physical</strong></td>
<td></td>
</tr>
<tr>
<td>Dimensions</td>
<td>Length: 32.3 mm + 0.5 mm</td>
</tr>
<tr>
<td></td>
<td>Diameter: 11.6 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>2.9 g ± 0.1 g</td>
</tr>
<tr>
<td>Material</td>
<td>Biocompatible plastic</td>
</tr>
<tr>
<td><strong>Optical</strong></td>
<td></td>
</tr>
<tr>
<td># of optical heads</td>
<td>2</td>
</tr>
<tr>
<td>Illumination</td>
<td>4 white light emitting diodes on each side</td>
</tr>
<tr>
<td>Field of view</td>
<td>172° ISO-8600-3</td>
</tr>
<tr>
<td>Effective visibility</td>
<td>Distance: 3 cm</td>
</tr>
<tr>
<td>Min. detectable object</td>
<td>At least 0.1 mm</td>
</tr>
<tr>
<td><strong>Operational</strong></td>
<td></td>
</tr>
<tr>
<td>Operating time</td>
<td>Minimum of 10 hours</td>
</tr>
<tr>
<td>Chemical safety</td>
<td>Resistant to dissolution in pH=2 to pH=8</td>
</tr>
<tr>
<td>Battery type</td>
<td>Silver Oxide batteries, Mercury Free</td>
</tr>
<tr>
<td>Operating temperature</td>
<td>20-40 °C</td>
</tr>
<tr>
<td>Band width</td>
<td>3.2 MHz @ 2.7 Mbps; 9.7 MHz @ 8.1 Mbps</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>0-25 °C</td>
</tr>
<tr>
<td><strong>Uplink communication</strong></td>
<td>Operating frequency</td>
</tr>
<tr>
<td></td>
<td>Frame rate</td>
</tr>
<tr>
<td></td>
<td>Data rate</td>
</tr>
<tr>
<td></td>
<td>Modulation type</td>
</tr>
<tr>
<td></td>
<td>Effective radiated power</td>
</tr>
<tr>
<td><strong>Downlink communication</strong></td>
<td>Operating frequency</td>
</tr>
<tr>
<td></td>
<td>Receiver Bandwidth</td>
</tr>
</tbody>
</table>
## PillCam Crohn’s Capsule

### Properties

| Physical          | Dimensions       | Length: 32.3 mm + 0.5 mm  
|                  |                  | Diameter: 11.6 mm       |
|                  | Weight           | 2.9 g ± 0.1 g          |
|                  | Material         | Biocompatible plastic  |
| Optical          | # of optical heads | 2                   |
|                  | Illumination     | 4 white light emitting diodes on each side |
|                  | Field of view    | 172° ISO-8600-3       |
|                  | Effective visibility | Distance: 3 cm       |
|                  | Min. detectable object | At least 0.1 mm    |
| Operational      | Operating time   | Minimum of 10 hours   |
|                  | Chemical safety  | Resistant to dissolution in pH=2 to pH=8 |
|                  | Battery type     | Silver Oxide batteries, Mercury Free |
|                  | Operating temperature | 20–40 °C            |
|                  | Band width       | 3.2 MHz @ 2.7 Mbps;  
|                  |                  | 9.7 MHz @ 8.1 Mbps    |
|                  | Storage temperature | 0–25 °C              |
| Uplink communication | Operating frequency | 434.1 MHz          |
|                  | Frame rate       | 4–35 fps              |
|                  | Data rate        | 2.7 Mbps and 8.1 Mbps |
|                  | Modulation type  | MSK/Digital data      |
|                  | Effective radiated power | -44.56 dBm       |
| Downlink communication | Operating frequency | 13.6 MHz          |
|                  | Receiver Bandwidth | ± 150 kHz             |
## Sensor Array PillCam Recorder DR2

<table>
<thead>
<tr>
<th>Versions: SB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reception antenna</td>
</tr>
<tr>
<td>Color</td>
</tr>
<tr>
<td>Material</td>
</tr>
<tr>
<td>SB sensor array</td>
</tr>
</tbody>
</table>

## Sensor Array PillCam Recorder DR3

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reception antenna</td>
</tr>
<tr>
<td>Sensor size</td>
</tr>
<tr>
<td>Color</td>
</tr>
<tr>
<td>Material</td>
</tr>
<tr>
<td>Antennas wire material</td>
</tr>
<tr>
<td>Transmission antenna</td>
</tr>
<tr>
<td>Size</td>
</tr>
<tr>
<td>Color</td>
</tr>
<tr>
<td>Material</td>
</tr>
</tbody>
</table>

## Sensor Array PillCam Recorder DR3 - Small

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reception antenna</td>
</tr>
<tr>
<td>Sensor size</td>
</tr>
<tr>
<td>Color</td>
</tr>
<tr>
<td>Material</td>
</tr>
<tr>
<td>Antennas wire material</td>
</tr>
<tr>
<td>Transmission antenna</td>
</tr>
<tr>
<td>Size</td>
</tr>
<tr>
<td>Color</td>
</tr>
<tr>
<td>Material</td>
</tr>
</tbody>
</table>
## PillCam Recorder DR2/DR2C

<table>
<thead>
<tr>
<th>Properties</th>
<th>Physical</th>
<th>Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recording capacity</td>
<td></td>
<td>PillCam recorder DR2: @ 2fps for 10 hours</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PillCam recorder DR2C: @ 4fps for 10 hours</td>
</tr>
<tr>
<td>Weight</td>
<td></td>
<td>500 g, including battery pack</td>
</tr>
<tr>
<td>Operational Power</td>
<td></td>
<td>6-10 V DC, 100-250 mA</td>
</tr>
<tr>
<td>Battery type</td>
<td></td>
<td>Internal, Li-Ion, 7.2 V, 4400 mAH</td>
</tr>
<tr>
<td>Battery Pack weight</td>
<td></td>
<td>200 g</td>
</tr>
<tr>
<td>Operating temp.</td>
<td></td>
<td>0-40 °C</td>
</tr>
<tr>
<td>Storage temp.</td>
<td></td>
<td>0-55 °C</td>
</tr>
<tr>
<td>Storage and Operating</td>
<td></td>
<td>Up to 85%</td>
</tr>
<tr>
<td>humidity</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Storage and Operating</td>
<td></td>
<td>790-520 mmHg</td>
</tr>
<tr>
<td>pressure</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Cradle PillCam Recorder DR2

<table>
<thead>
<tr>
<th>Properties</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>890 g</td>
</tr>
<tr>
<td>Size (without battery inserted)</td>
<td>14 [D] x 165 [W] x 97 [H] mm</td>
</tr>
<tr>
<td>Color</td>
<td>Black</td>
</tr>
<tr>
<td>Power mains range</td>
<td>100 to 240 V</td>
</tr>
</tbody>
</table>
# PillCam Recorder DR3

## Properties

<table>
<thead>
<tr>
<th>Physical</th>
<th>Software</th>
<th>Proprietary firmware</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recording capacity</td>
<td>Up to 15 hours @ LCD OFF</td>
<td></td>
</tr>
<tr>
<td>Weight</td>
<td>500 g, including battery pack</td>
<td></td>
</tr>
<tr>
<td>Operational Power</td>
<td>3V - 4.2V DC, 0.33A - 0.79A</td>
<td></td>
</tr>
<tr>
<td>Battery type</td>
<td>Internal, Li-on, 3.7 V typical 8000 mAH</td>
<td></td>
</tr>
<tr>
<td>Operating temp.</td>
<td>0-40 °C</td>
<td></td>
</tr>
<tr>
<td>Storage temp.</td>
<td>0-55 °C</td>
<td></td>
</tr>
<tr>
<td>Storage and Operating humidity</td>
<td>Up to 85%</td>
<td></td>
</tr>
<tr>
<td>Storage and Operating pressure</td>
<td>790-520 mmHg</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Receiver (Rx)</th>
<th>Operating frequency</th>
<th>434.1 MHz</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bandwidth of the receiving section in this band</td>
<td>10 MHz</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transmitter</th>
<th>Operating frequency</th>
<th>13.6 MHz</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Frequency band</td>
<td>ISM</td>
</tr>
<tr>
<td></td>
<td>Modulation type</td>
<td>Linear Chirp</td>
</tr>
<tr>
<td></td>
<td>Type of modulated signal</td>
<td>Digital data</td>
</tr>
<tr>
<td></td>
<td>Effective radiated power</td>
<td>-27.4 dBm</td>
</tr>
</tbody>
</table>
# PillCam Recorder DR3 SDHC Memory Card

<table>
<thead>
<tr>
<th>Properties</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>24 mm x 32 mm x 2 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>2.5 g</td>
</tr>
<tr>
<td>Capacity</td>
<td>&gt;16 GB</td>
</tr>
<tr>
<td>Rating</td>
<td>Class 10, Sequential Read/Write 20 MB/s</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>-40°C to 85°C</td>
</tr>
<tr>
<td>Operating temperature</td>
<td>-25°C to 85°C</td>
</tr>
<tr>
<td>Security</td>
<td>Built-in write-protect switch prevents accidental data loss</td>
</tr>
<tr>
<td>Compatibility</td>
<td>SDHC host devices; not compatible with standard SD-enabled devices/ readers</td>
</tr>
<tr>
<td>File format</td>
<td>FAT 32</td>
</tr>
</tbody>
</table>

# Cradle PillCam Recorder DR3

<table>
<thead>
<tr>
<th>Properties</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>250 g</td>
</tr>
<tr>
<td>Operating temperature</td>
<td>0-45°C</td>
</tr>
<tr>
<td>Color</td>
<td>White &amp; Black</td>
</tr>
</tbody>
</table>
| Power mains range   | Input Voltage: Maximum 5.25 V, Min 4.75 V  
                      | Input Current: Maximum 4 A, Min 100 mA     |

# DC Power Supply

<table>
<thead>
<tr>
<th>Properties</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>300 g</td>
</tr>
<tr>
<td>Input connector</td>
<td>3 pole AC inlet IEC320-C14C</td>
</tr>
<tr>
<td>Input voltage</td>
<td>90-246 VAC</td>
</tr>
</tbody>
</table>
### Output voltage
- 5 V DC, 5 A

### Protections
- Short circuit/Over load/Over voltage/Over temp.

---

## PillCam Desktop Software

<table>
<thead>
<tr>
<th>Software</th>
<th>PillCam Software proprietary, version 9</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Languages</strong></td>
<td>English/French/German/Italian/Spanish/Portuguese/Dutch/Swedish/Finnish/Danish/Chinese-Mandarin/Korean/Russian/Greek</td>
</tr>
<tr>
<td><strong>Data export</strong></td>
<td>JPEG Images, (MPEG) Video clips, grml (Given proprietary) files, PDF Reports, generic XML-format Capsule Endoscopy report data</td>
</tr>
<tr>
<td><strong>Displayed data</strong></td>
<td>Single and multi images, Timebar, Colorbar with region specific color and other diagnostic data</td>
</tr>
<tr>
<td><strong>Event marker</strong></td>
<td>Annotated thumbnails</td>
</tr>
<tr>
<td><strong>Viewing rate</strong></td>
<td>5–80 fps</td>
</tr>
<tr>
<td><strong>Viewing modes</strong></td>
<td>Single, Dual, Quad, Mosaic, and Collage view, Dual-head view (UGI and COLON/Crohn’s)</td>
</tr>
<tr>
<td><strong>Run modes</strong></td>
<td>View, Automatic, QuickView, SBI, Top 100</td>
</tr>
</tbody>
</table>

---

## Guidance and Manufacturer's Declarations

### PillCam Capsules

**Guidance and manufacturer’s declaration - electronic emissions**

The PillCam capsules are intended for use in the electromagnetic environment specified below. The customer or the user of the PillCam capsules should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Emissions test</th>
<th>Compliance</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF emissions CISPR 11</td>
<td>Group 1</td>
<td>The PillCam capsules use RF energy only for its internal function. Therefore, its RF emissions are very low and are not likely to cause any interference in nearby electronic equipment.</td>
</tr>
<tr>
<td>RF emissions CISPR 11</td>
<td>Class B</td>
<td>The PillCam capsules are suitable for use in all establishments including domestic establishments and those directly connected to the public low-voltage power supply network that supplies buildings used for domestic purposes.</td>
</tr>
<tr>
<td>Harmonic emissions IEC 61000-3-2</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>Voltage fluctuations/ flicker emissions IEC 61000-3-3</td>
<td>Not applicable</td>
<td></td>
</tr>
</tbody>
</table>
### Guidance and manufacturer’s declaration - electronic immunity

The PillCam capsules are intended for use in the electromagnetic environment specified below. The customer or the user of the PillCam capsules should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrostatic discharge (ESD)</td>
<td>±6 kV contact</td>
<td>±6 kV contact</td>
<td>Floors should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the relative humidity should be at least 30%.</td>
</tr>
<tr>
<td>IEC 60000-4-2</td>
<td>±8 kV air</td>
<td>±8 kV air</td>
<td></td>
</tr>
<tr>
<td>Electrical fast transient/burst</td>
<td>±2 kV for power supply lines</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>IEC 60000-4-4</td>
<td>±1 kV for input/output lines</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Surge</td>
<td>±1 kV line(s) to line(s)</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>IEC 60000-4-5</td>
<td>±2 kV line(s) to earth</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Voltage dips, short interruptions and voltage variations on power supply input lines</td>
<td>&lt;5% $U_T$ (95% dip in $U_T$) for 0.5 cycle</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>IEC 60000-4-11</td>
<td>40% $U_T$ (60% dip in $U_T$) for 5 cycles</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td></td>
<td>70% $U_T$ (30% dip in $U_T$) for 25 cycles</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td></td>
<td>&lt;5% $U_T$ (95% dip in $U_T$) for 5 sec</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Power frequency (50/60 Hz) magnetic field</td>
<td>3 A/m</td>
<td>3 A/m</td>
<td>Power frequency magnetic fields should be at levels characteristic of a typical location in a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>IEC 60000-4-8</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** $U_T$ is the AC mains voltage prior to application of the test level.
**Guidance and manufacturer’s declaration - electronic immunity**

The PillCam capsules are intended for use in the electromagnetic environment specified below. The customer or the user of the PillCam capsules should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conducted RF</td>
<td>3 VRMS</td>
<td>Not applicable</td>
<td>Portable and mobile RF communications equipment should be used no closer to any part of a PillCam capsule, including cables, than the recommended separation distance calculated from the equation applicable to the frequency of the transmitter.</td>
</tr>
<tr>
<td>IEC 61000-4-6</td>
<td>150 kHz to 80 MHz</td>
<td>Not applicable</td>
<td>Recommended separation distance</td>
</tr>
<tr>
<td>Radiated RF</td>
<td>3 V/m</td>
<td>3 V/m</td>
<td>d = $1.2\sqrt{P}$ 80 MHz to 800 MHz</td>
</tr>
<tr>
<td>IEC 61000-4-3</td>
<td>80 MHz to 2.5 GHz</td>
<td>d = $2.3\sqrt{P}$ 800 MHz to 2.5 GHz</td>
<td></td>
</tr>
</tbody>
</table>

Note 1: At 80 MHz and 800 MHz, the higher frequency range applies.

Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.

Note 3: P is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer and d is the recommended separation distance in meters (m).

Note 4: Field strengths from fixed RF transmitters, as determined by an electromagnetic site survey a, should be less than the compliance level in each frequency range b.

Note 5: Interference may occur in the vicinity of equipment marked with the following symbol:

![radio waves symbol]

a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the PillCam capsules are used exceeds the applicable RF compliance level above, the PillCam capsules should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as re-orienting or relocating the PillCam capsules.

b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
Recommended separation distances between portable and mobile RF communications equipment and the PillCam capsules

The PillCam capsules are intended for use in an electromagnetic environment in which radiated RF disturbances are controlled. The customer or the user of the PillCam capsules can help prevent electromagnetic interference by maintaining a minimum distance between portable and mobile RF communications equipment (transmitters) and the PillCam capsules as recommended below, according to the maximum output power of the communications equipment.

<table>
<thead>
<tr>
<th>Rated maximum output power of transmitter [W]</th>
<th>Separation distance according to frequency of transmitter [m]</th>
<th>150 kHz to 80 MHz</th>
<th>80 MHz to 800 MHz</th>
<th>800 MHz to 2.5 GHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.01</td>
<td>d = 1.2√P</td>
<td>0.12</td>
<td>0.23</td>
<td></td>
</tr>
<tr>
<td>0.1</td>
<td>Not applicable</td>
<td>0.38</td>
<td>0.73</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Not applicable</td>
<td>1.2</td>
<td>2.3</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Not applicable</td>
<td>3.8</td>
<td>7.3</td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>Not applicable</td>
<td>12</td>
<td>23</td>
<td></td>
</tr>
</tbody>
</table>

For transmitters rated at a maximum output power not listed above, the recommended separation distance \( d \) in meters (m) can be determined using the equation applicable to the frequency of the transmitter, where \( P \) is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.

Note 1: At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.

**PillCam Recorder DR2/DR2C**

**Guidance and manufacturer’s declaration - electronic emissions**

The PillCam recorder DR2 is intended for use in the electromagnetic environment specified below. The customer or the user of the PillCam recorder DR2 should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Emissions test</th>
<th>Compliance</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF emissions</td>
<td>Group 1</td>
<td>The PillCam recorder DR2 uses RF energy only for its internal function. Therefore, its RF emissions are very low and are not likely to cause any interference in nearby electronic equipment.</td>
</tr>
<tr>
<td>CISPR 11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RF emissions</td>
<td>Class B</td>
<td>The PillCam recorder DR2 is suitable for use in all establishments including domestic establishments and those directly connected to the public low-voltage power supply network that supplies buildings used for domestic purposes.</td>
</tr>
<tr>
<td>CISPR 11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Harmonic emissions</td>
<td>Class A</td>
<td></td>
</tr>
<tr>
<td>IEC 61000-3-2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voltage fluctuations/</td>
<td></td>
<td></td>
</tr>
<tr>
<td>flicker emissions</td>
<td>Complies</td>
<td></td>
</tr>
<tr>
<td>IEC 61000-3-3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Guidance and manufacturer’s declaration - electronic immunity**

The PillCam recorder DR2 is intended for use in the electromagnetic environment specified below. The customer or the user of the PillCam recorder DR2 should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrostatic discharge (ESD)</td>
<td>±6 kV contact</td>
<td>±6 kV contact</td>
<td>Floors should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the relative humidity should be at least 30%.</td>
</tr>
<tr>
<td>IEC 61000-4-2</td>
<td>±8 kV air</td>
<td>±8 kV air</td>
<td></td>
</tr>
<tr>
<td>Electrical fast transient/burst</td>
<td>±2 kV for power supply lines</td>
<td>±2 kV for power supply lines</td>
<td>Mains power quality should be that of a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>IEC 61000-4-4</td>
<td>±1 kV for input/output lines</td>
<td>±1 kV for input/output lines</td>
<td></td>
</tr>
<tr>
<td>Surge</td>
<td>±1 kV line(s) to line(s)</td>
<td>±1 kV line(s) to line(s)</td>
<td>Mains power quality should be that of a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>IEC 61000-4-5</td>
<td>±2 kV line(s) to earth</td>
<td>±2 kV line(s) to earth</td>
<td></td>
</tr>
<tr>
<td>Voltage dips, short interruptions and voltage variations on power supply input lines</td>
<td>&lt;5% $U_T$ (95% dip in $U_T$) for 0.5 cycle</td>
<td>&lt;5% $U_T$ (95% dip in $U_T$) for 0.5 cycle</td>
<td>Mains power quality should be that of a typical commercial or hospital environment. If the user of the PillCam recorder DR2 requires continued operation during power mains interruptions, it is recommended that the PillCam recorder DR2 be powered from an un-interruptible power supply or a battery.</td>
</tr>
<tr>
<td>IEC 61000-4-11</td>
<td>40% $U_T$ (60% dip in $U_T$) for 5 cycles</td>
<td>40% $U_T$ (60% dip in $U_T$) for 5 cycles</td>
<td></td>
</tr>
<tr>
<td></td>
<td>70% $U_T$ (30% dip in $U_T$) for 25 cycles</td>
<td>70% $U_T$ (30% dip in $U_T$) for 25 cycles</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;5% $U_T$ (95% dip in $U_T$) for 5 sec</td>
<td>&lt;5% $U_T$ (95% dip in $U_T$) for 5 sec</td>
<td></td>
</tr>
<tr>
<td>Power frequency (50/60 Hz) magnetic field</td>
<td>3 A/m</td>
<td>3 A/m</td>
<td>Power frequency magnetic fields should be at levels characteristic of a typical location in a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>IEC 61000-4-8</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** $U_T$ is the AC mains voltage prior to application of the test level.
Guidance and manufacturer’s declaration - electronic immunity

The PillCam recorder DR2 is intended for use in the electromagnetic environment specified below. The customer or the user of the PillCam recorder DR2 should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conduction RF</td>
<td>3 VRMS</td>
<td>3V_ms</td>
<td>Portable and mobile RF communications equipment should be used no closer to any part of PillCam recorder DR2, including cables, than the recommended separation distance calculated from the equation applicable to the frequency of the transmitter.</td>
</tr>
<tr>
<td>IEC 61000-4-6</td>
<td>150 kHz to 80 MHz</td>
<td></td>
<td>d = 1.2sqrt(P)</td>
</tr>
<tr>
<td>Radiated RF</td>
<td>3 V/m</td>
<td>3 V/m</td>
<td>80 MHz to 800 MHz range</td>
</tr>
<tr>
<td>IEC 61000-4-3</td>
<td>80 MHz to 2.5 GHz</td>
<td></td>
<td>d = 2.3sqrt(P) 800 MHz to 2.5 GHz range</td>
</tr>
</tbody>
</table>

Note 1: At 80 MHz and 800 MHz, the higher frequency range applies.
Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.
Note 3: P is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer and d is the recommended separation distance in meters (m).
Note 4: Field strengths from fixed RF transmitters, as determined by an electromagnetic site survey, should be less than the compliance level in each frequency range.
Note 5: Interference may occur in the vicinity of equipment marked with the following symbol:

a) Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the PillCam recorder DR2 is used exceeds the applicable RF compliance level above, the PillCam recorder DR2 should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as re-orienting or relocating the PillCam recorder DR2.
b) Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
**PillCam Recorder DR3**

**Guidance and manufacturer’s declaration - electromagnetic emissions**

The PillCam recorder DR3 is intended for use in the electromagnetic environment specified below. The customer or the user of the PillCam recorder DR3 should assure that it is used in such an environment.

**Emissions test** | **Compliance** | **Electromagnetic environment - guidance**
---|---|---
RF emissions | Group 1 | The PillCam recorder DR3 uses RF energy only for its internal function. Therefore, its RF emissions are very low and are not likely to cause any interference in nearby electronic equipment.
CISPR 11 | Class B | The PillCam recorder DR3 is suitable for use in all establishments, including domestic establishments and those directly connected to the public low-voltage power supply network that supplies buildings used for domestic purposes.
Harmonic emissions | N/A |  
IEC 61000-3-2 | N/A |  
Voltage fluctuations/flicker emissions | N/A |  
IEC 61000-3-3 |  

**Guidance and manufacturer’s declaration - electromagnetic immunity for all equipment and systems**

The PillCam recorder DR3 is intended for use in the electromagnetic environment specified below. The customer or the user of the PillCam recorder DR3 should assure that it is used in such an environment.
<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrostatic discharge (ESD)</td>
<td>6 kV contact</td>
<td>6 kV contact</td>
<td>Floors should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the relative humidity should be at least 30%.</td>
</tr>
<tr>
<td>IEC 61000-4-2</td>
<td>8 kV air</td>
<td>8 kV air</td>
<td></td>
</tr>
<tr>
<td>Electrical fast transient/burst</td>
<td>2 kV for power supply lines</td>
<td>N/A</td>
<td>Mains power quality should be that of a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>IEC 61000-4-4</td>
<td>1 kV for input/output lines</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Surge</td>
<td>1 kV line to line</td>
<td>N/A</td>
<td>Mains power quality should be that of a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>IEC 61000-4-5</td>
<td>2 kV line to earth</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Voltage dips, short interruptions and voltage variations on power supply input lines | <5% $U_T$  
(>95% dip in $U_T$) for 0.5 cycle | N/A              | Mains power quality should be that of a typical commercial or hospital environment. If the user of the PillCam recorder DR3 requires continued operation during power mains interruptions, it is recommended that the PillCam recorder DR3 be powered from an uninterruptible power supply or a battery. |
| IEC 61000-4-11                                    | 40% $U_T$  
(60% dip in $U_T$) for 5 cycles |                  |                                                                                                       |
|                                                   | 70% $U_T$  
(30% dip in $U_T$) for 25 cycles |                  |                                                                                                       |
|                                                   | <5% $U_T$  
(>95% dip in $U_T$) for 5 sec |                  |                                                                                                       |
| Power frequency (50/60 Hz) magnetic field         | 3 A/m                | 3 A/m            | Power frequency magnetic fields should be at levels characteristic of a typical location in a typical commercial or hospital environment. |
| IEC 61000-4-8                                     |                      |                  |                                                                                                       |

NOTE: $U_T$ is the AC mains voltage prior to application of the test level.
Guidance and manufacturer’s declaration - electromagnetic immunity

The PillCam recorder DR3 is intended for use in the electromagnetic environment specified below. The customer or the user of the PillCam recorder DR3 should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conducted RF</td>
<td>3V$_{\text{rms}}$</td>
<td>3V$_{\text{rms}}$</td>
<td>Portable and mobile RF communications equipment should be used no closer to any part of PillCam recorder DR3, including cables, than the recommended separation distance calculated from the equation applicable to the frequency of the transmitter.</td>
</tr>
<tr>
<td>IEC 61000-4-6</td>
<td>150 kHz to 80 MHz</td>
<td>150 kHz to 80 MHz</td>
<td>Recommended separation distance: $d = 1.2\sqrt{P}$</td>
</tr>
<tr>
<td>Radiated RF</td>
<td>3 V/m</td>
<td>3 V/m</td>
<td>Recommended separation distance: $d = 1.2\sqrt{P}$ 80 MHz to 800 MHz range $d = 2.3\sqrt{P}$ 800 MHz to 2500 MHz range</td>
</tr>
<tr>
<td>IEC 61000-4-3</td>
<td>80 MHz to 2.5 GHz</td>
<td>80 MHz to 2.5 GHz</td>
<td>Note 1: At 80 MHz and 800 MHz, the higher frequency range applies.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note 3: $P$ is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer and $d$ is the recommended separation distance in meters (m).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note 4: Field strengths from fixed RF transmitters, as determined by an electromagnetic site survey$^a$, should be less than the compliance level in each frequency range$^b$.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note 5: Interference may occur in the vicinity of equipment marked with the following symbol:</td>
</tr>
</tbody>
</table>

Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the PillCam recorder DR3 is used exceeds the applicable RF compliance level above, the PillCam recorder DR3 should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as re-orienting or relocating the PillCam recorder DR3.

Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
Recommended separation distances between portable and mobile RF communications equipment and the PillCam recorder DR3

The PillCam recorder DR3 is intended for use in an electromagnetic environment in which radiated RF disturbances are controlled. The customer or the user of the PillCam recorder DR3 can help prevent electromagnetic interference by maintaining a minimum distance between portable and mobile RF communications equipment (transmitters) and the PillCam recorder DR3 as recommended below, according to the maximum output power of the communications equipment.

<table>
<thead>
<tr>
<th>Rated maximum output power of transmitter [W]</th>
<th>Separation distance according to frequency of transmitter [m]</th>
</tr>
</thead>
<tbody>
<tr>
<td>150 kHz to 80 MHz</td>
<td>80 MHz to 800 MHz</td>
</tr>
<tr>
<td>d = 1.2√P</td>
<td>d = 1.2√P</td>
</tr>
<tr>
<td>0.01</td>
<td>0.12</td>
</tr>
<tr>
<td>0.1</td>
<td>0.38</td>
</tr>
<tr>
<td>1</td>
<td>1.2</td>
</tr>
<tr>
<td>10</td>
<td>3.8</td>
</tr>
<tr>
<td>100</td>
<td>12</td>
</tr>
</tbody>
</table>

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in meters (m) can be determined using the equation applicable to the frequency of the transmitter, where P is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.

Note 1: At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.

Declaration of Conformity with Radio and Telecommunications Terminal Equipment Directive

Hereby, Given Imaging, declares that this equipment is in compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC.